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2 F %) SIMATIC SFHI4%, #:% Windows /T4 3k B “FFa4"> SIMATIC
>“SIMATIC ‘&3 32" (SIMATIC Manager) 4.

Jrigl SIMATIC EBE48 i, R B FHRAT T LIRFT I3 H o
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faifr
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Zabxf PCS 7 Wb A4
(VU6 17) 5, IR ST ek A1) “color_gs™ Wi H o FAl TS (1R 40 1R 38 40 B W ok 3

Bhig. NE B IZ D U], SO B AR AT Do DRI, BT R A T AT
Rt TR E RN RAE R

IS T R A (TR HIUH RN, IR EA TR RSB 4 Ashd
BUEP T B/ e H52, AT AP PR AN IR, SN T X — N A R T 4R
JRAEAEAS T R IR BEE AR P I FE 254N B B

77 i (RO JEUR A A8 P AN JORHGRE vh O DX S ERNIL B S 38 o A JEURHA i AE = ARG
e IREHIL A T ARG B I R RSO, BIRRERL AR R . AT G IR e as A
5 SBOXHUH DRAZ TE A PR TR B EER JsURERN B — R S e

T RS B ARV SR AP R RE AR 5 B 3 1 B S B 5

2.0 VR RRAS R TR SRR I MR eI A B B S N S, AR SN SR A PR s A A TR
o AEON S I JFORMRIZS IR HEATHEFE . INFFIV JIR A7 7 it o BRIRIPAAT 25 45 11 S
IO S RS o o LI R AL R B P AR 8 K ) R R BTN B S R S

BN - EREFH B
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LREFT B Z G, P B A e AL N A b, P2 R N2 AL Y 25 R B 2 ml /N R G 1

BV - Y

ha|

W R (CIP) REEITEVER NS I8 W $ATH . AR O, - Er
JR AR 21— A B 375 2K RE P A T AR B

4.1.2 NRET LR 2B

DUHER AL B - S5O ) — 850

R, PRSP JsURHRE R SRR A7 R FH A K 8 JEURH s B A S . 55 IR A2 428
il o

BiEM{XEE (P&ID)
ETE AN s I U AL A AR S5 IR VIS I s B SRR AT DG R A 2
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P&ID P AR IR HAT LU 5 X
o LI GRAVFR/RAS) - WU JEURHE - (¥ 2 B A
o NK111 FI NK112 (VR € IIBFRRAT) - o8 S5 ORI 02004 T TF (145 11 1
o NP 111 CZPUREE I HHLER RS - i S N 38 15 BRI 22

o NK 113 2 NK 114 G REE IRAR UAT) - AT S W 3 1 B0 W 5 2
IBILURHI I s IX AN AR BEAT N AE T TPIRES

o FC111 (HESRD - HTHml s R AT 48

TEERAE D s AL NK111 2 NK114 [FRRZs . Jdid FC111
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ik

24

“color_gs"TiH K T A&

“color_gs” I H K £E 1 54 F 34k REUMAL G 1) T RENT st 5 A DR ot ¥y PP e /N AR &8 15

Jiti o

AR DU BT A TR R G, NI T XRG4

Single Station

Engineering Station (ES)/
Bewwsn Operator Station (OS)

Direct Connexion via
Cross Over Cable

SIMATIC S7-400 avec CP 443-1

il

J||I Systéme d'automatisation
oL

76 (NT1¥5/) (Getting Started) "', B A& LN A6 R 45

HE R 45E (AS)
B HAFAE AT AT T (1 ZR 0 h Ak

R, HT#sil“color_gs” 1.
7t ES Al iy, R N3 CPU. CPU
PATPFTINEIIRR T IE BoR i Rl . Wi CP 443-1 Ingkfd )y .

BAE 5Lk (08), L) #AF RAEISATIIM N I T Bk B OOl L) #E R aqfE
OS bAEZMFRm . AS ik CP 443-1 5 OS %E#:.

i

AL, MR L) SR E T LT A (NTT45F) (Getting Started)
(ALK AE 2L

ARIEMIUH, —ESHEZR ARG, WarE2 a8yl EEE TR
sl AR DL . o, BERRCER R g, W HATS (N4 ) (Getting
Started) [ HHIA—E,
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4.1.4 HAFEER

AR

LN AR L AS R G4

W M2 EL (T 26)
U H (58 29)

1Ak (VU 38)

1E T )28 TAE (hihY 51)
B CFC KI5k (114 61)
il SFC % (Ui 113)
GivE. AR (T 141)
2 A HRAE DL (DT 151)
G R [ (55 163)
ISR TAE (50 189)
AT INAE S5 (U084 201)
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4.2 WS A i B

4.2 P 2% B T4 T B
4.2.1 X 4% 0 L1 B B
BE

422

4221

R

P&

26

EFFIRZH A “color_gs™ Wi H 2 |, AT AU R R

o AEPEHIG LI M S B gy 3
LR R s RE T, PCS 7 2 AR Bl EHL L2225 1 N 4G B -
A LU s BAE ARG B DT e .

]
‘%A PCS 7 Jr, MW LEIBATIXE B . WIRAE B DL
PCS 7, MW s A IX 8 B I AT b E B

o IEFEMZRIGNCAY
FESEXSATHE Ik #E S PC 3 EA TN PC 3l s (1 M 4538 e 4 o

7

WA H 6 P TR E

o T LT AEAF AL HE A B LI TT
o ES iIHHALIK 3Com M4 IEHRC &% M1 CP 443-1 2 [H]  Z0EFAE X HL R o

e

1. 1§ J1] Windows fir2“FF4&"> SIMATIC > SIMATIC NET >“4 7% 4”(Configuration
Console) T A& -
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4.2 2519 A i B

2. H: & FLALE T “SIMATIC NET 4125 (SIMATIC NET Configuration)/
i (Modules)/[M 441G RL#s 2 AR5 H, LLEFEH T AS-OS 1l il 1) N 44 IEBLES

3. EFH - (Address) 4 H .
JIT 32 P9 6% 3 TG 245 (0 bk 40 4 S0k it 2 R4 AE BRI

4. 0 FLUKM (MAC) Hihik”(Ethernet(MAC)
address), K24 & 4 AR 2 FH 3

5. 4 H Vil 4" (Access points).

6. MUk R4 B A& H i “STONLINE U 1] £
BT IT“ST fEL: )& Y (Properties of S7 Online) X1 iGHE

7. LI D 41747 (Assigned Interface Configuration) R4k, %4 HPC
Wi CARHL) "(PC internal (local)), 5ol 2" (OK) fRA7 3 o

8. ¥ PC T Hoe M4 i 28 3 BN “PG
9. KMASEHE.

4222 WAk SIMATIC Shell 9 1 P 4% & Fio 58

faifi

N EEE ] T LA PC fif) I 25 G L

iR

ALK PC i FITEA LIS PC BRI AR R 48, WIETHHATLL M.
Titk

1. 7E Windows %55 #L2SM TE ML i PC ol CEAERN) &
2. %FE“Simatic Shell” 3043,

3. WP F R E..."(Settings...) 4.
BT PP 20 M 287 (Select terminal bus) X1 HE .

4, VEFETH] TS PC s i ) b 45 15 Bid 2s .
5. Hii“Hfi e "(OK).
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4.2 2k g s i A

6. JKHI“SIMATIC Shell” 3042,
R B W61 o

28
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4.3 B)# I H

4.3 I H

4.3.1 “BrEEIH "1 S A A

PCS 7“5 H [ 2
MITIT SIMATIC B g3, PCS 78rd i H ) S ARGE BN B E T B3R 3. wI{E PCS
7RI R R AR AT

CHTEI ) A S QIR H O SR D Ay, R A BEE . AR ERIA B
BEES R R ERCE, PCS 7 IS4 HENEIE S 4.

“color_gs"fIxf %

LLR X % 5t “color_gs” i H 4R FE % .

o ffEXI%: SIMATIC i, #I4nfH+ AS ¥ SIMATIC 400 5. fF OS (1) SIMATIC
PC i

o RN GERIMNZE Y. Pl E S B iR S5 PCS 7
i) RN BEE S

e CFC K%

e —/~SFC Kl#

o BT EYCde—/

o —ANEHE

4.32 PCS 7 mSME RN

AREFWMER, FEERETHA?
BRI PCS 798 it H i) ) LR SN IXPIHR 2 5 AL
PCS 7 BRI E M XT G
o ZIIH
o LHWEAE
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4.3 B)# I H

L TR H /e 2

EHARERAT A2

4.3.3 G

43.3.1

ST

30

i/ PCS 7 [ QA H I H I, < A QTR ZIH .
—AZIUH LA H 2.

FESBIIH g, 200 H [ as .

Z I H FRHEAN T DRI Z IH A PTAT I H XS8RI Rl A - i RE P IR 4%
BB

HITAEAR (NIRRT RIS T 1B A 2 i H A — A
TiH .

ZIHAT MR

FRE LT 3 RO an AN R A A TR, DABE o0 AT 2 4

BRI H AL TE A, TR EA TS IF LU SE BRI H .

FE ANTTHERD R 2 H , HRR A b2 00 H TRESR AL 2 Fh 2 A
KIZhE

TRV R, WB% (WFEH R PCS 7; THEFA) AETM.

i PCS 7 [ QDI H I, 2 A ) T4 .

FESEIE H EAAHEEAN I W 2 i B, B, Gl CFC

BIZERT, 1 SGAE AR PR s 2R CRC Bl A B T AT b B
TR RAT LN R

o VARSI FII, T HE A SR H i A B

o BRIMEHR, AT H HEEAN XA B .

FE Z I H S, il T e e SeVE RS 1R Tl AR B A 0 H T REIT S 44t 58 SCRROAS (R B
o DT R AE IS H b U P e RBAS DR b 3 i P ) B

tnfa] B 2 “color_gs” i B

PCS 7 In) S4:# Bh & 61) i “color_gs” i H :

1. 4TJF SIMATIC % Figs
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4.3 e H
2. MEPESE A A3 (File) >“FrEt T H”(New Project) [7] 2...
PCS 7¥ &3l H”(New Project) 1] 3] JT .
PCS7THE - HERA’
% 8lE T14)

PCS 7 BS : HEWH-

it PCS 7 AR SREAETEREERIFTE MR PCS 7 £ E . AR IR
{2 BRI BIE.

BE T LIEERENH.

T oo

%| | wE |

3. 4k 2" (Continue).
4. 7E5 2(4) T H HeE A M CPU? ”(Which CPU are you using in your project?)

PR EAE T H TP AEHT ) CPU 2.
Jirik CPU LI iEA (5 B s ESI R N7
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4.3 g1 ui
PCSTHS - HEEHR" |
B #®WATERAmL%S cPu? 2[4)
LrU: |45417-4 (BESTES4-L...-..) | vz
e MLFE | -
BE 5 7654-3LE47-06440 AC 120/230v 2045 #1122 UR1; 4 MB 77iE R
BES7654-3LE4G-00040 E-STAND:2.3 ASHI7-4VE; ACT20/2300 2045 #1238 UR1; 4 MEFiEF R
BE 5 7654-6LE47-06040 AS417-44; DC 24y 2045 132 URT; 4 ME TFiEF RAM;

BES7EG4-ELE48-0064¢0 E-STAMD:Z  ASH174WE: DC 24y 204 #122 UR1: 4 MBFEHEF RaM:
BESTER4-ELE48-0:<0 E-STAMD:Z2  ASI7-4WEZ DC 24 204 7 H122 URT ; 4 MB TFiE-F Rak ;

GE 5 7654-3LG47-0040 ASHT-4V4; AT 120/230V 2047 128 URT 5 16 MB 7RAEE
BEG7654-3LGAB-00D E-STAND2.3 AS417-4 /53 AC 120/230V 204 3 128 URT ; 16 ME 72RE-F
E 5 7654-ELG 470040 AS417-4Y4 DC 24V 204 H122 URT: 16 MB 7RAEE RAM: |
e i e o SRR RRSURR L 2 n_}l_l
BREAE S T~ P35 vED

M |
=@ [ F-gw |  =m | mi | wmm |

5. Hi“4k4L"(Continue).

6. oK 3(4) T H rh 75 A HIELE X %2 2 "(Which objects are you still using?)
H, TR N BROE

— MEZHC (Number of levels) gl ik Pesc H 4",

— 7E°AS %%"(AS Objects) T, K& 77 7 “CFC [E#"(CFC chart) fI“SFC
K| 2" (SFC chart) & 1EAE

— PIE“OS %[%”(0S objects) FI{“PCS 7 OS” kA,
B E ST AR vk R47(Single station system) 215 .
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4.3 G H
P(Ss7THS : HEEA’ |
[ BERAEEHNENS? 3[4
TR : A5 TS :
SN |4 vI v CFC ER=(C)
v SFC ElZ=(5)
OSE&R:
g st pa (] = Bk FEH)
[~ SIMATIC BATCH " EZEFHM)
[T Route Control O ZIL R HR)
| 5

M |
t—s@ [ F-gw |  =w | mis | @ |

7. Hiki“gk4L”(Continue).

8. (£ 4(4) vh, 7E“H 4" (Directory name)
NI N & PR color_gs” I 452 48 e A7

9. HL“TY >>"(Preview >>) & L ATHARSH I, BTN AL SIMATIC
BRI H R SMIATI o
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4.3 B)# I H

PCSTHS - HEEHR" |

@ SR ENEH TR AEET 4[4]
BFEED]: R TFI S ¢
I-:culcur_gs_F'ri #£TiH{ : color_gs Pri MP
g : color_gz_ PP
EREEE ¢ color_gz_Prp LIB
TFREAS CERE ) (9):
F:A\Temp I (B)
AT Fa A B s (a) -
fast

FHSE <<¢ |
color_gs_ Prj Prj [Plant View]

color_gs_Pri_MP || HEE | as B | 05 &R -
EI--@ colar_gs_Pri_Prj _NBEHCRoiy CPU 417-4 wa.0S7 EREE (OVERE —
- ] #FFH [FsFC(l) CPU 417-4 v4.0057 325 (1 ERE v
E| ﬂil'lt':lj' - {‘I — I _"|_I

color_gs_ Prj Prj [Component Yiew]

n:u:ulu:ur_gs_F‘rj_MF‘ | HEE | PH 43R i IE=
g2 color_gs_Pri_Prj _MBAsFoi1) Plank Ui L) Functiond 1 Position( 13 SFC
- E-{ill SIMATIC 400 [EYcFCit) Planti1)\Wnit 1)\Function{ 1 \Position( 1) CFC
= cPu417-4 v4.0
. BEmwEREn <l | r
=@ | T | = | mi |

10. Hdi“5E B (Finished).
BT IS 5 70 " (Message Number Assignment Selection)
XPUEAE LA I H , B EC i ) CPU ¥ AE— 1 B 5" (Assign CPU-oriented unique
message numbers) 5 EHEH FE .

PCS 7 - AI'1457 - 2 1 #5)
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4.3 G H
color_gs_Pri_Prj- EEHABSHE O ] |
— 2 EiIN B /R E
DRI RN B wEEE , LR FREI T — ¢
o SETEE CPU fIME—iE BiRs
[A WinCC%E. ProTool Y6 & STEF 7 W5.2 42 »
E-TEEER A EmAETH Ea; STER 7V5.1)
 SEEmETEAE—ERRS
[FiiEFE]
BT 5 |
FE5Eh |

1. HdiifiE”(OK) M HIBEE
H A I L8 0 B 5 B H

BiA

THER LR LI

o WERITHAR BBTIT, U 5 AIAIET JTcolor_gs™ 3 H
(Ui 36) iR 7S S Bt B A1

o EPARANFEIRLIEL, AL W A P (D08 37)" B PR A B A

SIMATIC & 228 T.) M 3 H IAE W R Fros:
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4.3 B)# I H

I @ color_gs_| F'l|_L|b

Rl

HEETR WEES LINC B&iE SHEEL_ERRERE | E
% calor_gs_ Pri_Prj Chineze [PRC) F:hTempheolor_gz_P... CHS1
@ color_gs Pri_Lib Chineze [PRC) F:A\Temphcolor_gs_P... CHS1
1
1] | I

4332 anfe] < A FIFT F“color_gs™ Tl H

RPATH H KLz
1
2
3
TP E B 7%
1
2
3
36

. W SIMATIC & HLgs A JUBAT IR H , O T3 AR WOCHIRLETH
. YEF“E O”(Window) > [Ji B 4 #R] [Name of Project] #ir 4, 4R Ji 1% F 56 A T H

SIMATIC & B & AE AT 5t 2o kI H .

. R4 (File) >“55H”(Close) 4.

FEFP R R I .

. 17T SIMATIC & H5%.
. itk color_gs" Tl H & A BT IF, nIEFE“SCH"(File) >“+1 FF"(Open) fir 4

AT 4T IF 5 H " (Open project) XJ1fHE, HorhH] /1 35 H”(User projects)
BRI AL TR o

. HeF“Z 10 H”(Multiprojects) #2581 £ 4 H “color_gs_MP”,

PCS 7 - NI'145%8 - 55 1 #4>
A48, 09/2007, A5E01222374-01



TH #8040 1 1F

4.3 B)# I H

4. PiliHiE"(OK).
REFFREST T I H LA R AR OG0 T2 44 126

4333  WEANEKE P EEE

fai g

7t SIMATIC

RGP H G, WA R AL SRz 0 H I X LR 2 T AT DI
Tk

1. {F SIMATIC & B 3% rh ik 5 “YL " (View) >“[FF 4L B ) 4 #R]"(IName of the desired

view]) @4

- ALK
- 1) A
— ARG

o

1. WRCEITHF TIUNIH, WIEL“E 0" (Window) >[I B £ (MEZFR) 1"([Name
of the project (name of the view)]) 14 .
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4.4 21855

4.4 AT

441 fic & 5L B

Bk
417 PCS 7§ ui H i) 3 & HAm A Rl R e di it X uHE4E (i
AS. 0S) S REKIIERL.
N BEAZRRAT EA R 2D 3R

BB RES

A7 AS (76 38)

Hr 4 PC ¥l (TG 42)

A OS (Wi 42)

7t NetPro Hi% B IE#: (TIFY 45)
TEBAEE (U 49)

A |WIN|~

it PC 3
i} PCS 7 ol LUK ] 3047 ES M HENLLLA A PC .
X SRV A SR PRy 4“3 3 OS {7 (Start OS Simulation)
MRRAMTHERAE kDR, A LR EdE F B EIER OS b ik OS B2 T .

A (NI1HE™) (Getting Started) [ 1) 4152 TAFuE &4, ES Al OS
E—EEN L. X, 4ARAM PC 3R LE ES Fil OS.
PUAH TR 6 77 A 2 ARSI H R 4l 28 A1 PC 3,

44.2 WIR

4421 Az AS

ik
o M{E SIMATIC HHIZS hT FF Ll H
o CIIRALFLA.
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4.4 45

W
1. WRTERLE ke
“color_gs_MP/ color_gs_Prj/ SIMATIC 400(1)” ({13
2. (EVELAME EPLIE kBt fE" (Hardware) X5, R 5 652 50 4 2w (E dit)
>“$T FF 514" (Open Object).
HW Config 24T 1 I 2o R Ge A4 Fe & A

i
WARAR W R H 3, Al fdr &P (View) > H 3x”(Catalog) .
AR RN T Tl AT 5 ) "PCST_V7 0 FL & SCAF A H %

FAHW Config - [SIMATIC 400(1) (ACH) -- color_gs_Pri_Prj]
ol 3545 @EE WAL R BEY) ERQ FOW FHEBIH) == x|

D@8 8 & ke bl B %2 K

i3 U1 :I — ik
P& 07 30, sHE: | | i

:

PROFIBUS(1} DP E85 2% (1)

3 CPU 417-4 BEE R PCS7_v70 =l
-2 PROFIBUS-DP

2 E oA - B2 PROFIEUS-PA,

i M - SIMATIC 400

Py -3, SIMATIC PC Station

IF2

5 [fECcP43

E

7

B jhd| ks

-
1| | 3

:Iﬂ 0] UR

.. fEth LA B M | e |
1 FS 407 204 BEST 4 =
3 E CPU 417-4 BES7 |V4.0(2
X2 0P 7638,
Ll MELDP Z 7635
IF1
IF2
5 Ei:‘. CP 4431 BGETF V2.3 16381
E =
7
8
3 SIMATIC 57, M7 LLE: CF (apdlae Bn A £,
PROFIBUS-DP M —
10
11 LI
T F1 LA ZRRRFERD. | | T
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4.4 21855

3. E$E CP 443-1, MRJ5IEFEE a2 g (Edit) > 5 )& 1" (Object Properties).
¥ 4T IF“CP 443-1 J&1:"(CP 443-1 Properties) Xf i .

4. " (Interface) 41+ 11)°J& 74" (Properties) »
BT LUK M2 11 CP 443-1 (RO/S5) J& 1" (Ethernet Interface CP 443-1 (R0/S5)
Properties) X} 1A .

5. {E*MAC Huli’(MAC address) 4t AME 4 A MAC Hilik. MAGC 453 CP
() i T

6. ZXM“IP Wil IE£E 8 FI”(IP protocol is being used) & iEHE .
IR 225 F AT AH G IR i A\ ATE

E# - Ethernet #O CP 443-1 (R0/S5)

= 2 |
W R E MAC It AR IS0 FHE D]
MAC Hidl 2 | 00-30-05-70-55-00 INFUEIE T~ FF
Mg R T —1-AT FAtHAE .
[ IR IP HHE)
! P
IP HihE [192.168.0.1 & D]
FRIEBE):  [255.255.2550
R Ema (L)
HidE(A) 2 [192.168.0.1
FHIS) :
2. |
EEEL. |
wesL |
W= me | wmE |

7. " (New) LBIEUH M 2%+, CPU Ml Ik M 25154 5 ES i,
KT I JE 1 - B Tk BUK M -7 (Properties -- New Industrial Ethernet Subnet)
XA o
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4.4 9185

8. iy e (OK) I HH T A T4 U
“Ethernet(1)"4% H 245 A 2“1 k" (Subnet) %] IF L&k .

EEf# - Ethernet O CP 443-1 (RO/S5)

= 2 |

|l s P o o = N P e )

MAC Hidlk - IDD-SD-DE-?D-EEI-DEI IFEE T —TFF
Mz R F—1-RT Fa it

I~ IEFEFER IP i (E)

. EES
1P M [152.165.0.1 ASY—
FFIHERIIE] - | 255.255. 256.0
O i ()
HidE(A) : [192.168.0.1
FHIS):

. *Eﬁl s : ......... %EEI‘H] ...........
EtE. |
mEL |

W b3 my | wmE |

9. HLliWiE"(OK).
IV e
FHFT I )@ - CP 443-1 (RO/S5)"(Properties - CP 443-1 (RO/S5)) X ifHE.

10. i E"(OK).
K I P 0BG PR AT

11, EFRE 4 “uh” (Station) >“fR 17344 13" (Save and Compile).

12. %M HW Config.
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4422 e E w4 PC ¥

R
o L{E SIMATIC HHIZS thT FF LBl H
o CIIRALIFLA.

Titk
1. 7 LI e
“color_gs_MP/color_gs_Prj/SIMATIC PC Station(1)" X} % .
2. PR A A iR (Edit) >“X 5 & 1" (Object Properties).

3. "4 R (Name) S AME S AAM T AL A 8K (RIEAEM 2% EWoRIGAFED .
AJ DA S A A G 445 (1) “355” (Station) AE b P B A4 K

4. PGS FR” (Computer name) 15 [1)“ 5 PC
3 4 FRAH R AT S H L4 FR” (Computer name identical to PC station name) & i%HE.
THRBLAFRS B AR N T HE T .
5. HiliifiE”(OK).
W IV HI B IR AR T AE
AL ] B 10 5 Sk R iR PC BT 5

]
R PC ufi RIS i kAR iR, 4% <F5> BERHT B o

4423 747 OS K PC 3

R
o [\ {F SIMATIC & H ge T HF LI H .
o HAFVLE B

PCS 7 - NI'145%8 - 55 1 #4>
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i H 198745 1 1F
4.4 9185

DR

1. TERTEALIE
“color_gs_MP/color_gs_Prj/[PC i i) & FR]" 343 .

2. (EVEANME EPLE k64147 (Configuration) %1%, 4R )5k F“4r#E" (Edit)
>“¥T T %15 "(Open Object) 4 .
HW Config ¥4 FFIFiR A OS 113K . HW Config $17F, Lk & A4 AS
I REAT (1 B
— HEH RO
— “PCS7_V70"Bl & A4 T IRES o

3. MEEfFH s ik $Eit CP:
“SIMATIC PC i (SIMATIC PC-Station)/CP MV LIK M (CP-Industrial Ethernet)/IE
#¥1 (IE General)/SW V6.2 SP1...”.,
¥ CP IS 1.
BT I B 1 - LUK 2 117 (Properties - Ethernet interface) % 1 AlE .

4. B E MAC i/ 1SO Pril"(Set MAC address/use ISO protocol) & IEHE .
5. {E“MAC #ili-"(MAC address) HEH 4 A /R &4 & il s i ik
6. JEFR“IP il C A% H”(IP protocol is used) & iEAE .

7. 7“1 M"(Subnet) ¥R AHE F1 L FE“Ethernet(1)"4% H «
X OL Ny CP A NER,

PCS 7 - NI'145# - 55 1 64>
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T H #8743 1 1F

4.4 21855

E# - Ethernet O 1EJEH (RD/S1)
=4 24 |
|l s e e == = R [

MAC HihE [00-30-05-93-88:43 INREET —TFF,
a2 R T —-1-ar F e bk .

[T IEIETEF IP S E]

! P
1P Hid [192.168.0.1 e —
FRIEBE):  [255.255.2550
e )
HidE(A) 2 [192.168.0.1

T R3]

A G wEm. |
BttEl. |
mess |

W= me | wmE |

8. HLli*ffise”(OK) fRATHIA -
2745 5% R 1 AE I3 0] 21 HW Config ..

44
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[Hw Config - [SIMATIC PC 3% .5(1) (B2 &) -- color_gs_Prj_Prj]

4.4 9185

ml 354 WIEE HBAD BC FEW EWOQ BOW) FEEH =18 x|
D238 &G ke D2 BN
- Bix|
NG =50 | Alay
g [ 'winCC Application EEEI]’*U‘PES?_V?D j
4 ﬂl PROFIEUS-DP
5 + PROFIBUS-Pa
B SIMATIC 400
7 SIMATIC PC Station
g {2 BATCH
9 {3 Contraller
10 {3 User Application
1 D CP-Industrial Ethernet
12 w1 CP1512
13 {3 CcPiE12
14 -| {3 CcRiE13
ED IE General
LJfF SWVE2 5P
{1 CP-PROFIEUS
{0 HMI

l

-] Raoute Contral

= | o PC

% E 18k e B | Mt | e
1| IEiBH IE_CP VB 2.1 -
2 |[|] WinCC Application -
3 1=
4
5
E
; T FHESR O , PROFINET (0 55 3
#I[88 , 150, TCPAP, S73E#E . PG A, B
9 LI B » SIMATIC MET CO 1142003 5P1 ..
T F1 LLFEERAEE. [ [ cha 4
9. IEF“¥h”(Station) >“fRFH:4% %" (Save and Compile) 4.
10. %M HW Config.
4424  WffE NetPro BT E
Bk
o [U7E SIMATIC & BEES h 4T T SE 5 I H .
o S
WaRis
1. FERTEALE ke
“color_gs_MP/color_gs_Prj/[A it ELHLI 2R % 5
PCS7- NI'l#&® - 5 1 3%
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4.4 21855

2. TEVEIE B R kB E R (Connections) 4% H, SR 5 b £ 5 i A 4w (Edit)
>“4T F5%F %" (Open Object).
F5¥7 7 Net Pro.

3. 7£ SIMATIC PC 3£ “WinCC W H F2/7"(WinCC Applications) %§%: .
76N J7 IS BRI 7R 1 8 R N P TR R

4. {E NIV S B IR RS AT, AR EEE a2 B A" (Insert)
>“¥ri&#..."(New Connection...).
BT P48 \Bn&E£2”(Insert New Connection) X1 HE .

5. fEMTERLEI TR E#I H 1) CPU.
It CPU J& OS [l Ak £, it & e 4tz AS 15

6. (LR FER(Connection) 41, A @5 E 1 “S7 &H:"(S7 Connection)
DL S A5G T 48 AT 2 JE PE"(Display properties before inserting) &£ HE .

PCS 7 - NI'145%8 - 55 1 #4>
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4.4 9185

BABEE =]|
SRR

=-{a] ELFTE $

El% color_gs_ Pri P
= SIMATIC 400(1)
e FIRCPU 417-4

------------ ERR & o Rk o
F-Ee] EEMB D ¢ color_gs Pri MP
2P FEFEIHE

WHE: Iu:u:ulu:ur_gs_F'ri_F'ri -
BaS): |SIMATIC 40001
REM)I:  [CPU 4174

~iERE
ERM):  [s7iERE [
W RrifA AiRIEED)

mE | mAw | mm | mm |

7. ki (OK).
BT IT B M - S7 &2 (Properties - S7 Connection) X ifitE, H.“# #”(General)
IR AL Tk R A

8. WEHLL T T CPU 1 OS Z &L IFIEHAK AL
— RML: R[OS MM ZIERCER], HlntIE HAL(IE General)

~ fkfE: $DIAS 19 CPP([CP of the AS]), #ili, CP 443-1

PCS 7 - NI'J451 - 25 1 #4)
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4.4 41& 55
B - 57 R B3 |
w4 |wema |
R HE R D —EEfRR
T ElERIErEEE=E ) DL :
[T e IS? conhection_1
|l s VFD 575
I~ it EstiE B (5] |WinCC Application
- IERERE
A Hh(C) Th{EN)
o = SIMATIC PC &b & 1)/ Iswmn: 40001)¢
ok WWNCC Application CPL 417-4
EOE: |IEER | |cPa431R0s5E) |
FH |Ethemet(1) [T 1bEthemet] |Ethemet(1) [T 1bEthemet]
HidE - |00-30-05-99-88-42 | 00-30-05-70-63-00
HEHERER ). |
mE | E=E |

48

9. HE“HiE"(OK).
PrdtEpek Won ekt . Wik s AS XN CPU, b4y BorItigs:.
10. EFESE A AW 4%"(Network) >“IR7EH-4i1%..."(Save and Compile...).
BT ITRA7 I 4% 3% (Save and Compile) XF il
11, JEPEGn B ITA & 43 PN 25" (Compile and check everything)
SLIEHE I 2 " (OK) .
IR SE G, R T O EUEAS A i) % " (Outputs for consistency check) % 1 .
12, WRCAEPATIEE, I HARRAERNR, WIOCHIZE H .
WU S AR R, ARSE A D B P (5 B SRR DT H B A g A
13. XM NetPro.

PCS 7 - NI'145%8 - 55 1 #4>
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4425

i

4426

fai g

4.4 9185

WA AR T2 OS # PC ¥4

. DI#E] SIMATIC 4 888 . 364% PC o, RGP a4 PLC

>“42s..."(Configure...).
FFT 4047 (Configure) XfiEHE

. 4] &7 (Configure).

BATIT “diA&s: <52 ui>"(Configure: <Selected Station>) X iHHE .

C EPATAN I RIS, IEIE R4 <iE e 195> (Configure: <Selected Station>)

X HE (K175 e 3 B P S S IR B TR A

- PR E"(OK), AR5 AERE IS ST IT AR B T 1 b A i 5 " (OK) HEAT#A -

AR B ALIL R PC i

YL C ) 5 AR (Transfer successfully completed)

TR, A 4 AR AE H 1)K 1] (Close) o
TR M SOERE, iR M ZBEE R PC .

CEPEE PC W, AR IEPEE 4 PLC >“TF#"(Download).

BT IR R G 6 2 A SR G H IR T o B 4 R Ge 858, i ? "(Delet
e system data completely from the automation system and replace with offline
system data. Are you sure?) 1 EAHEHE.

. 2" (Yes),

FEFT I DX TEAE 45 1E H brAi " (Stop Target Modules).

- i E"(OK).

NEGE K

WA R AS IR E

AXRIFBCEMAMT G, AU IS Bad s CPU. il 4135 T 43 CPU.

PCS 7 - NI'145# - 55 1 64>
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4.4 &5
R

S&

50

CPU &t T“STOP"#:{.

CL7E SIMATIC & BEas T 4T TS H o
CRIE AL .

- MR TERL I k¢

“color_gs_MP/ color_gs_Prj/ SIMATIC 400(1)" 3¢ {13

. P4 PLC >“IRIEHSRIEXTA..."(Save and Compile Objects...).

BT TP 0RA7 3T 40 6 %" (Save and Compile Objects) X iFAE .

. Wi “color_gs/[SIMATIC 400(1)/i{f (Hardware)” ¥ 4 []“%i 1" (Compile)

1“2 (Download) 1| i) & L HE .

- TR (Start).

KT B HE IS AT ) R BR3P S, AR R AR R s R R R R, e N IR
MR ERE D ... "(Downloading program changes during operation can, in
the case of malfunctions or program errors, cause serious damage to personnel and

equipment! Make sure...).

- L E"(OK).

REATO AN 2R IZIIRESERUR , A AESOR G S TP FTOT H S0

- R SCAR GRS -
. FE“G AT 86 %" (Compile and Download Objects) #HGHEF, #idi“S&1”(Close).

K S A LR R AE .

. JA3) CPU.

PCS 7 - NI'145%8 - 55 1 #4>
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4.5 77 PH 11 T 1F

4.5 7 PH tf T4k

4.5.1 T BEYHwE

T B%
VA% — SR T
T) 2% (PH) S#PIm ) f)29eq i, flan, 1) . Hocsdhsg. PH
AP RER WS, NI T AW
o JZIHL:
IXLE L R VR L /L) 45 MM e .
K. T EgaE , T3 ) 52 R B % . 1/ PCS 7
)53, ATz B P e B B AT BRI BRI JE S,
o ERM T ID 4FK (HID) 2%
PCS 7 3l HAL & 24 HID 5241 3o A ob A B i AR SE 4 R vh 40, 2 1
HID, XAFER/E DLt Re e PRI TR A 5 9 S B bR 2 AH G R e 1) o, FE:
& X2 gtz HARAS SRR HID #0784, 34 HID il AR 1R R E PLIR S
o I PH H3eqs im i J2 2 -
T ) T U 2R A R
TR ARV AE A S AR H DR O ) ) e B A2 0 A L T o X A 1 TR R R N

T — &85, IF HARN A0 AR AR R . DR 2 K T R G b A i T A
fis J7 AHR Y o

4.5.2 w4t PH AT E

Eok
o CW7E SIMATIC & HE 88 T IF LT H .
o UG LT HLAL

FiE

-_—

. LERHERLE T ik $“color_gs_MP/color_gs_Prj” /= %% .

N

. EFIETN(Options) >“ L) EZ"(Plant Hierarchy) >“i% & ..."(Settings...).
BT I & LT 4% (Customize Plant Hierarchy) % il HE UL 365 PH 255

PCS 7 - NI'145# - 55 1 64>
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4.5 77 PH 11 T 1F

3. 7E“E4%0 (Number of hierarchy levels) HEH i A2 (547,
v B AV % I .

4, 5% 777 (Max. number of characters) iy AE H 5 BT PUAS 2 4 A “107,
T B Z ) HID T3 R KRR E ) 10 N 745

5. Mg 1 R 2 5 7E HID F7(Included in HID) & I%HE
6. 2R 2 P OS X1 (OS area)ikIii.

7. WOECONL) T E kA R )2 25 (Derive picture hierarchy from the plant hierarchy)

SIEAE .
XU HE B 5 RPIR A :
BRI BE |
ELTEN) |4 3:
-EiRRE
Eif BETTE E?g i Y 05 (il
1: |1 i E: I v .
2: |1 i E: I W C
3: |1 0 3: I_ v i
4: |1 0 = r I
5: |24 = r I
E: |24 32 r 2
7 |24 =] r F
g: |24 =] r F
oy - J111111111 182222222222,
M
v MI BiiEif BmEmELE(F) &
[T AT B iigiadRED)
% ) iEfeE s BaE FH S (E)
0 M B E R EEE PHIE(E]
TRE HiH FEHh

PCS 7 - NI'145%8 - 55 1 #4>
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4.5 77 PH 11 T 1F

8. il "(OK) fRAFHIAN o
P BB 2 e 7S AE HID
W R . DR S N BT R SRS ? " (You have changed the "Included in
HID" property. Do you also want the changes to apply to existing hierarchy

folders?).

9. M EHEF I Z"(Yes).
PP R A AT B

453 T MEF R

SEBIMER L] EH

s C4AF ] PCS 762 %735 H ”(Create new project) 1] $455E T IUANZ Y.
DAL, 7RI H B TE AL ok 3 LA TR Sk

o MFEHIT - 205 1 (Process cell - level 1)

o LG - Z4J)] 2 (Unit - level 2)

e IIfiE - 2403 3 (Function - level 3)

o % - %5 4 (Device — level 4)

JRRSCIE I A BRI H i th PCS 7 HBh 3 BC I BRI AA FR.

XfT“color_gs_MP"IiL H ,  iAZ5UME 5L S5 44 LA AL “color_gs™ Il H &I K, BB
PR FERABIZHOCAEIE . SRRl LIS B T (0 45K, R 5 3 50 H

DR T R R AR A A BT A o

7 (NT146®) (Getting Started)

HRATC AN T SRR E T BL R 2 GO e 44 75

NAE S B SR TEHE

L) (Plant) Plant1 A1) (Complete plant)

56 (Unit) RMT1 JR#HE 1 (Raw material tank 1)

I (Function) FC111 MEEH GERLED (Flow control [dosing])

I (Function) LI 111 JERHRE 1 BN F5 75 4% (Level indicator for raw
material tank 1)

Difig (Function) NP 111 L (Pump control)

Bhfig (Function) NK 111 i35 (Valve control)

YigE (Function) NK 112 i ¥2 % (Valve control)

PCS 7 - NI'145# - 55 1 64>
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4.5 7 PH 71 1F
BRINAL TR BEHIER T2
g (Function) NK 113 {425 (Valve control)
Iifi¢ (Function) NK 114 457 (Valve control)
B4 (Device) ADDIT HI 4658 BEE M MA B B 2% (Auxiliary chart for
specifying setpoints)

454 WAl A& BRI 44 FR

Bk
o LL7E SIMATIC #BEEs hHT TSI H -
o CUHUH LS WKL

HEL L) "XXHRP R
1. P2 H AT “color_gs_MP/color_gs_Prj/Process cell(1)”.

2. EPER a4 g (Edit) >“Xf 5 )& 1t..."(Object Properties...).
BT I B - 290327 (Properties — Hierarchy Folder)
SFEAE,  Hd s 7 (General) 33 < 4b T3k FR 7

3. FE“% " (Name) HEH A 4 Fr“Plant1”,

PCS 7 - ANI'J#5# - % 1 4%
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4.5 77 PH 11 T 1F
Bt - E@eEk - HEBE() K|
BH | EsmmiEs: | A505 98 | sea Ry |
BIRN) - Plant]
I B R (P) - ||:|:|I|:|r_g$_F'ri_F'ri I
1 B s B (S) _ _
|F:'xTemp'xn::n:nln:nr_gs_F'rPu:n:nIn:n_F'r|
ZINE |
fillzE HEA - 2007-10-08 10:15:23
_FieiEciRtg - 2007-10-08 10:55:58
() -]
=
W me | e |

4. PR E”(OK) M JHBEE .
BEXSTEME DR AT LR G SO 1 44 FR B N “Plant1”

Hir 4 "I RS R

1. EREZYSCAE I Unit(1)”

2. BEPER Ay A gt (Edit) >0 58 I..."(Object Properties...).
BT I Bk - 29092 (Properties — Hierarchy Folder)
SHEHE, Ho“w 7 (General) I <4k T3 R A&

3. {E“%4F"(Name) HEF T AL P RMT1”,

4. )33 8 " (Control and Monitoring Attributes) 3£ .
BRI T 2348 F A0 3 i 44 )2 200 A IS 20 (No modification when renaming
the hierarchy folder) & i%&HE. X a[#fifr OS X4k ID
() STAS IR 24 S G SO A IR 44 BREAT B 24

PCS 7 - NI'145# - 55 1 64>
AI14574, 09/2007, A5E01222374-01 55



T H 198045 1 1F

4.5 77 PH 11 T 1F

Bt - B % -- Plant1,RMT1

wH  SHRTENEYE |ac0s 56 | seeziiEy |
T #FiR(D) Flant14RMT1 L\P_,,
¥ RIS R HID B—E53 )
05 B 1D[a) : |HMT‘I
05 BIEESE(P) - [RMT
I e S R R ]
FEHI()..
i B F

5. Hliifi € (OK) M JHBE
LR AE 5% P10 ELJR ST I i A4 R TE SO “RMT 7

B A HEXRIPE

1. RGOk
“color_gs_MP/ color_gs_Prj/Plant1/RMT1/ Funktion(1)”

2. PR A g (Edit) >“%) % )8 4" (Object Properties).
BT IR I - 2927 (Properties — Hierarchy Folder) i 1A o
3. 7E“4 K" (Name) HEHF i A 4 FKFC1117.

4. PliHiE"(OK).
K N FH B IR PR A

5. PSR
“color_gs_MP/ color_gs_Prj/Plant1/RMT1/ FC111/ Device(1)”.

PCS 7 - NI'145%8 - 55 1 #4>
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4.5 77 PH 11 T 1F

6. EPE a2 “GhiE” (Edit) >“XT 5 & 4" (Object Properties).
BT IT )@ - 20k Je (Properties — Hierarchy Folder) S5

7. fE“ZFR’(Name) HE 4 A\ 4 Fx“ADDIT”.

8. Fd“HiE"(OK).
K I FH 0 B PR AT o

455 Pl GEC PN

Eok
o W7E SIMATIC & HE 88 T IF LT H .
o UG LT HLAL

FiE

1. EFERMT S
2. EFHEN (Insert) >“ ] Xt5"(Plant Objects) >“JZ % 3¢ 43" (Hierarchy Folder)

oA
2o

KA e “Thig [1%E4:4% 51 (Function [consecutive number]) {1557 /2 40 S0k
3. KA E S LI,
4. % ENTER
5. HEL 1 3 4 DLGIEELL RN Z g0k

— NP111 - spLE ]

— NK111 - [ #sH]

— NK112 - & #33H]

— NK113 - @4

— NK114 - ¥4

PCS 7 - NI'145# - 55 1 64>
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4.5 77 PH 11 T 1F

BUE, LT RGN P

B

Plant] R Em

Documentation

F-{Ba] NF111
EI@ Test_2_Lib
ERE. =
- [Eq) Templates %
(2 AR R
(2 1B

45.6 AN PH #) AS/OS KI5 B

JE R IO B 43 BE

T RIS AL S BU 2 € 1) F A6 R GERIRE S (44 Dt
BEAR RURE e it as T R BRI REAN R O
SAFEIH T4 24 Qi RGN 5 I X4 2

fE“color_gs"Hit H . WA — A HEML RGN — A RAE Bk
I, AT 29SO B 3 d .

PCS 7 - AI'lHsF - 5 1 H%
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RESKS B

1. ERERMTZ 0K, ARG R FE L fr 2GR (Edit) >“%F 5 )& £ (Object
Properties).
BT I B - E 92" (Properties - Hierarchy folder) i iFAE .

2. EFX“AS-OS 73rfi”(AS-OS Assignment) £+ .
WA T 1R 23 BO R L -

— E7HCH) AS (BRI "(Assigned AS (chart folder))
e, FE B EEGE N A 3 RS

— {E“7rHC) OS "(Assigned OS) #1J&H, s H 1~ W Edis i #AE Dk .
3. KHIFFIEHE.
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4.6 2GFrREs...

4.6 HEPRE..

4.6.1 T H B S APRES

BRERNATES
BIPAE 1, ENITH AT T UL R B

CL7E SIMATIC & HiLgs 414 T “color_gs”Hi H .

CfE HW Config HH41as T REFFLLLT
CLRHAE A IC A HW Config T #3 CPU.

CAE T JZH A T LA

CfE 1) 28w T “color_gs™ Wi H (1 1) 45#4).

PCS 7 - ANI'J5w - 5 1 &%
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fll# CFC

2 S

5.1 CFC Bl CFC 4r%E 2%

#ig — f+4 % CFC BI&. 4% CFC %i##:?

CFC BRI R

T A Rl E S e A AT RR . ik, AZ0FE PCS 7 () CFC i as b gt
CFC %,

Pk CFC W%k, F¥ PCS 7 Library V7.0

SRR DN B S SR A 16 1/ P s R i B S I 1A e AR R B R
o SRS FFIXLEH (1) Hi NN BT B IR/ CFC g ds b HE A /A2 4. CFC

2 4 b T S B P St ] Bl B 46 58 AT 55

PCS 7 bl e rh 44t T ik B bR 28

EAMRE T E S FEAR %S Cln LA (#1564 CFC 3%k,

FET) JZ9H R CRC 3R O T ORFFITH 45 H KR, 4h 2% 2ls CFC
B AE IR A SR VR FAF il AE R GOk

CFC & i1 MR AR B brAr il [y

PCS 7 - NI'145# - 55 1 64>
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G# CFC 7

5.2 1t/

5.2 e

5.2.1 CFC ERMEHIEE

EHIRE RN A
Qs CFC R, LI M2 BRI . DIZIR AT BRI REp R E M PCS 7
PRUEZEE IR I0H 1) CFC &+
FE B % R SR AN FEAR S, JRREX ST R MR 2 CFC &,

FHEFERIM R R AT

A5 P 2 B 2 AT A R A NI rP A A R RSCAS R B AN 23 B B TR L
AT H TRENAEALBE 2 I H A A0 H I, X,

i 8 ek 2 o e It o — U (K PCS 7 Dhfig: BBk
i, A LD RE W BBk IR - 2 PR 2 AN BT A, BAB LRI P A — SO R

A R MR, IR I N2 B3R e T T A .

5.2.2 e g Xk G A A 2 B P

RETE S

DL P A e B . i, R R RS A T H R ESK . /E CFC
2 v e NI BT G S ) S RSz 2 1 B BAT B U

XA S 7 HEE A o g e B AT, 1 TR R S AN S T S AT

XL RE CFC BRI, HABHGE HaAE CFC IR MBSL 171 .
B, Ferp R S 2 A (CBUE EABRBIED .

FEHdm A AR R A
ks PCS 7 Prid K Fepr 2 8 RA AR LRI P . 5 B AU M UL
VLI RE bR 2SS A 45 (0 B AT B2 4 F1 S A\ 31 5 i 2R I RS
EABIES T
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Gl# CFC K#

5.2 (/)%
B B
FTIFIE (000 64)
15 EHs e v AR T A B (UL 65)
PCS 7 i) 32 e A5 H I 11 204 il 3= 00k
AF E O B A A I R AR A (5UHY 68)
52.3 1 FH =58
FHIEE R
TERIH G EE R R, T B frtlid CFC BIER Z AT A BRI o
TEA CNTIHREE) T, AR N S8 32 fit“color_gs™ il H f i 1 BT A e
KL TR P ZRIE AT
o XZRAFR
Xt PCS 7 iR h B AU
o TSR
H () ] o At 1 44 Bk
I HR P e 1 ] 6 ok
o HLK
o SRS
e 3¢ CFC E%
IR AP fE AL e T U CFC B3R
g | /5 &X B #H5% CFC
£ % %7 B
FB40 |INT P A A N AR IR B RR 43 Tk CFC_LI111
CFC_FC111
FB46 |OP_A_LIM B BAUE P AE IR CFC_FC111
FB48 |OP_D BPHA A EAE IR CFC_FC111
FB61 |CTRL_PID 4 PID s T2 CFC_FC111
FB63 | DOSE E AL T2 CFC_FC111
FB65 |MEAS_MON B R ASLALL U k(L T CFC_LIM11
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G# CFC 7

5.2 (/)%
X% we X E>3 #H2: CFC
& % et B
FC63 |MUL_R AR AAE i Hh S 45 SR e CFC_FC111
FC275 |CH_AI b B B 5 LIV EIAEEN CFC_LI111
CFC_FC111
FC276 | CH_AO KBRS A AL YR TP CFC_FC111
FHIEEF RS RS R
A LURH S 3 Hese Al 8] (1) 07 208 E 8 R i AN B bR 22 2
“color_gs"Ti H 75 Z LA N il FEAR 2827
RESS X i3 CFC EI%
MOTOR HHLE CFC I3 CFC_NP111
VALVE Wit CFC K% CFC_NK111

5.2.4 LULEEARIPE

SIMATIC & HES LTI -

1. EEICH(File) >“4TFF...."(Open....)

o

FE 71547 73T JF 35 H ”(Open Project) X% 4E .

2. EFEFE"(Libraries) A5 &,

3. fEkFEYIE T, R R PCS 7 Library V707 M1“color_gs_Lib” %

R
Tk

LisSs
64
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Gl# CFC K#

17 WH
APEE B |%pTE | £E0E |
& | FisrEE B
zzoalor_gz_Lib F:A\Temphcolor_gshcolor__ 2
@ color_gs_ 'h Lib F:ATemphoolor_gz_Prihvcolo_Lib
@ fazt_Lib F:ATemphfasztsfast_L_1
@ fazt_Lib FATempifazthfast_Lib

2 PCS 7 APC YYD

= PCS 7 Librany W70

C:MProgram Files\SIEMENSASTERPPST

C:\Frogram Filez\SIEMEMNS"

STEP?AST

@ R Libram %70 C:\Program Files\SIEMENSNSTEPTAST _
B ey rH_»,I_I
B
HFmAE : l_
EE : [ 2
PImE : l_
£EMA : [ MEE. |
W Bik e |

4. e (OK).

FEF AL P TR AN

525 TR AE f B
Eok

o SIMATIC & H2 T IT

e “PCS 7 Library V70" 2.1 1 F H. & i0is 7 A4 RL A

o “color_gs_Lib”" 3 %4 A CLFT T It H Ol 7 A4 RLIEL
Hik

5.2 1L/

1. ¥EF“8T 1”(Window) >*PCS 7 Library V70 (44L& "(PCS 7 Library V70

(component view)) T4 .

FEFPHFT I PCS 7 brifEfEE.
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G# CFC 7

5.2 1t/

66

- MWHTEALIE g4 H

“PCS 7 Library V70/8k + #5i4/E” ((Blocks + Templates)/(Blocks)).

PEANAE B Bor PCS 7 ARy b Birs nl FH [ de.
. EFVLET(View) >“¥ 41 {5 5" (Details) iy

LD IR B0 R AT, Wt 2 PR IAR S A4 RIS A4 8K . AT DT 8 58 0 TRAE 15 &

o

- AEVEANGE R DR, R LU BRI S T R B

FB40 - INT_P

FB46 - OP_A _LIM
FB48 - OP_D

FB61 - CTRL_PID
FB63 - DOSE

FB65 - MEAS_MON
FC63 - MUL_R
FC275 - CH_AI

FC276 - CH_AO
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Gl# CFC K#

5.2 (L%
:PCS T Library ¥70 (3H#EM B -- C:\Program Files' SIEMENS . STEP 7% 57libs"PCS_7_Library_¥70
=g PCS 7 Library Y70 HEEHR s HEEEE TiETFigaarh - | 68 «
Blocksz+Templates &3 FB34 AWER_P Sl a70 Thik
EFFBIE COUNT_P SCL 342 Thig
g
-] Shared Declarations g Eg;g B:EF"*:[;T_P ggt ;gg gg;ﬂ&
ZFFR40 INT_P SCL 234 Thae
Z3 FB41 LIMITS_F SCL 218 Thiegh
ZFFB4Z MEANTHM_P SCL 1308 Thegth
ZFFB43 MESSAGE 5CL E2E  Thie
ZFFR4R OF_aA SCL 188 Thie
ZFFR4E OP_aA_LIk SCL 360 Thie
EF FRAT 0P _a_RJC SCL 390 Thig
ZFFR48 op_D SCL 288 Theeth
ZF FB43 OF_D3 SCL 1138 Thig
L3 FESO OP_TRIG SCL 168 Thaeth
L3 FBS1 PT1_P SCL 412 Thiegh
&3 FBR2 RaMP_P SCL 526 Ihie
L3 FBRS CH_CHT 5CL 1154 Thig
I3 FEED CH_MS SCL 1368 ThigEth
3 FBE1 CTRL_PID SCL 6504 ThiE
EF FBEZ DIG_MOM SCL 1694 Thegkh
1] | Ld

5. kPE“4niE”(Edit) >“E #]"(Copy) 4 -

6. EFE 1”"(Window) >“color_gs_Lib (Z1{4#LE) "(color_gs_Lib (component view))

e

FEAT I - E 2
7. P TR A H
“f£ <color_gs_MP>/color_gs_Lib/S7 Program(1)/#t (Blocks) H”,

8. ILPEgwi"(Edit) >“KiNG"(Paste) fir 4 .
FEFF R A prik e .
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G# CFC 7

5.2 1t/

‘zcolor_gs_Lib (ﬂﬂ:ﬂEEl -- F:\Temp'.color_gs_Pri\.colo_Lib
5 TE <color_gs_MP>
=& color_gs_Lib . FEES &3 FUE3 &3 FCaia &3 FCave
STIER()

a1 2=

5.2.6 Al A I FE AR A R Y

R
T, EAAEAE R, R RERR AR R A A A T HA R E 3K (Charts) H sk
SRJGAE L) LA, R 350 e B (Templates) H s & il 21 FiAr 25250 (Process
tag types) HzxH.

2k

e SIMATIC & Hi2s O F IT
e “PCS 7 Library V70" 47 - If H O s 7 AR A .
e “color_gs_Lib” T2 #a & C 4T IF H CL s 7 A
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Gl# CFC K#

Tith

8.

9.

5.2 1L/

. PR HLay A O (Window) >“PCS 7 Library V70 (4H4431LE]) "(PCS 7 Library V70

(component view)).
AT I PCS 7 b FER AL RLIE

MATERLIE ik $64¢ H*PCS 7 Library V70/H A4 (Blocks + Templates).
PRGNS B 7R PCS 7 1 [T e B

LEVEANE BV Ik B DL %

~ “MOTOR’

— “VALVE”

VPR i 4“8 (Edit) >4 %" (Copy)-

TEPESE My 4“5 0 ”(Window) >“color_gs_Lib (ZH44-#LE) "(color_gs_Lib (component
view)).

WEARAERE T T 2
R BRI P ) 4 H
“fE. <color_gs_MP>/color_gs_Lib/S7 Program(1)/ Charts 4"

PR 2 YR (Edit) >“F5 " (Paste)..
A0 N AT PR ARSI,

K M“PCS 7 Library V707,

F1 I color_gs_lib”[#) T.) #H Il

10. MK FEAR KL HE“In <color_gs_MP>/ color_gs_Lib/ #iti (Templates)’ (143 .

11

 AETRAE S D IR LU R Ik

- “MOTORS”

- “VALVES”

12. EFE i 2 wiE " (Edit) >“BI )" (Cut).
13. MR R R S0

“In <color_gs_MP>/ color_gs_Lib/ i #2425 (Process tag types)”.

14, EFEE A 2 Gnd”(Edit) >“Ri " (Paste).

B4 N FTIE I FEAR BT,
“WikR”(Templates) H s k4.
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G# CFC 7

5.2 1t/

Ui B

K REbR SR ERAR RS, B2 B3R it FEAR RS 2R AL b A0 35 R AT S0~ P A
fiti (£ “Blocks™ U4 o

I AR AR R < color_gs_MP>/ color_gs_Lib/ S7 Program(1)/ £

(Blocks)”, ¥ EVEANS B 1R A B A O\ I B0 Tl 2 I FEAR 22570 F S0
TP,

5.2.7 BRI E

faifr
A LLREAN T E 7. JXFE, {E CFC
G R H AL B H SR, AR S I, [T L A LA i T R T e 5
BRI RE bR SR A A AE X 2 b, P AAE B “color_gs™ it H I, ml BURAE e =
e 12 o

DR XA, ) DUPRE M FT BN e AT

52.8 an ey K3 Ek AN s

By OR = K080 122 mh A S Il 1) 4 B ORI 36

ik
SIMATIC & #LES LT IF

et e 1 ik

1. EFICHE(File) >“B#...."(Manage....)
. FEFPIIT I BE"(Manage) A FHE.
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G# CFC K#
5.2 1L/

2. WEF“PE”(Libraries) Ac .
3. TEFIR LR R LN & 2 A A T
—  FHEE“color_gs_Lib”

- “PCS 7 Library V70”

— SFCJ#
- PbrifERE
|
APEE B |%pTE | £E0E |
& | ﬁﬁﬁ%& -
. SIMATIC BATCH Blocks C: ez’ 5h5
= CFC Library 3 W5
@ PCS ¥ Library W70 E '\F'ru:ugram FilezhSIE M ENS'&S T EF'?"-.S 7
- Hedundant [0 CGFP C:%Program FilezhSIEMEMSAS
&SFE Library I: SProgram FiIesHSIEMENS"-.STEF'?"-.S?
= SIMATIC_MET_CP :MProgram FileshSIEMENSSSTERTASY
@ Standard Library I: "-.F'n:ugram Flles'xSIEM EMSANST EF'?'xS ? -
9 - i _»I_I
[~
B
FHFIE :
EE: 4
A :
£E@E: | pEy | 270 |
F<Hl FEEh |

4. HuliEEC (Hide).
e WBIR AP RS BRI AT IR R

5. Hei“JCH]"(Close).
TR T T R B . E CFC 2% H s h A A2 e,

B e 1 7 ¥

1. P (File) >“&#...."(Manage....)
. FEREF IS F”(Manage) XEHE .
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G# CFC 7

5.2 1t/

72

. EFEPE"(Libraries) 45 &,

. M oK. (Display...).

FE K547 IF 300 Vi (Browse) X EAHE .

. MR TEALIE i $5 .. /[SIEMENS/ STEP7/ STLIBS/ [E/ & 8] % 4

2R RV 7R AR A U A%

- Hdi i E”(OK).

FEFPRE G IR AE . £ BE”(Manage) AR HE R 5112 2 B os FIbR e ik i) P8

AR BRIV, TR 3 3 5.

. B¢ (Close).

74 % FERT AT o
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LI CFC K #
5.3 PH 111 CFC K #

5.3 PH F1 /] CFC &%

5.3.1 i CFC El#%

ikly
— Hl b A 7 B 5 R A 648 CFC Ry s%, Wil JFaaflat CFC K.
fI# CFC BIERHMEA ST
BB P
{ET) 20575 CFC K%
2 fE%5[f) CFC [Pl A2/ g
3 e N R AT T 3% O b AN B 8
PH 1 CFC B%

PCS 7 1“8 mi H”(New Project) [ ‘5 CU7E 1. E4 A T —/> CFC K.
I R A A “ADDIT /7. i CFC K& M ST He . 4 20idE CFC

G 4 HORF BRI o
IE4h, “color_gs™i Hid s #ILE R, HEL] R4 HHmAN, K5t CFC
G4 o P EA T G A

HALIH 5 T B#, h“color_gs™ Wil H ()14 CFC
13 7 I 7 Sl P A2 Rt AR )

5.3.2 “color_gs"Ti H H 7 ELHf Lk K] K ?

e H H i CFC B3R
“color_gs”Hi H # LA T CFC [#%:

e CFC_SETP — M e & Eld
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G# CFC 7

5.3 PH #1119 CFC K%

o CFC_FC111 — J T & 4Rk Rl f 45 bt b AT PR A 23 1
o CFC_LIM11 — i THHIFILA A AL

o CFC_NP111 — JI-FHupLE il

o CFC_NK111 % CFC_NK114 — I T-W[ 145461

BEAS BRI R OC )  o Bg Bl AE CNTTHR D) ALK o, N T
B CFC BRI RIS o IR X A8 AN B R BEA T i B

KT CFC BIRIE T

125 A CFC_SETP. CFC_FC111 }¢ CFC_LI111 K. PCS 7

23 DU FRPR AR AL 1) T A4 58 48 1) CFC &3 CFC_NP111 FiI

CFC_NK11xo X i3 B T AT AL ARSI B i, B 1 KO 7E 4 2 v A7
fits I 1K S FRAR B

i
fE“color_gs"HiH+, CFC

PSR 10 2 PR MR A BT RIS RSO S A Bk, DRV A0 BT SR IR RE R 28 1R 44 PR R 20 BE I
o DI, IRAHRRESIEATIE—FR IR,

5.3.3 CFC BE&“CFC_SETP 5l FEAHX K4 X

CFC_SETP
CFC_SETP HI T-J\ OS j&féhikl. XA HL NI & T
e PARADOS_RM1_QTY Hufi & & 4 kLt
e PARA_DOS_RM1_VOL B g & B4k .

e PARA _DOS_RM1_SEL S5 &E Hin RN 2.
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Gl# CFC K#

5.3 PH 111 CFC K #

5.3.4 CFC B%E“CFC_FC111" 5t fEMxm& X

CFC_FC111

CFC_FC111 AT 4Bl AN E f g B HEAT AR o
R LU BRI SR

o “CH_APBRAE" Vi i di 418 {1t 24 1 B LR PR I B (LA 1L B "DOSE" LK “PV_IN"
CREFRED HA i o

FAMINT_P Y T AE R4k .

“CTRL_PID”Heii i i 12 42 i fs-42 1 5 B 45 Rh S

“CTRL_PID"Ht5“PARA_DOS_RM1_VOL"H— kil i A5 k42 s e e

FEREFE AT SR AL 1 AR 5 S i), TR AR Y AR e e i H i “LMINT B H O L RIS B “CT
RL_PID B fr) % Nt “LMNR_IN”

“CH_AO” B fi [ it h 15 A2 &

5.35 CFC B ZE“CFC_LM11" 58214 X

CFC_LI111
CFC_LIM A J FH MBI TSI, o IR R DL B B35 L T
o “CH_AP B A JSURHGE I B A I L iVl 224 AL
o BRUGULT, Mt 5“MEAS_MON UK “U i N\ B

o CINT_P B H AU AT

5.3.6 CFC E#%&“CFC_NP111" 5124835114 X

CFC_NP111
CFC_NP111 JHTadil. XM ol P& X
o “CH_DI"Hereki i QL LA i M iRk T HFEHD .
o J(E HXTIHFEATRAE) MOTOR S “FB_ON" i A\ (Jeist ON) Hi#.
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BI# CFC H7#%
5.3 PH #1119 CFC K%

o “MOTOR™ B 1) #ff: b3 ol B vy 2 ] (R P il s 42 oo

e “CH_DO"#\"MOTOR"He¥)“QSTART iy H iy HX 15 425 il iy 2 FF AL b FE HHeoKs b iy 2 11

EEIER

53.7 CFC E&“CFC_NK11IX" [t fEMH %4 X

CFC_NK11x
CFC_NK11x FF 1 145kl o X Rl N ER A& Sl R -
o “CH_DI'Hul 0 TIRPRA FTIFEERHD 1 Rtk Rl 25 “VALVE Bt
o “VALVE" UM /M il 45 sl S BTN B DD S R FRDIR A il g 248t “CH_DO
i 9K 5 7 M “QCONTROL i H i A 356 45 1
o “VALVE" B ] b e i S 2 B4 Bk o
5.3.8 TB’

5.3.8.1 e 7E PH HEm4 CFC EXR

kR
o W7E SIMATIC & HEES T IF LT H »
o UL LT M.

HiE

BBz CFC KR A7 /e T“ADDIT” S0 . BLE LR kT H v 44
1. FERTEALE it £ “color_gs_MP/color_gs_Prj/Plant1/RMT1/FC111/ADDIT” ({43 .
2. {EVRANE BT DB CFC(1) 4 .

3. P gmiR"(Edit) >“XF 58 " (Object Properties).
4TI @ I CFC X %”(Properties CFC Chart) XFig#HE, A ()5 #1”(General)
IR AL T IE IR .

PCS 7 - NI'145%8 - 55 1 #4>
76 A48, 09/2007, A5E01222374-01



Gl# CFC K#

5.3 PH 111 CFC K #

4. e NAEF N 2 FR“CFC_SETP”,
PR SERR I H A RS S5 PR e ARG A <, DUMEAR IR FEARSS,

EocEx ____________________K
= |E |
ABFRM) - |CFC_SETH
I B e iE - color_gs_PriSIMATIC 400(1MCPU 417-4457 12 (1 MBI
T¥ReE color_gs_Pri\PlantT\AMTTAFCTT1%A0DIT
T B i E - F\TemphTest_2_M\Test_Fii
TEE(4): |

tilERRE] 2007-10-08 13:45:26
Lk EECTR E] - 2007-10-08 13:45:36
BIEIC): -
[~
W me | e |

5. i (OK) fRAFHmA o

5.3.8.2 nfE PH 46 A B CFC E&

EiHEAK CFC B&
WA LA %S CFC BRI RAHALLF CFC BI%:
« “CFC_FC111"
o “CFC_LNM11”
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G# CFC 7

5.3 PH #1119 CFC K%

R

Ttk

o [\ {F SIMATIC & H ge T HF LI H .

o CHUET) K.

1. IWBHTEALIE ik +¢
“color_gs_MP/color_gs_Prj/Plant1/RMT1/FC111” 30 44:3%,

2. EPEE A A H A (Insert) > ] %} 5"(Plant Objects) > 2 CFC.

¥4\ CFC EI%“CFC(1)’. #EAMEIEN, PCS7
S ST L CFC NI B4 5 I BRI 44 FR X387 4 R B s Ao

3. MINLFR“CFC_FC111”3f4% Enter %,

4. MASTERLIE ik %

“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1/ LI111” 33

5. MEFSE A E N (Insert) >“T.J %14:”(Plant Objects) > 2 CFC.
#if N CFC K “CFC(1)".

6. HINLFR“CFC_LI11173:¥% Enter 4.

5.3.8.3  Wf#HEA“MOTOR" T FEras KAl

ikl

R

Ttk

78

B EK MOTOR I FEbr 25 AU A- il AE A v
A TR O bR 2 28 A4 N 2 “color_gs™ Wit H 1 L) 244 .

o LU7E SIMATIC & Bas 4T T SL I H o
o OIS HLK.

1. EFMTEAIE S H
“color_gs_MP/ color_gs_Lib/id FEFRr25 7 (Process tag types)/MOTORS”.
TEANE DAL PR o O 21 3= 200 e b i i AR 2587
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Gl# CFC K#

5.3 PH 111 CFC K #

2. %P CFC KL "MOTOR”, #RJ5kFEE v 4“4t (Edit) >“E " (Copy).
3. B AR B A e

“color_gs_MP/
color_gs_Prj/Plant1/RMT1/NPA11"SCAEIE, AR 5 KE £ 8 .y 2 "G (Edit) >*“A505"(Pa
ste).

CFC KR "MOTOR" B4 A 21 J2 B S Il ade v

4. EFESE A A “YwiB"(Edit) >“%T 4 & " (Object Properties).
FFT B CFC K3k (Properties CFC Chart) X} i&#E.

5. fE“4 %" (Name) HEHHERIA A FR“MOTOR S 25 4 “CFC_NP1117,

6. H i E"(OK) TRAFHIN o
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G# CFC 7

5.4 2Lprk ...
5.4 HEPRE...

5.4.1 T B 4 E50IRES

ERRIKABES
11 SERRAIEE CFC EIR Mtk s 1, BP L5 7 LA N ASAT 45
o KA TR IS FEAR RS AL T
o LB T “color_gs"Mil H AT EL NI, XA A “color_gs_Lib” = £k FEA AR v I
o LMETL JEHhE A A IHEAN T HH CFC K%k,
o UMEL] RN T “MOTOR I FARZE A,
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80 A1 1451, 09/2007, ASE01222374-01



Gl# CFC K#

5.5 [/l CFC #i#7#

5.5 i CFC 4ig5e

5.5.1 CFC i afaif

CFC 4w 3%

B in= S

CFC K 5Lhr LI qE CFC gl seh AT g, Bltnid NIt iS5, —FJF
CFC K%, #4$IJF CFC
RAERS . ZARARSSFT T AL LR e A S o< T RPIR A

FEHBLE N, CFC gifRasdtfr 17 in iz

o TEGRARIIINZENAT BB R CFC %, W CITIFNE AN CFC

B2, MR SAEE WA rTR S i Z A i A BOR SR E L e . 25,
IRy Be 2 HOF R L B

o {EGRAIIAMSE RSB, M CFC BRI H .
PCS 7 2 HENRAEIEXT CFC S 4 P v A7 L A% .

K CFC gmHas M E4IfE I, WS HAHNM CFC & LI LT M (SIMATIC, S7 11
CFC, #EZ:ThEEE) (SIMATIC, CFC for S7, Continuous Function Chart).

5.5.2 CFC %rig28+ 1 CFC EI&R

CFC B%*

A~ CFC BFR & ik 26 NMEIKrIX. H CFC
FR A — AR X X color_gs™ Wi H , A —AMEIR X Z BT FANEEE
I3 XN TAER 4L

T P T o AL PO S [ L2 047
o wATIER: O

o ot TERnEE: B

ARASRE B 4T % IR WA PR 26 2 B TR O A T AR 2.
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L1 CFC K%
5.5 (/] CFC %47

ME WY EN A TAHER
Xk it (K TAEZR, Al RO, S AL D48 21 A AR AL
S YL AR IR A AR AL T s IR HE A7 -

1 4

FEnfE 2

TEANGE ., TS HAHNY CFC 4 BhLL K T (SIMATIC, S7 (1
CFC, H#4:ThAEE) (SIMATIC, CFC for S7, Continuous Function Chart).

55.3 CFC 23+ H =X

FIFFE*
IR H SR MARSTIT, 5 HIS A & "L (View) > H 3%"(Catalog) 117

HRWARE
WA H g P B BIUA RS
o “HU"(Blocks) — RIYELLAL R BFL R R 51 53 B
{E“color_gs"Wi HH, KA B HIEARSE o

PCS 7 - ANI'J#5# - % 1 4%
82 A1 1451, 09/2007, ASE01222374-01



Gl# CFC K#
5.5 [/l CFC #i#7#

o “KEE"(Charts) —
nAELAN R B ) E bR T A AR, #ilan, CFC _FC111. CFC_LI111.
2 CH I B onAE CFC gaf 2% 1K) CFC &R LL—ANNMBFTIF SO TR

o “[i"(Libraries) — G5 PCS 7 Al A1 T 54 2
CEPAT T “Bak” D) fEHs “color_gs™ il H 1 T A 77 B H T 4135 R 40 11 A B o
XA L REE I “color_gs_Lib" % .

o “RIKE M (Unplaced blocks) — A 7EL AL 2 ALE CFC & Bor bk,
fE“color_gs™ Wi H I, HFIH R ERARBCERB", FrAAS BoRtirgg,

CEpIITED=)

TEAE L, WS HEANIY CFC /R4 MBI LI T (SIMATIC, S7 1)
CFC, HE4:ThftE) (SIMATIC, CFC for S7, Continuous Function Chart).

5.5.4 CFC KIRMATLBMEE

#d
LA)E CFC BZR, V55 %45 € U T T i K20 3%

PB SES

FIITEIRR (7Y 84)
2 A

¥

o FHud NF|“CFC_SETP”
o P AR“CFC_FC111”
o KM AF“CFC_LIM11”

3 VR adlve =

o FMmHIR

o FHRTEN/GHE
4 MR (JTFY 95)

PR RERRRE R, AU i A R, )
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L1 CFC K%
5.5 (/] CFC %47

BREELH B B

B9
IR YT S (I, YRS . TR s OFC
ek R, AR <F1> B BRI TPty

555 {7 CFC EF“CFC_SETP”

faifr

DU, AUk CFC BIERATIT, A RefE CFC BIRH A .
£33

o L1t SIMATIC & B &5 -F 4T IS 30 H o

o LR T) K.
Tk

1. IR TEAR B i 2
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1/ FC111/ ADDIT" ({43 .

2. {EVEUNME B, EF“CFC_SETP 1%, RGP “4miE"(Edit) >“F1 FF XI5 (Open
Object) 14 .
¥4 +TIF CFC it s.

PLAE RV AT it AT I 1 16 3K

5.5.6 CFC ERFISH 2T

ES b
REANBAAE TR
/O, "EANTRASAE B MEXT TR R o BT A% (1R SR L PT A R 5 HE F bRt 4 213X Sy
Nt o HUBERIE T s 7 HE e o

PCS 7 - NI'145%8 - 55 1 #4>
84 A48, 09/2007, A5E01222374-01



Gl# CFC K#

5.5 [/l CFC #i#7#

P /O LTI, AT LRI W HAefE i) g v R/ BT W24, 1E CFC
FIR ML R EARIXLEESH . ERpENET, nfee CFC EIER T HMELE 1/0

Al LA KR 1/O AN L. 7 57" (Not Displayed) 41, 522245 M6 1/0

M IEHE, LMEi% /O 75 CFC BRI .. thIhaea Bl T CFC

BIRAATH NS i, fE“color_gs”Ti H i, W32 BRABEE

557 TPk B AR N\ E“CFC_SETP”

Bk
e CFC E3k“CFC_SETP".7E CFC %uf s ¥ —
1P 'E:  “color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111/ ADDIT”.
o ATIFH=.
HiE

1. PI¥e3) H s % (Libraries) 310K .
2k T -E# B s“color_gs_Lib” ZE AL

2. (EWIEME S, T JF“color_gs_Lib/S7 Program(1)\Blocks/ OPERATE” U432 ,

3. H5“OP_A_LIM - FB46"H M\ H > Hijit £ CFC K%
PEHCH T e Ba R R .

4. BH UGS CFC BET,
J R 5“OP_A_LIM - FBA46”He[¥1AH N i iR B AT 41 .

— OP_A_LIM-FB46: ey E
— OP_D-FB48: {528 JrURHili% B 1 e WV 38
5. ¥ TS CFC & .
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G# CFC 7

5.5 (/] CFC %47

OP_A_LIM

—

OP_A_LIM

PN E

A
BERAEASPAE I Ja DA (5 03 AR (0 SR B2 R S e
/0, W /REE T A NHEGEENE T TAERKIA .

FEMAOL T, A2 ] B sl B, A& ANE s JEE AR AT HIF HLAE AR A BRIV A

5.5.8 Al K “CFC_SETP " I 4 L S5

Bk
e CFC E|#“CFC_SETP"U.{t CFC 4u/H#s 4TI —
gl 'E: “color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111/ ADDIT".
o CBAPTAH L
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Gl# CFC K#
5.5 [/l CFC #i#7#

1. EFE1 OP_A_LIM S, SR Gk $ 4w (Edit) >“Xt 5 J& #..."(Object Properties...).
AT I @ M — Bu(Properties — Block) X ifHE, LA [1)“H " (General)
IR AL TR HOIRES

2. {48 (Name) Fn AHEH i AN 44 F-“PARA_DOS_RM1_QTY”,
BRINHEDL T, 23050 FE/E R I #L”(Enable operating and monitoring) &% HE

B - crc ESBRBREE
#4 |0 |
2R : OP_é& LIk HheH G : |
EFRIN |PaRa_DOS_RM1_QTY
&iFEIC): Analogvalueoperating [limited) I ;I
=
i a - ¥ OCMW ErEEtE(O)
N
AP B FB4 WIER CRIMEAL. |
HEREL . DE74
EHRCARET D OP_¢, LIk I FJEQEEEF
ErlE OPERATE
[~ MES $B7% (M)
fEE : BASISTO
B A RO4H 0L M4 TR
HEIE).
v BRELEER
T $TED Heis FERD

3. Y )%y N /% L (Inputs/Outputs) 175
AIFE AL ST /0. FAE“4 FR"(Name) 41k 31 B A i AR i HA R 4 7K

4. Flhr s TUnER A" (Value) 51, 2R )5 HIE 50" 55 BRIAE .
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G# CFC 7

5.5 1t/ CFC %i#4#
B - --crc_ ES SRR
=4 10
# |&B&E  [1/0 |ZER <1 i SF... | &I
7 BTRACE |IM Bl 1 [ ] |Bumpless Changeover 1=0n,
1 EM M Bl 1 |:|
9 EMO QuT Bl 0 |:|
i LIME_ QM (IR Bl 1] [ ] |9elect: 1 Linking, 0=Cperako
5 LIME_ LI |IM REAL 0.0 |:| Linkable input: U
z QP _EM  |IN Bl 1 [ ] |Enable 1=Cperatar may inpu
11 QERE. QuT Bl 1 |:| 1=Erraor
14 |QOP_EM [QUT Bl 0 |:| Skatus: 1=0perator may inpl
12 |QOP_ERR [QUT Bl 0 |:| 1=0Cperator Error
13 |QOP_LIM |(QUT Bl 1] [ ] |1=0perator Input has been |
15 |[vHL QuT Bl 0 |:| 1=High Limit of ¥ Ackive
16 |OWLL QuT Bl 0 |:| 1=Lows Limit of ¥ Ackive
g U IN_oUT |REAL 50.0 [~ <A EERE=| [ | |Operator input
3 _HL IM REAL 1000 e |:| High Limik 11
4 ULl IM REAL 0.0 |:| Low limnik LI
| QuT REAL 0.0 Analog Cukpat
< | i
W #TED mE | ®mEm |

5. KGR E T UM ER A A2 (Unit) 51
R los—A M s

6. MiZ F 5K A IEFE m3/min”fr .

7. HliHfi e (OK) M FHBCE
ZFRPARA_DOS_RM1_QTY Kt iE7n7E CFC KRR Iy Hprd
FEQUEER R IR, K5 3% CFC BRI H /O A At i iR 52 o
WA L) 2. CFC EIRRA TR ML
o RIMAFRPARA_DOS_RM1_QTY" % T A& &4 1 —# 7.
L EANASE R IONIUEIER
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Gl# CFC K#

5.5.9

Bk

Tiik

5.5 (E/f] CFC % #5#%

8. HEE FRIINERIL eI ATMS R E . Nit, HEHLPE125

Hh T R

HLE /O £ CFC &R P AT L,
9. KK,
B T H H AR 110 & X i} BT
20P A LI |PARA DOS RM1 VOL |U* SE AR (E 500 m3
M

U HL A U SERE 500
OP_D PARA_DOS_RM1_SEL |I0O* 1E N 4 1 OFF
AT E A R

* 1. CFC " ANAT ..

e Bl A\ B|“CFC_FC111"+

CFC K3 “CFC_FC111".7E CFC Zwf#s 4T 7 —
AT -
C AT I H 3% H“FE”(Libraries) 54 n] W,

O BRI 4T IT“color_gs_Lib/S7 Programs(1)\ Blocks” 3 {432

R HBERAEAE A LD 255

- MAFJ“DRIVER”: CH_AI-FC275: Hflf ANE 115 5 Ab 2

— SCPEJCONTROL”: INT_P - FB40: Bifils B4kl i

— CJE“CONTROL”: DOSE - FB63:  JiUkli e 4k
- XIJE“MATH_FP”:

— XAFJE“CONTROL”: CTRL_PID - FB61:
TEREAR T B T A W AR T ARAL

- XMFJ“DRIVER”:

PCS 7 - NI'145# - 55 1 64>
AI14574, 09/2007, A5E01222374-01

“color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111”,

MUL_R - FC63:  3fe L%y A\ A - 7E i i ik

CH_AO - FC276: AbPREL 4 S 5

EESES

89



G# CFC 7

5.5 (/] CFC %47

2. 5 K pontEs) CFC B H B

CTRL_PID
CH_AI —
R
MUL_R
1
|
INT_P DOSE
] ] CH_AO
—
3. KHIKE%.

5510  ffaA“CFC_FC111"H {14 ie S %

Bk
e CFC KZ&“CFC_FC111" . 1F CFC 4t esh 4T H —
G S . “color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ FC111”,
o OUEAFTHLL
I

1. NEAEFT X% 8 P (Object Properties) G HE 114 Hi”(General)
TE T A % /% (Inputs/Outputs) 3£
2. T RN RS

3. FERIAFTAH /O NS HUN, REUCHS Hdi i 2" (OK) o
K B BEE

4. KKK,
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Gl# CFC K#

5.5 (E/f] CFC % #5#%
B I HF AR /O EHX &
CH_AI INPUT_U SIM_ON* P S 1
MODE METEE 4 45 20 mA
16#0203
VHRANGE MR Ve LR 100 **
SUBS_ON A HEARE 1
INT_P INT_P V_HL B R 1000 TF 1000
TI FR 43It 1] 2
DOSE DOSE SP_HLM* FE AR E E I R 1000
MO_PVHR* ST R R IR B s LR 1000
MO_PVLR E AR R R NI 0
SPEXON_L ﬁ?ﬂ%&%ﬂﬁ%ﬁﬁﬁ?ﬁﬁ% 1
SPEXT_ON L IN O SPIE S & 1
MUL_R MUL_R IN2 SE BRI & {H 10 AT I S H q
CTRL_PID |CTRL_PID LIOP_MAN_SEL | A3h/ T3 EiE4 TR 1
LIOP_INT_SEL i%m%%%m@mﬁﬁ%%m%% 1
SPEXON_L ¥ 28 D 2 A e
GAIN BEHSS M aE R E R 0.5 0.5
CH_AO OUTPUT LMN | AiEH]
* {E CFC thANH] i,
* BRIME
AL
A ERET=X (=S wi il o R A

X LEAME, RN R8I IERE PCS 7 B St e (i .
FhR BT RAMES, 2

b el DR E

A

4 CH_AI B3 il “MODE”I/O.
P LB 2, RARDR B AEAR (NTTHRE) T AR AL SR AN 11O Bk,
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L1 CFC K%
5.5 (/] CFC %47

5.5.11 WA ZE“CFC_LIM 11" RS

f&j o

WAE AN “CFC_LM1EIER . J7ik 561 “CFC_FC11 1B R 58 A1 A
Bk

e CFC KZR“CFC_LIM11"7E CFC 4ufE#sH I IF —

et & “color_gs_MP/ color_gs_prj/ Plant1/ RMT1/ LI1117,

o CHTFFH=X.

o CIEMTEALIE 14T H“color_gs_Lib/S7 Programs(1)\ Blocks” SC -3 .
HiE

HuRB AN S HeR Ai A, IR P PR HAeA], SR 5 R

o AFJK'DRIVER”: CH_AI-FC275: BB Abk i i R I8 B A fE T H 1
CFC " AZkLEHEAT AL BE

o EF“CONTROL”: INT_P-FB40: e TRl s RME 1 1A .

o J[f}“CONTROL”: MEAS_MON - FB65:
RERRARE T AR A AR T LA

MEAS_MON

INT_P

CH_AI |
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Gl# CFC K#

5.5.12

Bk

AT A “CFC_LI111” s IS4y B S 3

EIGR R4 N/ 7 (Inputs/Outputs) LT .

5.5 /] CFC 4i#d#

CFC K%"CFC_LI111"C4E CFC %% 1 T — f#-fiif£ "color_gs_MP/ color_gs_prj/
Plant1/ RMT1/ LI111" 3R

CAmA BT

. NEENHST IR % 8 11 (Object Properties) S5 HE i “ 3 #” (General)

PCS 7 - NI'145# - 55 1 64>
AI14574, 09/2007, A5E01222374-01

2. RN R AT AN
3. RO IS, RRRHE LI e (OK).
B H B
4. KKK
E23 WETH | o FX iR BT
B
CH_AI INPUT_U | MODE MG 4 5 20 mA 16#0203
VHRANGE | Wl LR 500
SIM_ON BEME AL TV SIRES 1
SIM_V JEOR IR 500
SUBS_ON | i HIEAUE 1
SUBS_V SIM_V HI#AUYE 500
INT_P INT_P U RERLJEORIGRE VR A -10
V_HL i LR 500
Tl 23] 1] 1.0**
MEAS_MO |LIA U_WH At I =450 m3 450 m3
N
U_WL BETR=7 m? 7 m3
U_AH o EFR = 490 m3 490 m3
U_AL WETHR =5m3 5 m3
MO_PVHR* | Aashid B Eos F R 500 m3
MO_PVLR* | A& i B 2 N IR 0 m3
HYS i JE 1
* f£ CFC AR L.
** IRIME
93



G# CFC 7

5.5 (/] CFC %47

R

Tk

94

B B

4 CH_AI

Py Be“MODEO. 2 T VE A RIS, WA R TEA (NTTHRR) (Getting
Started) i AR LIEATATHNE 1/0 EERL

WA H“CFC_NP111”H [ S S

CFC_NP111 KR C A A RER R A o
XTI, PR BN S BEE AT, S G color_gs™ i H .

UL
A P RE RS AL N JE 1B SR A BRI AR

CFC 3 “CFC_NP111" .7t CFC i #% 1141 JF — 17 {t“color_gs_MP/ color_gs_prj/
Plant1/ RMT1/ NP111”3C {4,

1. AT 0% & 1 (Object Properties) %% HE H1 {114 #1”(General)
I T FD i N/ H 7 (Inputs/Outputs) T 1< .
2. TR S

3. Hdi*ffi " (OK).
R I

4. KHEE,
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Gl# CFC K#

5.5.14

R EIE

5.5 (/1] CFC %i#i#
8>3 WEF1M4% |10 X B
&
CH_DI FB_RUN SIM_ON DI B b T 5 SRES 1
SUBS_ON Ja S AUE 1
MOTOR MOTOR MONITOR A AR Monitoring (1
) = Off
AUT_ON_OP* Wos B 3 Mode (#iz{) =
AUTO
* 7£ CFC "hART] I,

CFC BRI B

AR, R A B o AR i AT O . g e CFC

S A B P S o T DU b g . b, it B, SRS R
BHZE RN AN G, TERR A —44. CFC

T e C P PR T B VA WITES S A DA WA MBI it &SR AL T

L
U R P 2 I FR AN TR -
PSRN LIRS, NS E R AR (Edit) >“ B (Delete) i

“CFC_SETP” }2“CFC_NP111" B £ K5k 2 ib

CFC_SETP KIZRATGZAEM HIE, P KR T T4 € BUE EANA AT S dr

CFC_NP111

Bt AN EAT AT FE, DA BB RG] T I REbR 2R, Il S gt vr 1 AT (L
LN
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G# CFC 7

5.5 (/] CFC %47

55.15  WffE“CFC_FC111"h H &R

ik
e LL7E CFC %ifft &% '#TJF“CFC_FC111"CFC &3,
o CUEAFTAR, JEXIEA T T Edar A A,
Tiik

1. 7E'INPUT_USk_E i v

2. I INT_P BRI A U7,
CFC %ifHdht BalAd il — 4 HIELk.

3. PATHIFL R, 2 FRIIEM KB
CFC &R #5 W1 kPR

96

PCS 7 - NI'145%8 - 55 1 #4>
A48, 09/2007, A5E01222374-01



Gl# CFC K#

5.5 [/l CFC #i#7#

CTEL_PID
CTEL_PI
PID Con
O |DEADE _WESPEXTOM[—
5 |GAIM
o TH
oo Ty
i@
o}
o}

IMPUT _U
CH_RI
Analaa
164203 MODE WEAD—
16#0— WAL UE Ll
dmm . O—{WHEAMGE | [GUALT TS LLL_LHG |
O B—ULEAMGE dmE . Ml _ Lk H Lk
1—STh 0K o, bl _ Lidbd L HC_ Lk —
O O—EIn_U PU_Ih EEI—
1—EUEE_0M d6#E0—ac_PU_TH 1
00— EUES_N 1@ 3wl _PUHE
o]
o.m—pIEy
O—CEF
Mo Track |5P TEE
O _0—Ep_FXT
dmE . B EPEXTHL
OO EPEXTLL
1—LIOP _IM
1—SFEXOM
AmE . B~ Lk _HLH

_—_—

o O—{ Lk _L Lk

—_—

o _O0—LHM_TEK

_—_—

IMT_F OOsE
IMT_P DOEE
Inteara dozing

i _ZEL
1—LTOF_HAH
z.m—TTI auHL |- o_@a— — O—AUT L

imom . B— _HL HMLLI— 1—SFEXOM — I—LMNR I
ooo—u_LL u pu_in [ aToL_prl- 64 50—0C_LHkE

[}
u 16#50—{ac_pu_TH| aroL_H|- 16e50—{ac_LhN
1. 0-gy o] al- 4
@ . 0—{uT EACE 1-{sPEXT 0 ac_al-

a—TEACK a—ack_ToL [dEELxING- aUTPUT _ LM
a—HALD a—L_sTAET [dspExTanf CH_AD —
A—PAUSE Py_ouT - Analcs 346
a—LI0P_SE EEl 16#0—|MODE aEAD|—
a—cAMcEL | [DEIEE Ef— M YALUE-
1—ETHOETL 1m@ . @—UHEANGE | [BUALIT Y|
A—{CsF @ . O—ULEANGE
16#50—ac_g_T a—{=Im_on
0. 0—{ZTm U

4. KHEE.

B i S A
INPUT_U V INT_P U

INT_P V DOSE PV_IN
MUL_R ouT CTRL_PID PV_IN
CTRL_PID LMN OUTPUT_LMN U
CTRL_PID LMN MUL_R IN1
CTRL_PID LMN CTRL_PID LMNR_IN
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G# CFC 7

5.5 (/] CFC %47

5516  f7E“CFC_LIM11 " H &R

R

e U{E CFC #wffias ] JT CFC E%“CFC_LI111",
o CHEAPTAYL, JFXENIAr T Ea A M.

Titk

1. 3R B .
CFC A&t Ja 15k i 1 Frs:

LIA
MEAZE _on 0BS5S
Meas . wal 4.3
B C5F MH_ALH|
y oL _ALm]
A6#E0—Gc _U HH_WER
4a@ .0 |y _AH LAl _WEM]
4503 () WH
R TR
S.@ (U AL
1@ [HY=
IMT_P
INT_P
Int=ava
18411 HWHL —
Som ooy HL AULL
iy [T L'}
-d@_a—uy
1.8—HYE
UTRACK
O—TEACK
G—HOLD
IMNPUT _U
CH_RI
Analas
A6#203—{MODE | AERD—
16#A—UALUE Y
S O— UHEAMGE | [GUALIT %f—
O . O—ULERANEE
1—EIM_0n
SEE _D—EIM_N
A—{ZUES Ok
SIOE _O—EZUES _U

98
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Gl# CFC K#

PCS 7 - NI'145# - 55 1 64>

5.5 [/l CFC #i#i
2. KHEE.
B it S A
INPUT_U Vv INT_P VTRACK
INT_P v LIA U
99
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Gl# CFC K%
5.6 UFEXIZ A 119 CFC K#

5.6 TRENZAUE T H CFC E&

5.6.1 A A AR S AN B REAT 1R 14 )

(kN
ILAEALPEIE % CFC_NK111 & CFC_NK114.
FIHF AL, 8O BRI T VALVE S FEFRZ2RM, JEET) E% b ald 7Y
NEL A,

EREENZIE
NAEFLLPAH IR B, DAL 2EE PCS 7 i — M RE R ThBE: 1 REXT S ALIE

R K (E CFC
G P T IF A A IF IS G AR, T LAZE LR G 4 e B s 4 (.

N It EEA LT
o N FEXTGALE E SGEREARZESRAL 1) 170 (T 100)

UM L, R AL IEA RS PTAT 1 1/0, Il 0E SCE 7R 10,
SR AE B P R AR B D x5 1

o Ay AL RERRRERIY LI RS A (DU 104)
AR E BN i T I CY NS B €7 S =Xl d s ne S vl R N E el D S B R e

o SRR R IS HE (U 105)
PUR LA K B W R G AL (e s T e v ARy (5 M 2 4

56.2 B
5.6.2.1 anfe] Ay ik AR AR B ke SN S

R
o [\ {F SIMATIC & H ge T HF LI H .
o TR FEXS G
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Gl# CFC K#

5.6 WUFEXNZR A F1T CFC K

ik

1. MR TR ] ke 4%
“color_gs_Lib/id Fibr2525% (Process tag types)/I® (Valves)/VALVE %% .

2. EFSK a4 “YE TR (Options) >“IX 2% %" (Process Objects) >“%#% 1/0..."(Select
/0s...).
“REyE s . EPER(Filter: Select Connections) X EHER T IT o

3. WUE P (Block) Sk, FfArim AME 4 A H VALVE,
I B AV 2R “VALVE ez .

i - R 1/0 |
HE BT FHILLER 7

R 140
I~ 28

I {Zar AIY)

FET 8 - e
I B |

V 5B [t/alve]
I EE

~ sEkpo)
[~ 110

I Hage®ify)

I EwRERH)
R RENR P

4. FEHE"(OK).
FFTFF ik 110 (Select 1/Os) X iFAE

5. Hii“S4"(Parameters) 4111458
MR AR AT BoRAE“S80 (Parameters) 41 HHGE I FTA 1/0.
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G# CFC 7

5.6 UFEXI R F1) CFC 4

6. AEFIIXEE 1/O (¥R IEHE .
7. 4" (Parameters) 415G LL R 1/0 [ IEAE:
— AUT_ON_OP
— MONITOR
— START_SS
i o

IR O B R, T /O Hg AT BB HE Y o
IXFERUE 5 THRBI P A N A

PCS7- NI/ - 5 1 #45
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Gl# CFC K#

5.6 WUFEXNZR A F1T CFC K

EFE 1/0 - color_gs_Lib\ S EE S XX WALYVE

BTN RN AP RE S BAES.
g I'EQ'='VaIve' HE..
BN [ [ [pure (0% VO R TR 10 (58 [5S B0 / 110 [BE R [Jemasa =
7 7. [WALVE [VALVE [Single-..|AUx_PR10 Aviliary Walue 10 1| [ &N IM... |VALVE | CFC WALVE
g 7. WALVE [VALWE |Single-..|AUT_L Linkable Input ... 1| [J |BOOL IN - |VALVE |CFC WALVE
9 7. WALVE [MALVE |Single-..|AUT_ON_OP Operator Input ... [v] | O |EOOL IM... |VALVE | CFC WaLYE
10 P |WALVE |WALWE |Single-..|AUTO_OC AUTO Mode:1=... O | O |eooL IN |VALVE |CFC WALYVE
" 7. WVALVE |WALVE |Single-..|AUTOP_EN Enable: 1=0per... O | O |eooL IM - |WalvE |CFC WALYE
12 . |WALYE |VALVE |Single-.. BA_EM Batch Enable O | O |eooL IM - |WalvE |CFC WALYE
13 . |WALVE |VALVE |Single-..|CL_OP_EM Enable: 1=0per... O | O |eooL IM - |WalvE |CFC WALYE
14 7. |WALYE |[VALVE |Single-..|CSF Contral System ... O | O |eooL IM - |WalvE |CFC WALYE
15 . |WALVE [VALVE |Single-..|EN ] [] |BOOL IM - |WalvE |CFC WALYE
16 7. |WALYE |[VALVE |Single-..|ENO ] [] |BOOL QuTValvE |CFC WALYE
17 7. |WALYE |[VALVE |Single-..|FAULT_SS 1=ln Case of Fa... ] [] |BOOL IM - |WalvE |CFC WALYE
18 7. |VALVE |WALWE |Single-..|FE_CLOSE Feedback: 1=C... 1| [J |BOOL IN - |¥ALYE |CFC WALYE
13 7. |VALVE |WALWE |Single-..| FE_OPEN Feedback: 1=0... 1| [J |BOOL IM |¥ALYE |CFC WALYE
20 7. |WALVE |MALWE |Single-..|L_RESET Linkable lnput B... 1| [J |BOOL IM  |VALYE |CFC WALYE
21 7. WALVE [MALWE |Single-..|LIOP_SEL Select: 1=Linkin... 1| [J |BOOL IN - |VALYE |CFC WALYE
22 7. WALVE |MALVE |Single-..| MAN_OC Operator Input: .. 1| [J |BOOL IM... |VALVE | CFC WALYVE
23 7. WVALVE [MALVE |Single-..| MANOP_EN Enable: 1=0per... 1| [J |BOOL IN - |VALVE |CFC WALVE
24 7. WALVE [MALWE |Single-..| MONITOR Select: 1=Monit... [wv] | [] |BOOL IN - |VALVE |CFC WALYVE
25 &Y. WALVE |VALWE (Single-..|NO_FB_CL 1=Mo Feedback... O | O |eooL IN - |VALVE |CFC WaALYVE
26 7. WVALVE |MALVE |Single-..|NO_FE_OF 1=Mo Feedback... O | O |eooL IN |VALVE |CFC WALYVE
27 . |WALYE |WALVE |Single-.. NOMOMN_CL 1=Mo Monitorin... O | O |eooL IM - |WalvE |CFC WALYE
28 . |WALYE [VALVE |Single-..|NOMOMN_OP 1=Mo Monitorin... O | O |eooL IM - |WalvE |CFC WALYE
29 7. |WALYE |VALVE |Single-..|OCCUPIED Occupied by Ba... O | O |eooL IM - |WalvE |CFC WALYE
30 . |WALYE [VALVE |Single-..|00S 1= Out of Service O | O |eooL IM - |WalvE |CFC WALYE
il 7. |WALVE [VALVE |Single-..|OP_OF_EM Enable 1=0Opera... O | O |eooL IM - |WalvE |CFC WALYE
32 . |WALYE VALVE |Single-..|QAUTOP Status: 1=0Opera... ] [] |BOOL QuTValvE |CFC WALYE
33 7. |WALVE |WALVE |Single-.. QCL_OP Status: 1=0Opera... ] [] |BOOL QuTValvE |CFC WALYE
34 7. |WALVE [WALWE |Single-..| QCLOSED 1=Walve iz CLO... 1| [J |BOOL OuUT|YALYE |CFC WALYE
S Y. |WALVE [WALWE |Single-..| QCLOSING 1=Walve iz Closing 1| [J |BOOL OUT|YALYE |CFC WALYE
36 7. WALVE |MALWE |Single-..| QCOMTROL Control Qutput: .. 1| [J |BOOL OUT|VALYE |CFC WALYE
7 7. |WALVE |MALWE |Single-..| QERR 1=Emor 1| [J |BOOL OuT|VALYE |CFC WALYE
38 7. |WALVE |VALWE |Single-..| DGR_ERR 1=Group Errar 1| [J |BOOL auT|VALVE |CFC WALVE e
39 7. WVALYE [WMALVE |Single-..| OMAN_ALT 1=AUTO, O=MA. . 1| [J |BOOL auT|VALVE |CFC WALVE
40 &Y. |WALVE |MALVE |Single-..| OMANOP Status: 1=0per. .. O | O |eooL OuT|VALVE |CFC WaALYVE
41 7. WVALVE |WMALVE |Single-..| QMOM_ERR 1=tonitaring Error O | O |eooL OuT|VALVE |CFC WALYVE
42 7. WVALVE |WALVE |Single-..| OMSG_ERR 1=teszage ER... O | O |eooL QuTValvE |CFC WALYE
43 . |WALVE |WALVE |Single-.. OMSG_SUP 1=teszage Sup... O | O |eooL QuTValvE |CFC WALYE
44 7. |WALYE [WALVE |Single-..| QOFP_ERR 1=0peratar Ermrar O | O |eooL QuTValvE |CFC WALYE
45 . |WALYE |WALVE |Single-.. QOP_OP Status: 1=0Opera... O | O |eooL QuTValvE |CFC WALYE
46 7. |WALYE |WALVE |Single-.. QOPEMED 1=Valve is OPEN O | O |eooL QuTValvE |CFC WALYE
47 . |WALVE [VALVE |Single-..| QOPENING 1=Valve is Open... O | O |eooL QuTValvE |CFC WALYE
48 7. |WALVE |WALVE |Single-.. RESET Operator Input E... ] [] |BOOL IM... |WalvE |CFC WALYE
43 7. |VALVE [WALVE |Single-..|S5_FOS Safe Fosition. 1... | <P> safe posi..| [] | [ |BOOL IN - |¥ALYE |CFC WALYE
50 7. |WALVE [VALWE |Single-.|START_SS 1=5tart with Saf... W] | [] |BOOL IM - |¥ALYE |CFC WALYE LI
W
wE | gFEER| gos. | #uo. mE | wmm |
7

8. Huili“ffi " (OK).
B A 1107 (Select 1/0s) XA HE

9. KHIEFEXZAK .
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AT 4675, 09/2007, ASE01222374-01 103



GI# CFC K7

5.6 UFEXIZ A 119 CFC K#

5.6.2.2 WA 6 N “VALVE" T FEfr 2 K R

R
o [\{F SIMATIC & ge T HF LI H .
o UUHMIE T MK,

Tii:
{55 MOTOR I b 26 2 58 A A 1K) T 1+

1. {E“color_gs_MP/ color_gs_Lib/ i bR (Process tag
types)/VALVES” U [RGB T, EREVALVE I FEFR 25,

2. ¥ f“4mi8"(Edit) >“5 %" (Copy) Al“4wi8"(Edit) >“Killk”"(Paste)
KA, ELL R SO N VALVE it FEAR 28

— color_gs_MP/color_gs_Prj/Plant1/RMT1/NK111
— color_gs_MP/color_gs_Prj/Plant1/RMT1/NK112
— color_gs_MP/color_gs_Prj/Plant1/RMT1/NK113
— color_gs_MP/color_gs_Prj/Plant1/RMT1/NK114

3. 4% FRE A AN MRS
4. KT K.

BERIAR HiwdiN:

./RMT1/NK111 CFC_NK111
./RMT1/NK112 CFC_NK112
../RMT1/NK113 CFC_NK113
../RMT1/NK114 CFC_NK114

ARVEM U], ES%
WA N “MOTOR L FE bR 2SR (TTHS 78) %84 -

PCS 7 - A1 1451 - 45 1 #5>
104 AI4675, 09/2007, ASE01222374-01



Gl# CFC K#

5.6.2.3

2K

Tith

5.6 WUFEXNZR A F1T CFC K

AT S “CFC_NK11X" (1S

O SIMATIC 55 B 28 rh 4T T 52135 H «
CLIE I R S AL

. IHTERL I k¢

“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1” 3043 .

. &P (Blocks) T

BaBAT T SO

. &AL 9E" (Filter by column) T $7471 38 F ik £ “H”(Block) 45 H -

AR s« 27" (Display) #E.

. {E*i7R"(Display) i AMEH AP 4 FK: “VALVE”.

R A% AT HOBOF s A YA CFC BRI I (Valve) B

A
Wik CFC BRI A FRAES P o A SeHE, R Ehs B T %" (Chart)

FI| A& 33 F”(Chart Comment) 512 1), 4R 5 A ili.
o Q3RS 5, (FHIES 4 H 5

. E*CFC_NK111”EZ& 1 Heyi: B (Block Comment)

Hihia N4 Frestop_valve1”, #RJ54% ENTER 4.
X2 BT UL R BT A I B AR (B R

IR PR A AL E CFC B MBGAER .

. kP H (Parameters) LI E

BmdEAT T SO

. N1 8 (Filter by column) T Hz41) 3 Hhik $“H”(Block) 45 H -

B s R (Display) i A

. 7E“%7R"(Display) i AHETH AR 4 FR:  “VALVE”,

RAKIEAT T BB
BT U SRR BRI =4 1/0.

PCS 7 - NI'145# - 55 1 64>
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G# CFC 7

5.6 UFEXI R F1) CFC 4

E3 color_gs_Mp (R RMAE) -

[=-{2a] color_gs_MP
=8 color_gs_Pij
-] HE=EE

¢ -y Documentation
- color_gs_Lib

Y Temp' Test_Z_Mi\Test_MP

SEH | it SE8 |58 | e | BEHR | S8R | Raiee | BEEN | HEEg |

R fr=r HHEES
|1;Ja =] |va\ve | =2 | o) nl
=) B (B B it 140 & VOEE .ﬁ_ﬁlﬁ v A

1 Plant1 S RMT 14K 1114 CFC_M...[Valve... |VALVE Single-Drive... MOMITOR Select: T=Monitoring ON, 0=Moriton..| Sars g8 f = —
2 PlantT\RMTTAHETT2Y CFC_M...|Vake... [WALVE Single-Drive... MOMITOR Select: T=Monitaring ON, D=Manitar...|| | FITe] 1% =%

3 Plant]\RMTT5HETT3, CFC_M...|Vake.. [WALVE Single-Drive... MOMITOR Select: T=Manitaring ON, O=Manitar...|| |8 K15 =22

4 Plant1 WA TT4METT 4% CFC_M...|Walve . [WALWVE Single-Drive...| MOMITOR Select: 1=Manitaring ON, O=Manitor...|| | B8] 15 =%

5 Plant SRMT15HETT1Y CFC_M...[Valve.. |WALYE Single-Drive...[AUT_OM_OF Operator Input Mode 1=AUT0, 0=_.. |||[#8%=F=h

B Plant1\RMT14MET T2 CFC_M...|Valve.. WALVE Single-Drive... AUT_OM_0OP Operator Input Mode 1=4UT0, 0= .. =5ah

7 Plant1\RMT 14K 134 CFC_M...|Vakve.. WALVE Single-Drive... AUT_OM_0OP Operator Input Made 1=4UT0, 0=.. |||[#85=F=h

8 PlantTWRRTTAMNETT 44 CFC_M...|Valve... [WALVE Single-Drive...| AUT_OM_OF Operator Input Made 1=AUT0, O=.. |||[#8x=F=h

3 Plant1 WA T 14K 3N CFC_M...|Walve . [WalWVE Single-Orive.. | START_SS 1=Start with Safe State Position and... ||[1

10 [Plantl\BMTTSHET14Y CFC_M...|Valve... [WALVE Single-Drive...| START_SS 1=Start with Safe State Position and... ||[1

11 Plant1WAMTTYETTTY CFC_M...|Valve... [WALVE Single-Drive...| START_SS 1=Gtart with Safe State Position and... |0

12 [Plantl\RMT1SHEIT 2 CFC_M...|Vakve.. WALVE Single-Drive... START_S5 1=5tart with Safe State Position and... |||0

I«

106

10. ¥e2)E"(Value) 51|, SRJ54% RSN {E .
— ROURRE T AN .

VLB AR A AR A~ P RAE.

— FE M RLAE R

AU E T E (Value) 1

CFC Bl%

CFC_NK112 stop_valve2
CFC_NK113 stop_valve3
CFC_NK114 stop_valve4

PCS 7 - NI'145%8 - 55 1 #4>
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Gl# CFC K#

5.6 UFEXIZRHE 119 CFC K #
iR
MRE WL ST ISR, TRETCIA A 24" (Chart) 51, At i B2 7 Bt 5 1/0
HUAR AR R

R AL SR AL L 2L 5

M. CROEARE TR SN 4 55 58 /2 MK AMEIF i o
PR A E AR AR R TP AT L.

12, AT RS R AR E AR L 3h 2)°1/07 8 5 i .

13, MAJFRlbntZAL.
R PR L e 1, AR5 ] DM AR T I ACTHR B A AE A AT L, RS &

BoRAELM .
CFC B% I/0 X 18
CFC_NK111 START_SS TRV (FTIFEHD 0
MONITOR XS B AT IEAIOR AR S5t Monitoring (i
M) = off
AUT_ON_OP B iR U3 B sh il Mode (#:) =
Auto
CFC_NK112 START_SS 0, 3 0
MONITOR S k3 Monitoring (i
W) = off
AUT_ON_OP Z 0 B3 Mode (#i:) =
Auto
CFC_NK113 START_SS Z0 1
MONITOR S 13 Monitoring (i
M) = off
AUT_ON_OP Z L3 Mode (#izl) =
Auto
CFC_NK114 START_SS Z L3 1
MONITOR S k3 Monitoring (i
M) = off
AUT_ON_OP Z 0 B3 Mode (#:) =
Auto

PCS 7 - NI'145# - 55 1 64>
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G# CFC 7

5.6 UFEXI R F1) CFC 4

9 color_gs_MP (B3RS WED) - F\Temp'\ Test_2_M\Test_MP

[=-{@s] color_gs_MP
E'@ color_gs_Prj
=] HEER

Ly ERETEREE
B Docume|tation
- color_gs_Lib

BB | el JSE2 |HE | DEHE | oens | Rarer | BER | 55|
HE BT RN
B =l | ¥ |
Eif BEE HFEEE & BT 1405 I/0 R e[S EEEE |
1 FlantT\RMTTSFCTTY CFC_FC111 5 Analog Out.. | VALUE Output value ||| 1680000 =i
2 FlantT\RMTTSFCI11Y CFC_FC111 INFUT_U | Analog Input | VALLIE Input walue 1ER0000
E PlantTARMTT5LA11Y CFC_LIT1 INPUT_U | Analog Input | WALLIE Irput walue 1ER0000
4 Flant1\RMT 14K 114 CFC_NK111 Walve: Single D... FE_CLSD Digital Input  |YALUE Input value a
E Plant1\AMT1MMNETTTY CFC_MK111 Walve: Single D... [FBE_OPEM Digital Input - WALUE Input value 1]
B Plant1WAMT14NETTTY CFC_MK111 Walve: Single D... OUTPUT Drigital Output YaLUE Output value 1]
7 Plant]WAMT14E112% CFC_MK112 Walve: Single D...|FB_CLSD Digital Input - [WALUE Input value 1]
[ Flant1\RMT14ME1124 CFC_NK112 Walve: Single D... FE_OPEN | Digital Input | VaLUE Input value a
9 Plant]WAMT 14K 2% CFC_MK112 WValve: Single D... OUTPUT Digital Output VALLE Output value 1]
10 [Planti\RMT15MET13% CFC_MK113 Walve: Single D...|[FB_CLSD Digital Input WaLUE Input value 1]
11 [Plant!\RMT1SMET13Y CFC_MK113 Walve: Single D...|FB_OPEM Digital Input - [WALUE Input value 1]
12 |PlantT\BMT1SHE1T 3 CFC_NK113 Walve: Single D... OUTPUT Digital Dutput | YALUE Output value g0
13 [PlantlA\BMTTAMETT 4% CFC_MK114 Walve: Single D... |FB_CLSD Digital Input - WALUE Input value 1]
14 [Plant! \RMT14MET1 4% CFC_NK114 Walve: Single D...|FB_OPEM Digital Input - [WalLUE Input value o
15 [Plant1\BMT14MET14% CFC_ME114 alve: Single D... OUTPUT Drigital Dutput YaLUE Output value 1]
16 |PlantT\BMT1SHP111Y CFC_NP111 kator: Single 5... |FE_RUM Digital Input | YALUE Input value a a
17 [PlantlA\BMTTWMPT17Y CFC_MF111 Motar: Single S... | OUTPUT Digital Output VALLE Output value 1] ’LI
L] | ol

5.6.2.4 U]+ e e B bm 2 Y

faifr

108

R, AZGOT U DAy o A v ) B A A . TR AEAE LA BB ThRE, B LI B4
DAREAT R

o Lt SIMATIC & B &5 FF T TS 30 H .
o CHuREREN ALK

1. MBS TEARIE %
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1” 343,

2. FE“H(Blocks) I .
T Py 0 s 1A T S

3. 4515t yE" (Filter by column) 4 71| AE HH ik $“ " (Block) 4% H -
TP B0 i 77 (Display) % AE .

PCS 7 - NI'145%8 - 55 1 #4>
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G# CFC K#
5.6 UFEXIZRHE 119 CFC K #

4. fE“Z/R"(Display) i AMEFHEIARIIZFR: “VALVE”,
TSR0 R A BT SR A i DU/ CFC 3R W or“Valve B,

5. 7ELL T B 1 “HLE 5" (Block Icon) 41l i A 2"
— “CFC_NK113”
— “CFC_NK114”

6. 7% ENTER.
e CSuN el 0] RN SN N S = W S A P

9 color_gs_MP (BB ME) - F\ Temp', Test_2_M'Test_MP

E"%@ﬁjﬂf_ F., VER B |58 |5 | me | BENS | Dumg | Bk | Rem | s

O #=%9H TR : EEE R

n:hflﬂ 2 iy~ | Flo[|
g;gk‘ml%%ﬂ = B Eee B . |epE  |[UEnEh [RER | |[RERER LR
Documentation 1 [Planti‘Rk... [CFC_MK111 [Walve: Singl..[VALVE Single-Diive... —
@ calor_gs_Lib 2 |Plant1%RM... [CFC_MK112 |Walve: Singl...|VALVE Single-Drive...
3 |Plant1%RM... [CFC_MK113 [Walve: Singl... [VALVE Single-Diive... 2
4 Plant1sRM... |CFC_NK114 [Walve: Singl...|VAaLVE Single-Drive... 2

7. RPN ZALA .

5.6.2.5 M BR 5 Hhuht ) B %

fai g

HETH S PCS 7 FE FEARZE A T NK111 & NK114 18/ #2 51 NP111
FALEE o X eI FERRZE AN B S N B ER BN B . B A (NTTHE )
AT BRI I8 FE R N A, BT LR Sm BRI [R) 2 R — 42450 8. Db i
Ik 06 H R i A A

PCS 7 - NI'145# - 55 1 64>
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G# CFC 7

5.6 UFEXI R F1) CFC 4

R
o T7F SIMATIC & PRES T 4T FF 25 i H -
o CUHMEIE RN ZALE

1. M TEARL I e %
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1” 343 .

2. 5 57(Signals) Ik .
P 5o B 1A 7 5

3. Fifif5 5" (Signal) FIKIZIbRE LHEF S 4 H
4. FETH 4 H, A% <DEL> #.

— “digital output (¥r7#it) ”

— “feedback run (15 2IZ1T) "

— “feedback open (4TI ”

— “feedback closed (i xKH) ”

E3 color_gs_MP (FEXRMED) -- A Temp' Test_2_M\Test_MP

- %\%Eﬁjﬂf_ P B (B |58 SRS KR | BENS | SNEE | o | Remt | ses |
R et P © 23 YR -
|Ftgs> =l | ¥ |||
£ BBt Ei BE® E=TE ® TR 1408 1/0 FF HEE  [ES EEEE .
. [ meumel ation 1 FlantTARMTTAFCTTT CFC_FC111 5 Analog Out... ValLUE Output value 1640000 —
@ cobo_gs_Lib 2 PlartTN\RMT14FC1T1Y CFC_FC111 INPUT_U | Analog Input |YALLIE Irpuat value 164#0000

3 FlantTsAMT15LITTTY CFC_LIT11 INPUT_U Analog Input |VaLUE Input value TE#0000
4 Plant1"BMT1WMET11Y CFC_MK111 “Valve: Single D...|FB_CLSD Digital Input | WALLE Input value 1]
3 Flant15\RMT1SHE111Y CFC_MK111 Walve: Single D...|FE_OPEM Digital Input  |WALUE Input value a
B Plant1\RRMTTWMETT1Y CFC_ME111 Walve: Single D...|OUTPUT Digital Output | WALUE Output value o
7 Plant1"AMT14ME1124 CFC_MK112 “alve: Single D...| FB_CLSD Digital Input | WALUE Input value a
g Plant1\BM TTWMETT 24 CFC_MK112 Walve: Single D...|FB_OPEM Digital Input | WALLE Input walue 1]
9 Plant1"B T14WMET12Y CFC_MEK112 “alve: Single D...|OUTPUT Drigital Output | WVALLIE Output value 1]
10 |Plant\BRTTSWNETT3Y CFC_MK113 Walve: Single D...|FB_CLSD Digital Input  |WALUE Input value a
11 Plant1 "R T14WMET1 34 CFC_ME113 “Valve: Single D...|FE_OPEM Digital Input | WALLE Input value 1]
12 |Plant\BMT18WHET T34 CFC_MK113 Walve: Single D...|OUTPUT Digital Output | WALUE Output valus a
13 [PlantThBRMT1AMETT4% CFC_MK114 “alve: Single D...| FB_CLSD Digital Input | WALLE Input walue 1]
14 [Plant1"\BRMT14METT4% CFC_MK114 “Valve: Single D...|FBE_OPEM Digital Input | WALLE Input value 1]
15 |Plant\BRTTSWNET 144 CFC_MK114 Walve: Single D...|OUTPUT Digital Output WVALUE Output value a
16 [PlantT"\BMT1WMP111Y CFC_MP111 Motor: Single 5... | FE_RUN Digital Input | WALLE Input value 1] f
17 |Plant\BMT1WWP111Y CFC_NF111 Matar: Single S... |QUTPUT Digital Output | WALUE Output valus a ﬁl
L4 | o

5. KU FEX AL .

PCS7- NI/ - 5 1 #45
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Gl# CFC K#

5.7 ZGHINE...

5.7 MAEPRES...

5.7.1 i B W4 EPR&

BSR4 SES
£ CFC AW 258 T BL MES5
o fE CFC At i THL, X LEH e 7 240, P AT T HE,
o CE I REN S AT R 1) I REAR 2SR T M S T S 40
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G# CFC 7

5.7 I NE...

PCS 7 - A1 1451 - 45 1 #5>
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filg SFC E*® 6

6.1 SFC EFE Wi

JR# - 252 SFC?
FFE e (SFC) &M HATE L P4 U5 R 4
WA, PRI ANIRSAE R MRS
RN F3H R 48, vl I B S E AL AR ZS 11 7 6% W CFC
KR EE D Re U TR I A Bt AL B . SFC B3 AE SFC s as eIz .

1] PCS 7 [1) 35 “color_gs” il H Itf, PCS 7 2 A3l SFC

K2, BRI 25 3R . LI 246 SFC 4% K 44 “color_gs Tl H ¥ SFC
K%

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.2 /1] SFC #4i#4 #

6.2 {f ] SFC 4niEss

6.2.1 SFC ZRiERHN

SFC 4ut5 2%

F17F SFC B, SFC Zwfastha4T19F. SFC
i A 1T T IR BT A ) A0 B AR 28 O e — R R R PRI R AL
L CFC i asAiftl, SFC
G AL R AL o S, R SR 5 (S b ) 4 1l R 4
Py T 2R 48 A S RN A TR
o HH AL

FERPERATIN A Fe 4 SFC BRI/ MR R R

°§J/l::

BE25 AR =AM B B AT IR AR A

- Hlhte

- AT

— B
—HHOBWEOE, AT IRtk BRI T RSB A A ST iR
AL, AT OB 5 B
SERBT A RS, %R A N AR RS, R Eb A N IR

2 SFC E&H KRR

SFC 48+ K% SFC EE

114

1t SFC gui s ¥ I8 1Y SFC ERR, S E L/ RN TR — N5
o “JEAZ’(START)
o HERELAA

o “4i3"(END)

PCS 7 - NI'145%8 - 55 1 #4>
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G# SFC F#

6.2 /1] SFC #4i#4 #

6.2.2 SFC 4wig a8 H I EE TR

SFC 4nfa s M EEINRE
N ER o> 2 A 20 A color_gs™ Uil H 1) SFC BRI 75 2211 SFC gwik o £ 21 fe.

i1 SFC gl as TR MU TR S XKLL AAT 15 X

gl X

Y JETLILEEELY , T UL SFC

3¢ Enablo sl I 5% IS RIRERS . LR A
L

JA AL, bR e g — /AR 2k o o 5 B 4L 5 T
HEI R . . %4%4‘?%%@]@lgli%qjﬂﬁa)\;ﬁﬁ%%%ﬁﬁﬁ’ﬁiﬁﬁi e
AL + B 5 (Insert step | Sty 648 4 1411157 (Step with Transition)

>

)lj;
ﬁ

+ transition) %41l MBS, [FIR, S — RGN RN &40 (Step
with Transition) ({7 &' .
PRE BERCEIN, ) DU NIE PR 3o IR R AR O MRS
| P Sl s RS StV S T

“$f ALEFES> 32" (Insert alternative
branch) %4l

7E“color_gs" Uil H A4 FH B e 44

B n= S

K SFC 43 MIFAIME B, WESHHALHY ARG LK (ST 1f) SIMATIC
SFC; EL:INREK)Y (SIMATIC SFC for S7; Sequential Function Chart) T}

6.2.3 MR & R

faifr

G R0 IR RS 251 10 24 FRORIMEL T 2248 1 s 1" (Properties)

RAGHE o X TR AR 55T, A RE RS T IT IS T AE o

B AERORH AR Al UE R S B — N AT A0, T LU s 2L
I SCIR R AR

TR AL
AL S L

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.2 /1] SFC #4i#4 #

=

X

4]

“F i 3k”(Arrow down) 54l

8 PSS L DI 2 ) SR RS 26 A F 1L

1]

“ |- i3k (Arrow up) il

GOSN B M 22 2 S 7

2|

HT‘I‘

“fi k" (Right arrow) 12411

#73k"(Left arrow) #2411

P AL LU e B AR AR OB 251120

SRS AEAT DY AN R FIE TR o T ] 2 A0 X LE IR T .

11 & 1k (Properties) X 15 HEH 113237 -

o “HH"(General) — {EULIHTH AW E, W SCPFIAFK,

o “WIAHA (Initialization) — 7E L e SIKIHRAEANAEWOE A5 I AL 2 — 1R

o “NLPE"(Processing) — fEME LHHRAESGIA LI, B RN T —HB &I,
o “ZI"(Termination) — 7E I PR EANAE 2D A LI Ab BE— 1K

41 @ M (Properties) 1 HE H A3 35 1< -
o “HH"(General) — 7EULRHATH OB E, W1 H SR A AR

e “4fF”(Condition) —
SRR P, FR T TS IR s R b N Ak

6.2.4 SFC EIRAX LR

ik

FAE SFC KIZR, AT R 81 120 1%

AE

%)) SFC B2 (Ji 117)

HEir4 SFC K% (7115 118)

17T SFC K% (i 118)

116
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G# SFC F#
6.2 /1] SFC #4i#4 #

7 H&

T8 WP R G0 T 2454 (TR 119)
HEig s (U 122)

5 (DU 125)

WAL (i 127)

R AT (7S 133)

AT (TR 137)

© || N || O~

6.2.5 A #%3h SFC B#E

f&j
% “color_gs”3il H I} T} PCS 7“New Project CHra:IiiH ) "a) 3 6J% 1) SFC
K% “SFC(1)" {7t e “ADDIT 24 Se ke rb o i TR RARMEAH S AT it e 1) 24, Fn LA
T PCS 7 5 HEh I () SFC KR sh B (2 etk .
Bk
o M7 SIMATIC & BEAS T FF S 1 H o
o LR K.
WiRrS

1. IBHEAL & ik ¢
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1/ FC111/ ADDIT" ({43 .

2. fEVEANME AT LR SFC(1) X 2.
3. UL gmiE"(Edit) >“BIY1"(Cut) fir 4.

4. MRTEALEE ik
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1” 33,

5. EF“YR4E"(Edit) >“*£BI;§”(Paste) 2o
TR 3 N BTk i FE AR 22K

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.2 /1] SFC %434
6.2.6 wfTE A% SFC B&R
fRifr

£33

Tk

6.2.7

R

Ttk

118

A RFRIH by 44— SO, TR AR,

o 7E SIMATIC & HIZ T FF Ll H .
o UL LT MK,

1. MR TEAL I
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1” 3043 .

2. FEVEANG B O Pk £SFC(1)" %) % .
3. EF“gmia”(Edit) >“%} 58 #:”(Object Properties) 4.

4TI @ I CFC K #2”(Properties CFC Chart) X[iE#HE, H:A4“H #i”(General)

IR AL ERES

4. 7% FR"(Name) HEF, K BRIAZFRSFC(1) B 4 h“SFC_RMT1”,

5. Hiliifi 2" (OK) TR A

7 FF“SFC_RMT1”SFC Bl %

o LU7E SIMATIC & Bas 4T T SL I H o
o CHUATL) HLK.

1. M TEAR ] e 4%
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1” 3043,

PCS 7 - NI'145%8 - 55 1 #4>
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G# SFC F#

6.2 /1] SFC #4i#4 #

2. {EVEYIME BT, EBECFC_RMT1"M %, R)GEF 4" (Edit) >“FT FF X1 5" (Open
Object) #ir % .

F4TH SFC g4 2%, “Start (J33h) "FM“End (4590 " UL LB LAE 1 C&A(E7E.

6.2.8 W PP 42 ) R G ) T E 451

LEF5)
LA 50 XS “color_gs” i H R #2348 2 AN 20 RS 26 AF I T 2P 1A TR

W ThRk
START BRIME:

R B R 2 B O T B
K EATRHE R as U1 A

B ITIRE N A3
PR b
DOSE_REA1 i)
DOSE_REA2 TR RS 1 BRI 2 T s k2
INIT_LINE1 et T
T A R AN <5 174 1l
INIT_LINE2 $TITARRE 3 31
JaBhE
B 2 B RS DI 2SN e
INIT_1_OK 2y
INIT_2_OK AR LA ST
- PRI A O A AN e 7
INIT_DOSE il e

T B A LIRS 1) v e

BB BRI BEE A A S

T A R ) e

REhERSE

INIT_OK i)

SE L RITIR?

SEmgRLE (SERRBEEE) /M F 500 AFH?
SLOW_DOWN il e
ERETFENE B EITAA, BRRE S8R
END_DOSE il

SETAA R Y

CLOSE_LINE il

KA K

1514

2 B4R HAS D)4 2 F B

e e R BB 0

151 B R

PCS 7 - NI'J451 - 25 1 #4)
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G4 SFC F#

6.2 1)) SFC i1 #%

B Ihek

CLOSE_OK i)
S L 1R 52

END A
o B2 R 2 T3 R
KA 1
AT ER 1N

L) ERAE DO Bt R E) . IR L

6.2.9 WnfT7E SFC BT+ BRI R 4%

(kN
N RS 4441, SFC
GRS S TCIESE R TS, ARG, EHETER L) & A RS X s 540,
K
e U\7F SFC ZmiH s 4T JF“SFC_RMT1”’SFC K% .
e “START (Jd3h) "FI“END (&E3) "B LI N “Transition 1 (#8544 1) "C&A74E.
Hi:
1. GRBEE T T D R RS S 0 T 2424, 1 AAL A" (View) >“ T B #2"(Tool
bar) % .
XEATIF T HAE

2. i A + R 41 (Insert Step + Transition) %41 .

=|

ARSI — AN ARk 7 15 Pl R 2 45 AR
3. FChrE THA &M A N T ERIMBL &L, R did S LA
FEFP A 3 MRS 12"\ SFC [ER

4. iR NEPR 4> 32" (Insert alternative branch) #4411 .

Rz

PCS7- NI/ - 5 1 #45
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G# SFC F#

6.2 /1] SFC #4i#4 #

5. K Jehr B T8 30" (START)
IR T HBIH I — ARG, ARG i SO AR
FEJP 2B e P 0y S HBAG NI 8" (START) 2510 5
R AT R4 LI AT I T AN, R U247

6. AL + HHA&M(Insert Step + Transition) %4 .
=]
7. BhRE T RN EIHEA L + HR AT
— {EMHESAE 3 NI - HANT B 5 FEA AT 5
— EHRAEA AT AT D 6 MER AT 6
— FEHRAEA 2 T AT D 7 MBI T

PCS 7 - NI'J451 - 25 1 #4)
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G4 SFC F#

6.2 /1] SFC #4i#4 #

a3
& SFC EIRIAE N % T B

START

7

S
==piy==

Bai

EMD

6.2.10 WMEMKZD

E:EN
o LL{E SFC %iff#s 14T JT*SFC_RMT1"SFC &3¢,
o CURAITHL A A1

PCS 7 - A1 1451 - 45 1 #5>
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G# SFC F#

6.2 /1] SFC #4i#4 #

Tk
1. Bl (Select) 141
L3
2. L5,
3. IEFESE A A g iR (Edit) >“X) 58 " (Object Properties).

B L (Properties) X iH#HE, L HL"(General) 23+ Ab Tk HARZS .
CLE“Z PR (Name) HEFIEFE T ERIASCH S,

4. ¥ 4" (Name) HEHP 5" S SR “INIT_LINET”,

EE#E - INIT_LINEL - culur_gs_SP"-.,PIanI:l"-.,RMT*"-.,"-.,SFE_RMT1

(T 2 | st |
EFRN) - INIT_LINET SB: B m®iAE
AT
(ﬁd\fﬁu]: [~ BRER: |-
FERR M) ; =]
[~
05 ERI0): [-
[~
T =
H=VINE .
[~
[(=An |[=ew | e t| 4] o0 | nme. | s3m | wm |

5. H N " (Apply).
K ORAT B 2K o

6. M k" (Down arrow).
KR4,

7. B4 B (Name) HEF 114" B B “INIT_DOSE”, 4R ki 1" (Apply)

8. M E ki AR e P, ARSI R S AR
RN 2 RRES, 5N H " (Apply)

PCS 7 - NI'J451 - 25 1 #4)
AT 4675, 09/2007, ASE01222374-01 123



G4 SFC F#

6.2 /1] SFC #4i#4 #

9. #ii“KH"(Close).
BARARE, FHORMA N5 JE P (Object Properties) 1A

BRNB R B2

5 INIT_LINE1 — © 581
4 INIT_DOSE — &\5¢ %
3 SLOW_DOWN

7 CLOSE_LINE

6 INIT_LINE2

by
#H

SFC EIZ 2 Bon % L UR A4 FK

TR

i

INIT_LINE2
INIT_POSE

]

SLOW DOWN

i

CLOSE LINE

PCS 7 - A1 1451 - 45 1 #5>
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G# SFC F#

6.2.11

fai g

Bk

Ttk

6.2 /1] SFC #4i#4 #

W E i 4 e s A

LRy AR PR & FRERA ARl 50 o0 BRI T & A B
it 55 O A RR I ik T o

C.7E SFC %% 451 T JF"SFC_RMT1"SFC K3

CEPRHERB AR, RIGIEREE R A e (Edit) >“XT 58 4" (Object Properties).

FHHT I 5 & 1" (Object Properties) X i&HE, Jf H“# " (General) i1~ 4k

ML) & AR 2 75" (Name) HE 1 R ER A Z4 7R
T LA T .

BRI N TR, HREL TN F " (Apply) 24 56 B 24
1 LA — NSRS B R — AN 44
G 1" (Close)

BHRAE W E I X % JE 1 (Object Properties) X G HE

RN R BB

DOSE_REA1

INIT_1_OK

INIT_OK

END_DOSE

CLOSE_OK

DOSE_REA2

DN~ |O|W

INIT_2_OK

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.2 /1] SFC #4i#4 #

a3
SFC K3 2 Bos W SUR RS 2 2K o
111 SFC EIRIAE N AZ W1 N Frs:

FHiE T2

DOSE_REAL DOSE_REAZ

INIT_LINEL INIT_LINEZ

INIT_1_OK INIT_2_OK

INIT_DOSE

INIT_OK

SLOW DOWN

=

CLOSE LINE

EMD_DOSE

126
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G# SFC F#

6.3

6.3.1

fai g

2k

T

6.3 EZH

WESH

wfh SFC BRI T IEA S H

M SFC FRHAE 73 BL4rCFC BRI A A -
E R R R P A iR v E 2 — N START (A zh) "Jiiksg .

EYSEMEE S (HIbEN s 2N W/ GRTAZE
REMWAE IR S R TP i T 24

e \{E SFC 4wt a5+ $T H“SFC_RMT1"SFC K% .
o BT HIERER A ZFR.

1. ¥id“START",
K541 IF @ 1 (Properties) XHTHE, 3 H“% Hi"(General) 5 jik .
2. Ul E“w)iG1E" (Initialization) 2T .
IR 23 WoR — MR AAT IR FAIER, Jehs b T26 —AT A2l 41 v
3. HLli"¥ %" (Browse).
FE AT TFH 0 (Browse) XHFHE, JLH T ML (Plant view) #15F 40 A5 8RR A .
SRR, T RO BRI, AR B TR BT 10,

4. MWHHEME hiE$“Plant1/ RMT1/ FC111/ CFC_FC111/ CTRL_PID k.
A DX A8 57 BT A N R BRI

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.3 EZH
% -color_gs_SP'\Plant1 RMT1
Irae | mune | zaE | %2 |
. RMT14FCT118CFC_FCT11ACTRL_FID, 70 <fitereds
=Bl Plarti =] Al SR o Jorc. |src. g | |
=B RMT1 T T O P
=) Foi11 AUT_ON 0P BOOL IN_D... Opera...
=[] ADDIT AUTOP_EM EOOL I Enal..
o [ CFC P aLI%_PRO5 ANY IN_O... il
~ ETRLFID AUX_PROG ANY IN_O... Auh...
- aLIX_PRO7 ANY IN_O... il
-4t DOSE All_PROE ANY IM_0... Al
- INPUT_U Allx_PR09 ANY IM_O... Azl
] INT_P ALX_PR10 ANY IN_O... il
- MUL_R Ba_EM BOOL IM Batch...
o} OUTPUTLEMN Ba_ID DwORD IM Batch...
w0 [ LT _ | BaNa STRING[32] | 1M Eatch...
-l NKT11 CSF BOOL IN Contr...
DEADE_W REAL I Dead..
@ (1l NKT12 DFDE_SEL EOOL I Deriv...
- NK113 DISY REAL IN Distur...
- MET14 EM EOOL I
(B MF111 ;I ER_HYS REAL IM Hyste. .. LI
x| mAE | tEse. | EEE =i | wm |

5. Xl“AUT_L"HiN
“WI Y (Browse) XIHHES T 275 8¢, HIEFRIEL 1/0
S ALE R AR oA N B — N i AT 1
Jebres HEENAEAT 1 A

L]
W ARTC IR /O KA FR, VS I 58 L

6. fEItA AME 4 AEH"0

7. HaheR P (Apply)o
0”2 B B4 “FALSE”.  “Start (JH3)) "Ik 0 EE— N 2 LS 58 il o
BRI PRS0 T AE W1 R s

PCS7- NI/ - 5 1 #45
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G# SFC F#

6.3 EZH

EE#E - F¥G -- color_gs_PrivPlant1 RMT1\SFC_RMT1

1 | |7|T1 SFETTISWCFC_FCTTIACETRL_PLD.AUT_L = IFALSE

_2 |7l =]

_a |

4|

_5 |7

8|7

2|

_8 |¥]

_a |7

o |~

|

[ a0 |[(mAe |« t]$] =] oo | e

e |

8. Pl AU 2L . ] A R AT IR T
BEERAE RS ChR AL T2 AT R 22 B

9. mAELE3 B9, &N START LI R AL, FIAE T RPERIPTHRE R .

10. iR (Apply).

M. R EE LRI E S, JRRYE PR AL

iR
R rp bk E o LR R
[E RS\ B R A4 FR\BR 1/O]

KA “Plant\RMT A AEXS T B X G5 Y AH ], DRIHORE J0me 25 0 XAl R 1y iH o) 1 .
] “color_gs” T H 3 A B In T 5l Hoch, MRIEBITE R T EHN KR .

G | gk 1 Huhk 2 X

=

1| BoERk: FALSE PRl a8 F ok
FC111\CFC_FC111\ CTRL_PID.AUT_L

PCS 7 - NI'J451 - 25 1 #4)
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G4 SFC F#

6.3 K EZH

6.3.2

“INIT_LINE1”2 (1551
REFTRFINIT_LINE1 135

130

Gi | Hudlk 1 gk 2 A%

_%

2 |FC111\CFC_FC111\CTRL_PID.SP_EXT |FC111\ADDIT\CFC_SET | Wit =%l 5 &l

P\PARA_DOS_RM1_QT
Y.V

3 |FC111\CFC_FC111\CTRL_PID.LMN_SE |FALSE TCERER
L

4 |FC111\CFC_FC111\DOSE.L_START FALSE U I A R

5 |FC111\CFC_FC111\INT_P.TRACK TRUE OGR4 4%

6 |LIM1N\CFC_LIM1NINT_P.TRACK TRUE HIBEA 5 5%

7 | NK111\CFC_NK111\WVALVE.AUT ON_O |Auto & 4bF H B
P

8 | NK112\CFC_NK112\VALVE.AUT ON_O |Auto & 4bF H B
P

9 | NK113\CFC_NK113\VALVE.AUT ON_O |Auto & 4bF H B
P

10 | NK114\CFC_NK114\VALVE.AUT _ON_O | Auto & 4bF H B
P

11 | NP111\CFC_NP111\MOTOR.AUT_ON_ | Auto N T B BBl
OoP

12 | LIM11\CFC_LI111\INT_P.HOLD FALSE PR¥e HE

TiHA

AR, IER AR O AL B " (Properties) X il HE IR AR AU L85 T I @ ik
WERTCE R SCH] T B L (Properties) X AE, 1 Wik >4 iy g 4 10 20 BB T T4 1 HE

Mk 1

Huk 2

X

- | 2

NK111\CFC_NK111\WVALVE.AUTO_OC

TRUE

FTIT 1

PCS 7 - AI'l457 - &5 1 #4)
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G# SFC F#

6.3 W EZH
G0 | Hadi 1 il 2 X
_%
2 | NK112\CFC_NK112\ VALVE.AUTO_OC TRUE T
3 | NK113\CFC_NK113\ VALVE.AUTO_OC TRUE T
4 | NP111\CFC_NP111\MOTOR.AUTO_ON TRUE JAB AL
“INIT_LINE2" [t 551
TR AINIT_LINE2" S 125
R it 2 X
%
1 |NK111\CFC_NK111\VALVE.AUTO_OC TRUE I IR
2 | NK112\CFC_NK112\ VALVE.AUTO_OC TRUE F I i
3 | NK114\CFC_NK114\VALVE.AUTO_OC TRUE T
4 | NP111\CFC_NP111\MOTOR.AUTO_ON TRUE JAB AL
“INIT_DOSE’# H1&41
TR INIT_DOSE” #1155k -
W |t 1 il 2 A X
_I%L
1 | FC111\CFC_FC111\CTRL_PID.SP_EX |FC111\ADDIT\CFC_SET | i E A= HIH3E s i EH
T P\PARA_DOS_RM1_QT
Y.V
2 |FC111\CFC_FC111\CTRL_PID.AUT_L |TRUE A A Bt
3 |FC111\CFC_FC111\DOSE.SP_EXT FC111\ADDIT\CFC_SET | & E4RHE 1% 3) R el
P\
PARA_DOS_RM1_VOL.V
4 |FC111\CFC_FC111\DOSE.L_START |TRUE JA B =45 R
5 |FC111\CFC_FC111\INT_P.TRACK FALSE BEEE B 1 5 IR ) 2%
6 |FC111\CFC_FC111\INPUT U.SIM V |50.0 g e A
50 ATy BRI B
7 |FC111\CFC_FC111\INPUT_U.SUBS_V |50.0 Bl SIM_V (AL
8 |LIM1N1\CFC_LIM1NINT_P.TRACK FALSE AR

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.3 KEZH

Mk 1

gk 2

X

o |dn £

LM1NCFC_LIM1NINPUT_U.SIM_V

FC11N\ADDIT\CFC_SET
P\
PARA_DOS_RM1_VOL.V

SE B R (LA

10 | LM1N\CFC_LIM1NINPUT_U.SUBS_V

FC11N\ADDIT\CFC_SET
P\
PARA_DOS_RM1_VOL.V

B SIM_V (18R

BEB{TH A -“INIT_DOSE">
1. B35 M (General) £ F

2. {E“Ia4T I [H)"(Run times) 41115 /N (Minimum) HE 46 A {E“8s” .

3. N H”(Apply).
PCS 7 & HalW(H 3 0 “T#H8S” .

“SLOW_DOWN"# 154
TR “SLOW_DOWN" A (1) 22 44 -

| Hudk 1 ik 2 a3
_%
1 |FC111\CFC_FC111\CTRL_PID.SP_EXT 10.0 TR ek =R N
2 |FC111\CFC_FC111\INPUT_U.SIM_V 10.0 AL .
10 A THAY B 7
3 |FC111\CFC_FC111\INPUT_U.SUBS_V 10.0 HME SIM_V (R E
“CLOSE_LINE" S 124
FHRFTR N CLOSE_LINE S 11 541
Gi | Hudlk 1 ik 2 X
_%
1 | NK111\CFC_NK111\VALVE.AUTO_OC FALSE K A1 1]
2 | NK112\CFC_NK112\ VALVE.AUTO_OC FALSE K A1 1]
3 | NK113\CFC_NK113\ VALVE.AUTO_OC FALSE Sl

132
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G# SFC F#

6.3 KEZH
G | ik 1 Mgk 2 X
=
4 | NK114\CFC_NK114\VALVE.AUTO_OC FALSE PRl
5 |NP111\CFC_NP111\MOTOR.AUTO_ON |FALSE 5L
6 |FC111\CFC_FC111\CTRL_PID.LMN_SEL |TRUE B R I ONE O
KA )

7 |FC111\CFC_FC111\CTRL_PID.SP_EXT |0.0 VAR G B0 B e (H
8 |FC111\CFC_FC111\CTRL_PID.AUT_L FALSE il g F Al
9 |FC111\CFC_FC111\DOSE.L_START FALSE ke 25k
10 | FC111\CFC_FC111\INPUT_U.SIM_V 0.0 PR B

0 ATH43%h
11 | FC111\CFC_FC111\INPUT_U.SUBS_V 0.0 Bl SIM_V (1= 48 (H
12 | LIM11\CFC_LI111\INT_P.HOLD TRUE PIER 4

"GN S
TRIURNEND (4id0) "B

G| a1 Hhg 2 HX

_I%L

1 |FC111\CFC_FC111\CTRL_PID.AUT_L FALSE L=EDATTIN

2 |FC111\CFC_FC111\CTRL_PID.LMN_SEL |FALSE WAL I
3 | NK111\CFC_NK111\VALVE.AUTO_OC FALSE KA IR

4 | NK112\CFC_NK112\ VALVE.AUTO_OC FALSE KA

5 | NK113\CFC_NK113\ VALVE.AUTO_OC FALSE A I

6 | NK114\CFC_NK114\VALVE.AUTO_OC FALSE KA IR

7 |NP111\CFC_NP111\MOTOR.AUTO_ON |FALSE 15 HLAL

6.3.3 Wk SFC ERIEBZM I ESE

fai 4

R A S P2 R SRR BN — DN DAL B R — AP I PR IR 4 AF . s B, O
FERB 2 AT 3 WS ) 325 D020 93 WS ) 3 i ) o
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G4 SFC F#

6.3 KEZH

R

Ttk

134

B SFC gnf s H 4T HF“SFC_RMT1"SFC K% .
CE S T 20 RS 2 AF I BRI K

. HE“DOSE_REA1 #4144

B B " (Properties) X G HE, iy Hi"(General) I+ A T 3G 8R4 o

. VI 3“4 £ (Condition) #£ T+

ZIET R R P AN AP, BEAAT. bR @ T — AT i ezt . X inHe
FRIATT Ji 5 D 20 3 BE 25 B s BRI HEATT SR AT 7] o

. N"DOSE_REATHM M S H. sk HIL R, TP HAT TE, LAE

P

— XETHUE 1, R Browse) L, TTFIN (Browse)
R, SRR EFEAIE 1O

— A 2

BB

T

faragaray
ST

 IEFERERS S A I A L

Bi. B3

HNHBYERS, IER AR O 4L B TR (Properties)
X TEAE IR A B T BT e 4 A

5L SR, Rrp ke e o LN kg
[ SO I\ B R A4 R\ 1/O]

kT 2K

PCS 7 - NI'145%8 - 55 1 #4>
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G# SFC F#

6.3.4

Lz 2 aR e

“DOSE_REA1"## &S %
TR A “DOSE_REA1 4 A1 1S5k

6.3 EZH

| bk 1 BAER a2 | WX
_%
1 | FC111\ADDIT\CFC_SETP\ = FALSE TERNZE 1 e s RL?
PARA_DOS RM1_SEL.Q0
2 | FC111\ADDIT\CFC_SETP\ > 0.0 ERAREEAT 07
PARA DOS RM1_VOL.V
“INIT_1_OK"## &K%
TR MINIT_1_OK' #5115 5
| k1 BER a2 | X
_%
1 | NP111\CFC_NP111\MOTOR.QRUN = TRUE HHLIT A ?
2 |FC1M11\CFC_FC111\ = TRUE %ﬁfﬁﬂ%&&ﬁﬂq%%ﬁ&%ﬁ
CTRL_PID.QSPEXTON :
“INIT_OK"## &1+ K125
TR NNIT _OKH R 4511 S5
| Huht 1 AR (wat2 | BX
5
1 | FC111\CFC_FC111\DOSE.QSTRTDOS |= TRUE ERARITR?
2 |FC111\CFC_FC111\DOSE.ER < 200.0 SERARLEL:
Ve - SEPR{E <
200 ~FF?
3 |FC111\CFC_FC111\DOSE.ER > 0.0 SERA R
W — PR fE 0 > AT

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.3 KEZH

“END_DOSE % #4143 31
R H“END_DOSE" #1411 (11 5 54

Gi | gt 1 BIER wmp2 | BX

_I%L

1 | FC111\CFC_FC111\DOSE.QEND DOS |= TRUE SE R ?
“CLOSE_OK #4113 3

TRPT7/RM“CLOSE_OK #1414 .

Gi | it 1 BER k2 | WX

_%

1 | NP111\CFC_NP111\MOTOR.QRUN = FALSE HLLC A ?
“INIT_2_OK"# % £1F K125

TR NNIT 2. OK 3R 41155

| it 1 BIER k2 | X

5

1 |NP111\CFC_NP111\MOTOR.QRUN = TRUE HHLIT A ?

2 | FC111\CFC_FC111\ = TRUE 1%%%%%&%%%%&&%@

CTRL_PID.QSPEXTON :

PCS 7 - AI'l457 - &5 1 #4)
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G# SFC F#

“DOSE_REA2"# #4115

NPT K “DOSE_REA2" 4 55 S 44

6.3 EZH

Huhk 1

BAERF

Huk 2

FC111\ADDIT\CFC_SETP\
PARA_DOS_RM1_SEL.Q0

TRUE

FC111\ADDIT\CFC_SETP\
PARA_DOS_RM1_VOL.V

0.0

FH SFC K%,

6.3.5 T IE AT

fai g

PCS 7 ffit T3t HHmin i

KIRMASE, k.

2k

o CW7E SIMATIC & HE 88 T IF LT H .

o LR T) K.

T

1. AEREIE T, ERCijfr CFC BRMSCIFk.
2. MGG BB s CFC B, REEFEH

Object).

KK (E CFC gmifas 4 IF.

—

IBAT M T RE o

s CFC KIZ 1 SFC

i 2“4 (Edit) >“F] FF X5 (Open

3. EF“IETN"(Options) >“tRALIZFT R /F..."(Optimize run sequence...).
BEFT T BT HE“BR(F32 4774 5 24..."(The run sequence of the blocks will be
changed...).

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.3 KEZH

4. FLliifiE”(OK).
BB Y -

5. XM CFC K.

138
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G# SFC F#

6.4 G/ IKES...

6.4 MEPRA...

6.4.1 i B W4 EPR&

BSR4 SES
7t SFC 4SRN T i T WLy 2 ?
WO T Ear A AT TS bR HED) e -
QI T SRR U2 R ¢
IS E Wi ke Z S NGRS E
YL T84T My -

PCS 7 - NI'145# - 55 1 64>
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G4 SFC F#

6.4 2Ggika...
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ik PP ER 7

7.1 Gae. T EFNNRAAA

/3%

KEFEEN A LT N E

o Wififgvridid CFC 1 SFC GRS .

o WK RESF T #EE] CPU.

o AN TAEM BRI M s TRE .

AL AT L B R DR T IR o N BRI e T fe

ity AT B R AT R I AN 2D R

o R GIEN N EIMEIR — AT S, WAL B BN 4 (Compile
and Download Objects) Jjfig

o HPRIMAFEY — wAE SFC Zifas P AT, thnl7E CFC gadas th AT It

PCS 7 - NI'145# - 55 1 64>
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WiFs AW A

7.2 LB

7.2

7.21

faifr

R

i

142

W 4R R #; CFC #1 SFC E#%

£ "color_gs” i F1 014 T CFC A1l SFC 4. ¥[8 R itE CPU
TR, LT AS BT 19 30t
SR BT — X R 2RI

CP L&ttt “RUNLED 4b FiE sk 4
CPU 4t F“STOP"#:X.

CUE SIMATIC & L2541 FF 5L 135 H
W SRR

Ny Z VNS S

“color_gs_MP/ color_gs_Prj/ SIMATIC 400(1)” 3043

. PSR LA PLC >“IR A7 451 5..."(Save and Compile Objects...).

BT I LRA7 I 4 PR %) %" (Save and Compile Objects) XA HE.

R TTEALIE .

MLPERE twk 7 color_gs™ il H ({1454, 145115 SIMATIC A5 Bl as i 4L UL SE AR BL
CASER RTINS E DRI S L (RIS EPSE

PCS 7 - NI'145%8 - 55 1 #4>
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WiF  PEAI AL

7.2 LR
ERINTENE M= E3
HEFERR(B) - k
HE k& TiEE wa T
S SIMATIC 400(1) | Ll
oy #E FEL ] ]
=- FLC AR Ol O
®
7 FEL O] O]
% EE R L L
TR B3h EELT MR
@Ee. | oFn | wew | Tesmo =g smp. || smewn | meswesL
[~ {THEHEREE)
[~ RRiZM) Iv il RS IR TR D)
e | =eo | #y |

4. 4 (Charts) X %1% 1" (Compile) 1 1 4"(Download) &I AE.

5. WHEIL"(Charts) 4 H, FFai“gnide/ MU E"(Settings for
Compilation/Download) X 571 (¥1“%w4k..."(Edit...) .
BT G R 7 T 353 H b5 248" (Compile Program / Download to Target System)
SHEAE,  Horheoks B 2 4 3% 4 R (Compile Charts as Program) 2E3 K # ik .
¥ A Bk FE 1N FE P (Entire program)
I, PRI IZ 2 B — IR TR g DA B A

i

I RAEM I ) A A e R AEAE R 5%, 620 SE 11 CFC M SFC B LIV R %
IR BEFOIT UG AN AU, PRI S X (Changes only) LET.

XAFACATAE G RN BN 48 A 24 2 1IN

PCS 7 - NI'J451 - 25 1 #4)
AI1451, 09/2007, ASE01222374-01
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WiFs AW A

7.2 LB

6. WA R R IK 5 /7" (Generate module drivers) & IEHE.
IR 5 A BR A A S IR B T

Vi
TR L 4 “gm i (Edit) >“THBR 251217 4"(Delete Empty Runtime Groups)
TﬂﬂJ bRt izqT4 .

REER |
gismEnes | R
CPL : CPU 417-4
EFFEH SIMATIC 40001 NCPU 41 7-4457 325 12)

- ﬂﬂﬂﬁh [_]

v 4 pEEERIEEhER(G) EhIEEhEREE(E)..
[~ 45k SCLIE(M)

Cancel Help

7. Fpinfae”(OK) AN 3 .
WXTUEHERE O T, JFFT I RAE DA, W BUE T8 (... ) , CPU
LI EE I R (Remember that if you download later (...), the blocks will be deleted
on the CPU),

8. FLili*ffiE"(OK).

9. M A“4n ik N4 %" (Compile and Download Objects)
X TEAE R U7 DA DU S ) B

PCS 7 - NI'145%8 - 55 1 #4>
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WiF  PEAI AL
7.2 2B 5E

— %P (Compile only): 2%
— R 2 g BRI A R 2 (Do not load if compilation error is detected activated)

10. Hifi*)d 3l (Start) 1 T AR g AN iR A
TR ERE IS AT ) R B0 S, A R A R s R R A R, e N B
WA IR "(Downloading program changes during operation can, in
the case of malfunctions or program errors, cause serious damage to personnel and

equipment! Make sure...).

1. e (OK).
FEAT TR BT AE W R AL 2 R, R, ... & 4RE2? "(If you want to
download changes online, please make sure that ... Do you want to continue?).

12. 2" (Yes).
P TF LR G PERT T 2

i
BERE R oRtR R PCS 7 HTIEAERATHRA P IR, .
o “YiiFAIT FH X% (Compiling and downloading object)

o WY 1% NFL " (Compiling charts as program)

BAE TSR R AESOAS G A T T T H SO

13. 2B
‘o > MR gFCHET, HHBL T, 7(...-> Object compilation was executed
(with warnings)).
PRI WG ACRE 11O AR R0 H b, BT DUAE R T B R
14. KHISCARGn 42 o
‘K% (Charts) 47 FPRAIAE AT 3" (downloaded).

PCS 7 - NI'145# - 55 1 64>
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WiFs AW A

7.2 LB

L
ARG e H S S P o B s B R, T AR TE AL Tk £ 18127 (Charts)

W%, ARG X157 (Single Object). AR T H A&7 (Logs) XA .
AL AE LR A VRN ) RS R .

15, TE“Yu AT 206 4" (Compile and Download Objects)
XPEAEHT, i OC 17 (Close).
KOG PRI HE

16. Ji3) CPU.

7.2.2 WA 7

faifr
FI{E SFC s HRARL Y, WAI{E CFC gk as ol /o
FENRBEATT, AT AL A R TR AL DL
A A, T R AL A R 12 1R R G iR HiE A T
SFC H H A

MARSELE SFC g as h HATH, EBAEQIHE SFC BRI O Zgn a2y A B 1 i
“J&YE"(Properties) X il HEAE MR A S EAZOAEH .

WX SFC BRI A D BB 4, AT I s " (Properties) XfiiHE.  1E40
SFC

BRI QIR —FE, AT TS AN — A0 B RS 2 A DD 2 R — N D B 4T
FEMRAEACT, X IEHEIS R AL N5 &«

o (ELHIBPERARHE, Zeidahl 1 552 BoRSLhnft, Al 2 552 WonBoE(H.
o TERRAAFM BN IEAE T, Huhk 1 2R dE 2 A5 002 WoR A E S HTE

PCS7- NI/ - 5 1 #45
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WiF  PEAI AL

7.2 LB

MBS E ORI A HIFCAE, X B S NS EE, BRI
SFC KRS 4.

7E2% 3] (NI14579) (Getting Started)
Pt RE, AL SUTATE; &M (Properties)
OPUEAE R H RS T AT IR

CFC H HJul iR A =
#F CFC ik CFC 4k 32 1 2h MR . BEAE7E S H 1/O Ab S5 i R FF I PR g

7.2.3 w7 SFC gwiEaR Iz F

ikly

Gt N R, ATENREA N T E.

TRAAGE o] S A L 478 W R e 1) A A A 1 DA MR P B AT A T IE .
Eok

o W7E SIMATIC & HE 88 T IF LT H .

o [7E SFC Zufiias 47 H“SFC_RMT1"SFC K.

e CPU #F“RUN" .
FEMIRARL AT TR

1. EFESE a2 PR (Test) >“MIRER"(Test mode).
FEI7H i AR K
— 7 SFC Zias priidsrh, KR O 5 LB R4 FSFC_RMT1 -
color_gs_Prj\Plant1\RMT1 ONLINE”".
— 1& SFC Zfas ) N, " &AGEFREPRE. BT,
EATRER BN UL T % BN “MANUAL (F3) 7,
MR R ORTE TR, BRSO R RE T,

PCS 7 - NI'145# - 55 1 64>
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WiFs AW A

7.2 LB

— f£ SFC ZwfE a8 3, A M T4 SFC
K%k (B, Esh. PREE. k4 1fedl.

2. PSSR (Test) >“ B #L=,"(Step Control Mode) >“T 8% M”(T or M).
7t SFC KIZRIZATINIRIN, A O S 4% 55 10 1F B O™ iy 2 4
AT T4 R TR AE i

3. Hi R B (Start) $ LIS TR .
¥ a5 SFC K%,

MATHAT IR DA IR SR (O B, R FR A D N Sk o
— OSSR RSO R, IR /N ERL
— EFIE SRS AR B R A R ERR A 5t b
— R EMBIT TAHE, BaseiEA SFC

K2R, BT DA ke o H o5 i ik brid.
W, REHEBAEARE DL, P d C Fahdt T T —2.

4. P AWK (Test) >“ WX (Test mode).

P A .

I 42 £ 2R R A5

WREE...... NP #4 R GEs AT LA #4fe:

PRI NS NP7 ) R SR AR A A I S HOE D AT o ANt 2% 4%
AR WA A PRI BN AL, WP ) R G0R 45 1 b
TRFRE FAP R BRI, K] il CH LR e 2~ — 2.

7.2.4 A CFC 4riE 3+ A2 7

i
£ CFC iz -Hillik CFC &y Un] 5k SFC & 15 sUAH ] o
R

o LL7E SIMATIC 4 BlLas T 4T T SL I H o
o CUUE L) LK.

PCS 7 - A1 1451 - 45 1 #5>
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WiF  PEAI AL

Tith

CifE SFC %% 4T JF*SFC_RMT1"SFC KI5,
Cift CFC ZwfH s 7 JF“CFC_FC111"CFC Kl%.

C EPEE L 2 PR (Test) >“WAEE"(Test mode).

TARA AR B -

- FCTRLBEIFREFELL R

— CTRL_PID
— INPUT_U

- DOSE

. IEPEE LA AR (Test) >“ ML #LFF /5 "(Monitoring On).

e s D& P BT R T Rz

. PI#e3)“SFC_RMT1"SFC K.

. i E )" (Start) THAZ A .

EQ LY SRIL A o

. VI#3*CFC_FC111”E %

AL I P 3 AR P A D e S T
B, S RAVRHRE I AT SR /£ DOSE B PV_OUT it ik o

7.2 LB

BiA
FFHEBCE A 1, MEAENNSAET [ ) CFC A1 SFC K.

. LSRG A PR (Test) >“PiRBE " (Test mode).

K R RR

. KM SFC %i%E#s 1 CFC iiEas

PCS 7 - NI'145# - 55 1 64>
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WiFs AW A

7.3 25 rRAs...

7.3 HEPRE..

7.3.1 B B HEPRAES

BRERNATES
FIHAT M1k, SIMATIC & FI CFC it #s & SFC
it T AS PRI O S M. DR IPENT 8 T 4, Ji1E SFC il CFC
G4 o PO S T 0 H AT DL
]l DR B H A B BATH R
USRI H AE AR M IS INAAAE R R, IR BUA A DR LEAE RN T H 58 1 7
ARG o

PCS 7 - A1 1451 - 45 1 #5>
150 AI4675, 09/2007, ASE01222374-01



H S BRAE vk 8

8.1 RS B BRAE F ok

BAE BRI AR
)RR DA R N AR D1 (OS) FRARE IR AL RE . ke 4 B 03 Wl
Pt femii. Atk Rg (AS) HIFHEMllfe OFFRMEIAESD . 1 OS K AS
G FEAE I AL IR T USRS s X e o I REAEIA 2 sk i B fia s IR,
R I i 2 N7 B 7 T AR o XA R AT R nT A E ) R B R A
$ Ay “color_gs” 3l H Bt — AN R iy, el 2 i 1 )L JORE A AR RISV . BRDIRZS

v
&,

8.2 HASHRAE Rk

TR H = B B
il PCS 7% 55 H"(New Project) [1] T 10 H i, PCS7
¥ A — M EE . OFF HW Config LA CERAE bl sl . (HIEE A AL OS
NS, R EEE N ES MR
AS, &8 HEh A ARG T RE ik 2 (8] (R T T 28 3445
Xt T color_gs™ il H Jo ittt PR TR ot A ERAT: B (0 TR — S vl b, JF EHLERAE
bty ES AR — 21 AS % .

L B A A R i
PCS 7 [l FI&AE 1) E4h A Sh G m i, X8 i n] B 5 75 OS 1.
BRI H 23 HAT 2 A Femi LUK 3 1) AN R 4Lt
Xf T color_gs" Wi H , RBZAS A M. JEW, EHSRETRT 2 8E
OS M HEA T BE -
X s AR B bsbsvE:

PCS 7 - NI'145# - 55 1 64>
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S HRAT 75

8.3 71 SIMATIC E##1 T.1F

8.3 7£ SIMATIC B 28+ T 1

8.3.1 SIMATIC & HE2S & TAE

3%
FFEAAE OS AR, TFEAE SIMATIC 4 BEES AT LR JULANTI A A 1.
BB N
1 s 4 ] T 42 Bk It FH G it B AR T Th g (D05 153)
2 THBRAS 75 ZL (9 i T (V1A 155)
3 B E bR (Vi1 155)
4 ik OS (Wit 157)
SR T R
T PCS 7¥#:30 H”(New Project) [n] 3 CL a1 g miff, [Kbixeem it CFC
KR — PR A BB FK.
T SR WA ZUA Tk 1) 8 T 3 FC T ) 3 1 44 FRORAG MUK S BRI 44 B LIS B I H 75 2
T EE F T B B RR 1 Th fig
) i A a0 2B f 1) T
i PCS 7 [ RGN H J5, ®TR B3NS 1) 2R A Z R,
[A ok “color_gs™ it H 75 EE— N[y, - PRt 200K AN 75 22 1 i 1 A PH MBS
B E bR

152

PCS 7 $fit 1 “GI L EIFR D fig .
BePbr e il AEERE T p, SXRE, BRA DR T DU B I REAR AT O A di LA R

WJZZD, FEFE A BRI bR T, BRAE T SRR (PV) L BOE(H (SP) AT {H (O
UT) o FEEs i D bR A R i b 2 R 2o
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S HRATR7 I

8.3 7= SIMATIC E P T 1F
0.000000
0.000000 Einheit
0.000000
Ell=NEN
4% OS
1E. SIMATIC % 388 th 58 s I A7 B A 5, 7EFIR417 OS 19 OS
M2 B, BHHAT G OS"ThAE, OS WJi“al N HI" 4Tk [ SIMATIC
PRSI (WA R, WA SO REERE B
J83h 0OS
WAAE) OS LAk 1A . SRS FifE WIinCC 0 H & B 98 sh AT HL e 2D %
8.3.2 S

8.3.2.1 G0 n] G 8 1H) T R

faj A
TG AR R, BT DL B
o B i R 1) 44 FR
o EFAIE P BRI LI
Bk
o [fF SIMATIC & H g 4T TSI T H .
o UG MM,
B T4 IH) [ 48 BRI T vk

1. WAL ke
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1”" 30 :3%¢ .

2. (EVEANLE A Pk $EPicture(3)”.
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S HRAT 75

8.3 71 SIMATIC E##1 T.1F

3. EF“4uiE"(Edit) >“%F 5 )& " (Object Properties) i1 4
P IF)E 1k - WIinCC il :  Picture(3)”(Properties - WinCC Picture:Picture(3))
SHEAE, Hodh w7 (General) 3 < 4b T80 IR A

4. e 4" (Name) HEHKEEERIN 4 FR“Picture(3)” 3 MO “RMT1,

E# - winCC Bil: RMT1 |
= | e | [
B RHT1
ERTT: color_gs SPAOS[TMGraCSARMT 1.Pdl
BT color_gs SPAPlant14RkT1

T B BT i & F:%Temphcolor_gshcolor 1

1EE: |
sz B8R
B B
basE =4 =]
[l
W= A | By

5. i 7 (Apply) I AT E o

ISR EIFR I TT V5
1. Pl 2B F5"(Block icons) IR
2. N T JE IR LB b7 (Derive block icons from the plant hierarchy) & i%AE.

3. Ll E"(OK) LLORAFHA A A
P74 50 PR AE I HLAE ) T2 20 Ao 3 F v 44

PCS 7 - NI'145%8 - 55 1 #4>
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S HRATR7 I

8.3.2.2 e ] B A 7 22 F 1 T

8.3 7I- SIMATIC & FE# 7 1 1F

[ AR AEREA 2 A AN . 71 “color_gs” il H o HUfq 25— A, Pk

(iPly
BRIANEHLF, PCS 7¥r&: 5 H”(New Project)
— 1 TR T DA 2 RO T A W B
ESk
e U7F SIMATIC & BEES 4T JF 525 T H .
o O] MMA.
FiE

1. TEREALIE Tk FE“Plant1” 3042
2. (EVEANLE A Pk $EPicture(2)”.

3. 1% <DEL> .
BT IFMIER" (Delete) 5 iFAHE .

4. B2 (Yes),
T U 53 1 o

5. XTI RGP LI F OISR AL 1 % 4,

SR ] T A& R
FC111 Picture(4)
ADDIT Picture(5)

8.3.2.3 nfe] B g Bk P b

2K

o LU7E SIMATIC 4 Bas 4T TS H o

o CHUET) K.

PCS 7 - NI'145# - 55 1 64>
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S HRAT 75

8.3 71 SIMATIC E##1 T.1F

o CLEFEH] T AU B B bR LTI
AT RIZLE B A5 S, Al 225 Qe H i g A (U085 153)" 850

WikrS
1. B TEARIE %
“color_gs_MP/ color_gs_Prj/ Plant1/ RMT1” 3%,

2. EP“IETN"(Options) >* T.J 24" (Plant Hierarchy)
>“f)| /58 Fr B Bl #%...”(Create/Update Block Icons...) T4
KT IT B3 5 Fr B K b7 (Create/Update Block Icons)
XPUEHE . IEAR & A oA AP E bR . /B4 (1451 ) (Getting Started)
W FR N “Plant\RMT1\RMT 17,

3. KDL N RE:
— 215 kP “Plant\RMT1\RMT 1 [fil 7 ¥) & IEHE .
— RTLEAIEN N 40598 (Lower hierarchy levels included) HE o A T {117,

HAL T B RS E R ERRE)
WPlantT\AMT 1NAMT T

MEA TAG B TFF HID dHH4AR8E(T)

[ErEwm =
BAMEERRERL: [T =]

mE | mAR my | wmm |
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S HRATR7 I

8.3 7I- SIMATIC & FE# 7 1 1F

4. R HiE"(OK).
P2 U6 A SR Bl bR o
X SRR T HE R T B ARAT ..
WA 5 RS SRR Dk R RS IAE B B D) BE H 35 ? 7(For any later... you must
subsequently compile the participating operator stations...Do you want to view the

function log now?)

fllE  EI i EE (3283:5053)

s | EWEe Wikl BELDETEHEE , T
1) FEecissdRiEsaatiE CHD. ERs
... ) 2 AT RCHI R R

Ehme Al EE W HET

(M)

5. gii“m”"(No).
P4 58 R bR A 1, SR 5 S AT TEAE

H B8 N B AR DB RIAE T 45 R . A 9T IT color_gs™ 3l H HL e i i i A4~ e & 21 81
B b o

8.3.24 w4 i%E OS

f&iIr
75 OS PUEH 27y, WX OS MATHEE. (FHULIhAE, OS ¥ nl YUl i ik H
SIMATIC & EEZs 2l (s, WE. SCARCLAREERIEBAS)
ANEK G 5 PRI BT PEn, BB A TRASGELL -
XL A 2 2t OS YU, DM R AT 7R A8 S e AT s 1) o

Bk

o UM{E SIMATIC & B a5 Hh 4T JF S T H o
o CHIRAMALE.
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S HRAT 75
8.3 71 SIMATIC E##1 T.1F

YiR7S
1. MR ik $ac H
“color_gs_MP/ color_gs_Prj/ [SIMATIC PC ui{#] % #£]"(color_gs_MP/ color_gs_Prj/
[name of the SIMATIC PC station]).

2. PR a4 PLC >“BRAFEH4r %S 4..."(Save and Compile Objects...).
BT TP 0RA7 3T 40 56 %" (Save and Compile Objects) X iFAE .

3. FIFH AL T A0S (1) %3k g 178" (Compile) EIEAHE .
4. EPFOS()" X%, Ik gmin"(Edit).
BT ISR MRS X e 0 i 4544 B2t OS(1)? ”(Which areas do you want to assign to

operator station OS(1)?) X} G HE
BT M ARAE LI H g — N BL EXY0S, o] LUZES I 1 E .

HS : &i% 05
ESTL R T N
= | Jp0s HER |
@F’Ianﬂ AT RrT1 CHST4WinCC Applications05(1]
4| | 1
ceEE) [ F-swe | E=RE miel | #BU |

5. fii“ N2 >"(Next >).
BT TR P 5 IX B X IOCER 1Y ST F2I5 1M 4% 1%:#2” (Select the network connections of
the S7 programs associated with the areas) X 14,
“S7 TP 1M 4% 1% 482 (ST7 programs and network connections) 41147 4% H“S7
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158 AI4675, 09/2007, ASE01222374-01



S HRATR7 I

E4%(S7 connection) fiI-T-#“Sym. conn.”:

8.3 7I- SIMATIC & FE# 7 1 1F

X JE B4 NetPro

TR B A B4 RGN ER AT Bk T T TR IR

H : d&if 05

HSEERXED s7T EFEERSER.

HRE R L IR (D) | STz TIPIEERES)
Elﬁ 05[] s7TiER o | iR | FM | TFREER | wincr BT
e BT =3 5-_"'#%.':':_'[1 | 2 57 connection_1 FEiEE MamedCo...

1] | i
ERO. |
EEE) [ F-sws | =mEe | mie | #my |

6. W ICAL R BoRT &Rz, W %" (Connection...).
Fr“ 1k W % 3% 4% (Select network connection) % HE H k64 NetPro Hhdt 7. (1) S7

B, RJE e (OK).
T RN o

7. BT 2" (Next).

P 1N I B G R OB R 2 15 VE ] " (Select the data you want to compile and the

scope of the compilation) % .

8. L R GEHERE I .
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S HRAT 75

8.3 71 SIMATIC E##1 T.1F

X 45 5 HEHE IR

“Y¥i”(Data) “Ap B FNH A" (Tags and messages)

“SFC m[#14L"(SFC visualization)
“IFi [ #4”(Picture tree)

"JLH"(Scope) "B OS TEf# 28 A" (Entire OS with memory reset)
HS: &\iFos | x|

EEREEEmSENSERHEE.
—HiE BT

v FTEF0iE A (M) IR R RRA

F%?ﬁﬂﬁ@. [iw =]

(T

ek

&+ - 0S[E) v HRFES )

O M (H)

EEE [ FEw> | mmE | B (&) FEHL)

160

. N (Apply).
L ONIEHE R E: T4 OS”(Settings: Download OS) ] 7T

R TR W AR LR N ... A 4kEE? ” (If you want to download changes
online... Do you want to continue?) ¥ 4] #.

. kit (Yes).

G TP AR
P SEAUR  ASTE SRR T IT LGSO, DL R 7

- R SRR -
. FEGRPEEAT R 206 42" (Compile and Download Objects) XHEHEF, #iii“5&14”(Close).

PCS 7 - AI'1457 - 2 1 #5)
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S HRATR7 I

8.3 7I- SIMATIC & FE# 7 1 1F

8.3.25 w3 0S

l5k]
N O AE SIMATIC #5328 b 52 i 74178 OS T T A e+ b %, I7E vl LLITHA A2
OS. M, #E44TJTF OS.
Bk
o [\{F SIMATIC & F g8 FT 2 H .
o LK CBEE
ik

1. fERTERLE Y, EF

“color_gs_MP/ color_gs_Prj/ SIMATIC PC 3/ WinCC N IR OS(1)" %% .
2. P4miE"(Edit) >“T FF 45" (Open Object) 4.

H#4TJF PCS 7 OS - WinCC I [ 4 Bl 2%

PCS 7 - NI'145# - 55 1 64>
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AR 53 3
8.4 1t/ OS

8.4 ffFH OS

8.4.1 OS - WIinCC i H B H 23 451

(il
WinCC it H % Bl asde it T — R4 nl I T 4175 OS Wgifids . (HX T
OS, A bUEHIL A LA 2 -

WInCC T H & B3 B A £ 1
WiInCC Tl | &5 3l g8 45 1) 15 Windows %8 5 FI g 25 4 J5 )1 AR A AL
o (EIEKETA —ANRINEE 1. FEMEAETTHREH T412% PCS 7 OS KT G 8% .
o FEATEHE T —ANVEANE B O, b BORAERINEE I i 4 H KR
fE“color_gs™ 5 F v HU 5 FH IR P ekt 8% b L) ) TR gl B i . AN B AT
T gkias k4l 0S.

8.4.2 T ) [ A Sh e

A AT, R R A S R R B R AR R R R R GOIRAS

4y “color_gs” i H A g (1) it F2 i [ A7 £ T SIMATIC FREZs i T Egh.
WP 3o R o T BT G s P . TR NI T R A SR Bh & S IR e AT B .

PCS 7 - A1 1451 - 45 1 #5>
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S HRATR7 I

8.5 Wt e # it T 1F

8.5 I H A e g A A

8.5.1 BT i 2% 1T A

VAR iTii]
B gk a5 it OS Mg as < —. KBS S g an R
o JeflliE AR, T X SR Bk E B
o FRIAIE AR, TR R O SR A B
o (EAME N XS BIEFM . e BTG HEER DTR S S B RUE X RN . A lid
AR FEN, AT B A SR
JE
B G ) e K R ] kPR LRI TR oo s, B BRI . Al XX Lo st T8
SCECR LS A B 2] B R H FErb, LUEREI T
PIE 3

V) T 4 R X A AN ) I R (R B AT T X 0

o XS —
PR GUR P IR e P R B2 R 5, B, e, . 2T SOR

o ZNANG — M G R B
/10 (h3%8) A kAN AT, XL G2 R B2 0 7o il B AR 1 24
HifEH. 7E“color_gs"il H r, RN T il S sl %

8.5.2 WA FT T R

fai 4
5. OS i FRmM . A ol A8 FH PR T G i 245

Tk
L7 WINCC I3 A4 B g8 4T IF SE 1 5

PCS 7 - NI'145# - 55 1 64>
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S HRAT 75

& Wi T e LT

HiE

1. ERNE O, R R iR 28" (Graphics Designer) 4 H .
TEAPL DR s I H BT e i A i . 4R 2o PCS 7
FRAM D A R A I [T RS I 77 o 3K 28 1 [T M e 44 BRI @ - R R A

2. FEVEARALIE T, X RMT . pd I i SCAF
A I A 7 T 25 P T T
M s R S, R IR AEATR G, X 2l SIMATIC
B P  G P b Ty R A o R 1 G i ) PR I RR o RAE BT LA 3 i 1 B L A A
KPR 5577 ROMTE B 7 B A . S CFC &3 43 ic 2 $in 70 1 1 %) 427 (Picture
Objects) LEIj 1= H ¥y Rt A I b b AT 1 1 B 45 A X A 7 2K

¢ RMTL.PdI M=l E3
RJ1/CFC_LIM11/LIA

.| 999999.9
; L]

]
A 1y e R vy P R P s PR T e TR P R AN [

8.5.3 AT & Fh T HEAE

faifr

I R B T HANE PARAEBOA T DL N AT TPIRZS o
WERTEE ORI T T A SRR, R WA S A T BT s

PCS7- NI/ - 5 1 #45
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S HRATR7 I

8.5 Wt e # it T 1F

R
TR A B R g s R T T

Fik
1. S A VB (View) >“ T HA2"(Toolbars).
BT I T B AL (Toolbars) X HHE. I K 21 1B TE g 2 S A4t (0 T A7 T LA

2. FONUEHERE R, 0 RS EAT R 1

TRE HE|
=k oy
v e
= mAe
v
v g

EiR)

j

3. T E"(OK) M B E
REAER PR s P i) TR,

X BRI AN IR I
o “bryfE”(Standard) LI
o “f}”(Controls) LI &

£ (N3 (Getting Started) H, 5 A8 “brfE”(Standard) 3£ .
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S HRAT 75

8.5 W H A K EHi# it 1 1F

8.5.4 K gmiEasH X5

T g i A T IR B2

TEEDE gt T A b AT SEPR LA AT, A 2 T g — 22 5 ] T AIE “RMT 1. pd il 4 i i
[R5 R ZAR G B IR . IXLE R E LR LR

o HFEXHR
o SUAI
e /0

BOE R R R BERREE T 545 S — WA IO e i i A AR 2

8.5.5 A RBESITER?

TR B (WEIEEED EDWAL, WA ERRAN R . IO SR AU P AR G it
HZ BRSO FEAR R 1

8.5.6 HaRICAR?

SCAI

FESCARS, wl AARAE T 38 S e R i A RS R e B, mlEmA NI
A, DAERETT DUbRA 0 G ] e 584 5% 100 A e 11 D6 B A o AT AR B SO
B NAEATSCAS, PR SO OO A8 2 8 ) o PR A A 7 7

Xt¥color_gs™ i H » R 24 BITAT I RERR 25 #8478 A\ B e A AR 25 1K) SCA

8.5.7 H4 £ 110 B ?

/0 1%,
/0 ST T AT A A LA FZEEL) 170 k.
o Haytik
o ALK

PCS 7 - A1 1451 - 45 1 #5>
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S HRATR7 I

8.5 Wt e # it T 1F

o LA IS AR g 4K

/O 3] b BN A ks =0, —gk il bl A R RS
LREBEPA X G FE, WA 11O Sk FEAN R Rk SR T AN R (1 1
fr"color_gs™ Wil H . CREAEH] 1/O Sy Ptz dhier S b 1 8l 2 (1€ 4 kL

8.5.8 PR B IE/E R R

R EE
RAE T A 2 ) o o IR PSP R D e
FER RS, Ron I REbr R R AE (106 Gl A 1 75 i v o
I bRSE HE, AR R SRR R bR RS 2 T g B, XA OS Al LA
AS Rl A R i s A AR SE

PCS 7 - NI'J451 - 25 1 #4)
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S HRAT 75

8.6 GYE L FR i
8.6 B3 72 1) T
8.6.1 An )R T A B O\ G R 1 T
K
o “RMTA" ik i i [ 7 [ FE G 8 o 4T
o HREFEAA.
AN BT U e 1 S P £
WG O — AL B AR B AC T, SR 5 A BEH % BAR A 2 B e T 7 A5 S
A
HiE

168

- EPESR R A VLB (View) >“FE"(Library).

ATIT OS JE.

. I “Global

Library (4:J5%) /PlantBlocks (T.) Ht) /Tanks (##) /Tank4/PlantBlocks ( T./ ik
) [Tanks () [Tankd”, 4R i 1 i i VK HL A% 50 30 mi p

i
o T AR IR S (Eyeglasses) 1240 Al 3R 15 KX % 1 1

AR PTR, A5 IR G sh 2 AR .
- KM
- RPN GO RAE N B LS B

— AR S, TR BCE AR B B, ARG AT B F LV TR IR K X R 4 5 21
Priti L & o

—  ATRUERER A NS BN, AR AR CEAEX SN L, AEFAT B b % AL
(RIR]IN BEAT 2N, AT AR R A KA

PCS 7 - NI'145%8 - 55 1 #4>
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iy Jiabin

8.6 G2

/]

bE T S LR R AR

Horizontal pipes (/K V% i 3x Global Library (4=JRJ#) /PlantElements (1) JGZ) /Pipes - Smart
Objects (&1 - & HEXTS) /3D Pipe Horizontal (3D 7K P41

Vertical pipes (IEH#1E) 5x Global Library (4=JR)%) /PlantElements (1) JGZ) /Pipes - Smart
Objects (41 - FAgx%:) /3D Pipe Vertical (3D I H41E)

Angle (&%) 1x Global Library (4=JF)%) [PlantElements (1) JGZ) /Pipes - Smart
Objects (i - & fiExt%) /3D Pipe Elbow 1 (3D #1253k 4)

Angle (CZE) 1x Global Library (4:J5/%) /PlantElements (1.] J6%) /Pipes - Smart
Objects (&1 - & hEX%) /3D Pipe Elbow 2 (3D #1425k 4)

Angle (CZE) 1x Global Library (4:J5/%) /PlantElements (1.J J6%) /Pipes - Smart
Objects (&1 - & hEX%) /3D Pipe Elbow 3 (3D &i&Z5:k 4)

Angle CZE) 1x Global Library (4:J5/%) /PlantElements (1.] J6%) /Pipes - Smart
Objects (&1 - & hEX%) /3D Pipe Elbow 4 (3D #1425k 4)

Control valve (#=#1I1&) 1x Global Library (£ %) /Symbols (£55) /Valves (&) /30

AR N MHE (Tanks 2x 4= JA)J% (Global Library)/Siemens HMI 45 (Siemens HMI Icon

representing reactors)

Library)/fi# (Tanks)/Tank1

PCS 7 - NI'145# - 55 1 64>
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SR AT

8.6 G FE AT
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S HRATR7 I

8.6 LY FE AT

8.6.2 FRvETL] A4

BiR
TSR R LU AN D BRI AT AR E -

B N

N IE ELAS A SO (TR 171)
2 W SCA, (1Y 172)
3 SISO, (VTR 172)

8.6.3 BB 1 - WA R SO,

Bk

“RMT 1. pdI" e 7t i C7E B T G 4 s R 4T T
o CIHAFSHZR .

Tk
1. FEXTR IR P TPk v Xt % (Standard Objects)/# 4 SCA (Static Text)”.

2. A b AR X
PR TR B A MR SCAR AT 5

3. FESNEEFFE A ORI
R N— MR, HILH RSCAR e gkt .

4. FZSCAHE N “Reactor 17,
5. % Enter 48 SCAS .
6. AR “FE AL PR 15 B SRR A% K

— RSOSSN TT L (Line weight/invisible) 45 H
WA 25 BB A S IR U AE o

— Merh A I e U AE W (Fill pattern/transparent) 45 H .
IEERAE S Al SCARIR I B AR A i B

PCS 7 - NI'145# - 55 1 64>
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S HRAT 75
8.6 LY FE AT

8.6.4 IR 2 - W B A,

R
o “RMT1.pdl"ied i i 7 O 5 B T i 4 2 T 4T T
o CUAIAJFIEFESCALL

Ttk

—

. IEPEEE A A AL (View) > B " (Properties).
“X} % J& V£ (Object Properties) X i HES] ¥, @ PE"(Properties)
IR AT HEIRAS .

. AERTEAL P b 50 2% SUA” (Static text) 45 H «
VEANT BN DR s SCAIR ) 24 AR AR

VIR EEN G B, SR X “ER AT (Static) £ H R “E A& SCAS 17(Static Text 1)
HIHE,
TUAE BT G LM B N ATE R 1) SO

. BEAN 4 Fr“Reactor 17, #RJ51% ENTER.

R RAF L FRIFAE AT P R
WERIEAEAE AT AR, R 208 B e o 5 B s, Aot A o0 TR Bor

N

w

N

5. FEM AR I A Ik A SCRIF 4R (Static Text/Font) 4 H .

- DI B EAE BRI . 7R AA7(bold) Je 5% HOAE - XUk 757 (no) {i.
ZAH 157 (no) BEBUh /2 (yes), SCAMMA T fHAK"(bold) J& 1k .

(o2}

~

. KM% % JE 75" (Object Properties) X} ifiHE .
W oS A T

8.6.5 WIB 3 - WA & SCA 5,

Bk
o “RMT1.pdI" ik i imi 1] & 7F B g i 2% Hh 41 7
o CURASIAI
o UNIUARBHT T RE .

PCS 7 - A1 1451 - 45 1 #5>
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S HRATR7 I

8.6 LY FE AT

Tk
NI S T REAT N B — N SO AT I P A B, TR SOAR, R A HUR A R
A SRR

1. WERSCAHERBILERE, EFHZICAHE, MR A k438" (Edit) >“E #"(Duplicate) i< .
FE 4 S SCAAE

2. AESCAKEH XK R SCA B il “Reactor 27,
S Thhe A 3 B AT HARRS 5.

3. EPYLE"(View) >“|E " (Properties) @4
4. FEVEANE B 1 HeRoN % 44 R Ok “Reactor 27,
5. B SCABIICE BZA 555
6. EHALWA £ 5, QI FHISCAE:
—  JRURHE
— L] RMT 1 4

7. ATIFSCARIR Unit RMT 171 J& 1 R0 TEAR 1] 1“8 SCA 7447 (Static Text/Font)
%H.

8. VI EITEAN(E B 1 JF 4 74K/ (Font Size) J& 4 A {5167,
9. JM“X % )& " (Object Properties) XfifHE .
10. 4% DL 77 sUBCE SCA IS :

—  JEURMRE — AR JEURMRER 220

— LJH) RMT 1 & — Rl RE i i) e b A

1. LT (File) >*R17"(Save) fir
FE 7K PR AT 2ok A2 1 ]

WESR A NHE . A EAIARZE, T A i i 20 B s«
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SR AT
8.6 G FE AT

999999.9
999999.9 i
999999.9

8.6.7 W S R S T AR

o
eI I PR N I RER S JURHGE . SRR AT s JEURLRE (K 2 BT WA, BRI )
Al A5 EPSES U

EoR

o “RMT1.pdl” i 42 i i1 07 ) FE G 45 25 41 T

PCS 7- A\I'1¥6/ - 5 1 #0
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S HRATR7 I

LIS ANGEFSUE

8.6 LY FE AT

Fik
1. IEFER R B Tankd” M %
TR ChRE TR BT, KA I T R BIRiZ S ) A FR
2. EFVE"(View) >“J& " (Properties) 4 .
“Xt % J&@ 7" (Object properties) X 1iHAEST 7, Hrh“J@ " (Properties)
TR A TR
TERTERL I Ik Tankd”, WIFETELRA(E B & 1 2R 544 757 (Object Name)
F“Z"(Layer) J& 1.
3. DB VEAN LI SR 5 0L FR A" (Static) B 1) Tank4 i A E .
T A5 P G Y A AE PR SAS
4. i N4 FR“Raw material tank1”J1:4% Enter .
mARER HE
| i@ ﬁ'lﬁ'l EEEEE] IHaw Material Tank j
Bt | | ¥
o BELHE B @& (& @
- I Raw Material Tank,
i 0
LHE
i UserDefine:
1] |

5. 7ML K ik B Tankd/Fr %5 73 " (Tag Assignment) 45 H o

6. UIHRENVEAN(E B A o REOEARBCE B TS (Fill Level)

JETER I bR s ST AT B GES

PCS 7 - NI'145# - 55 1 64>
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S HRAT 75

8.6 LY FE AT

WA - HA: F Temp'.color_gs'.color__

7. BT

(Tag...)

AT TR B XS T HE o

FR27(WInCC tags) ke
PRI o ES #r%5.

9. fERIEMIE S, WP

“ES ##%/ Plant1/ RMT1/ LI111/ CFC_LI111/ LIA’(ES tags/ Plant1/ RMT1/ LI111/

CFC_LI111/ LIA).
FEANALIEIR s BT T ES AR5

10. {EVEANE BV H Pk £ U AL e

. 1E“4¥5 5" (Data source) 41k “ES Fr%"(ES tags) HIiEHE,

1wincproj',05{1)05(1).mcp

H25H“WinCC

PCS 7 - AI'l457 - &5 1 #4)

WES Wariables
EHEIE [WinCC FFE
g [0 =l
E@ E3 Wariables || AEFE I Tvpe I Camrment I il
=) Plant1 M _SuP_aL Einary wariable 1=Suppress LL ...
L—-l - RMT1 EM_SUF'_'-.-'-.-'H Binary variable 1=Suppress H ...
| FC111 EM_SLIF'_'-.-'-.-'L Einary wariable 1=Suppress L A...
E‘ L1111 EDCCUPIED Binary variable Qcoupied by Ba...
CoEEycronn _ _ .
: 3005 Binary variable 1= Out of Service
- LIA ) )
- EQEF{R Binary variable 1=Error
EQMSG_SLIP Binary variable 1=Meszage 5u...
ESTEF‘_NO Unsigned 32-bit,..  Batch Step Mum...
3Z-bit floating-...  Analog Inpuk (...
ELI 32-bit floating-...  HH Alarm Lirik
3LI AL 32-bit floating-...  LL Alarmn Limit
3LI_'-.-'-.-'H 32-bit floating-...  H Alarm Limit ...
ELI_'-.-'-.-'L 32-bit floating-... L &larm Limit {w,.,
7 | 3'-.-'STF'.TLIS Unsigned 32-bit,,,  Status-word =
TR mig | s
ps
1. Hli T 52"(OK).
T34 AR 25 F1 L 58 3 % 452 5 N5/ 57 (Dynamic) 41+ .
176
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S HRATR7 I

8.6 G2

‘Wlféflfi’l EEEEE Raw Material Tank
2 |$f¢ |
W | a7
#5,000000 @ PlantlJRMTLCFC_LI111JLIA L
1000,000000 @ Tag_max
0.000000e+000 @ Tag_min

12, 7E"FA"(Static) I, X" KME"(Maximum value) J& % 1151007,
BT M5 N (Value Input) XFHEHE .

13. #E“I K" (Maximum value) fi AN EH i AE“6007, 485 F i “ffi 2" (OK) .

FEFF 1 DR AT BEARL
14. ER R/ MENZHL.

15. KM% J&PE"(Object Properties) %I ifHE
16. EFEICHE"(File) >“fRA7"(Save) 4.

7K DR A I R i 1

8.6.8 fe] R R E bR

fai 4

T 0 T A A P s SR B B AR D REAE SIMATIC

G REANSRE bR, PCS7
C A ShEd R i b A e m A T IR bR an R T IX SR A b,

PCS 7 B2k T CFC EZR P i BN /K1 M1 H5 7] H BBt 7 B I&I s
WAL I T SRR X LR P B o

PCS 7 - NI'145# - 55 1 64>
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SR AT

8.6 GI#E L FE i
2K
o “RMT1.pd i 42 i i 07 FE G 45 25 41 7T
o HEIFRTT .
Tk
1. EFPE.._NKA11/NVALVE B B FR 4 S 20 20 A 75 407 B, DU Re B B bR o (4 18 57 v
ff I A 5 T 2 ]
2. XTI AT SR bR A R P AH R (9 77 5 542 T TR O

999999.9

R
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S HRATR7 I

8.6 LY FE AT

3. L (File) >“{-7E"(Save) i 2.
R YK DR AT 1oL R 100 1T

8.6.9 AN EAE REEHHEA 1/O 3

B
T ERAE L], AR R A L
o NI
o AR/ PR B o
T A N S IE R 46 —
SRR AP ER. RJE, FEAHAN A A RE 2 A e (E A -

3 M

A 1O 35, (JhY 179)
#4110 1 (FT5 181)
AU SO (TTAS 182)
HABIA R EE (TUHS 183)

AW IN|[=-

8.6.10  F&E 1 - tfalHdEA /O Bk

2k
o “RMT1.pdI"id F i 1] O 7E B G 4 2 R 4T T
o XTGP T,
o FEABEFI AT,

WIRFS

1. 75N Gk PR P IR BB HE X :/1/0 187 (Smart Objects/I/O Field) 45 H .
2. R R IX .
PR FRERAZ R /N 1/O HE B R o
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S HRAT 75

8.6 LY FE AT

3. FEAE BRI & RN 2 A2l — AN . HOBIRK/NRN %S 110 HER) R /h—3L.
BT IF1/0 14147 (1/0 field configuration) XA .

4. P bR (Tag) HE S0 I “brZ ik H 4] UEHE”(Tag selection dialog) %41 .
BT I PR - T H”(Tags - Project) XSG HE.

5. 7455 (Data source) 41HEH“ES #1%5"(ES tags) K IEHE.
AL R TR ES FR%5
6. {ERHEME T, EH4 HES $r%/Plant1/RMT1/FC111/ADDIT/CFC_SETP/

PARA_DOS_RM1_SEL"(ES Tags/Plant1/RMT1/FC111/ADDIT/CFC_SETP/

PARA_DOS_RM1_SEL).
AL ELRE s T A BR 26

7. AN B A RO

W %8 - WA: F\Temp'color_gs'color__1'wincproj,05{1)4,05(1).mcp

e B . Engérzg%es
wtiess: [0 =l
E@ ES Yariables st Type | Comment |
E‘"' Plant1 IETRACK Binary variable Burmpless Chan...
L:-"" RMTL Einary variable Operator Input 0
El'" FC111 ZILINE_OM Binary variabla Select: 1 Linkin...
E[EDSIETP e Einary variable Binary Cukput
; w-fF PARA_DOS RML_QT* ZIG0P_END Binary wariable Status: 1=Cper..,
:ﬁ' PARA:DOS:RMI:SEL ZlQoP_ENL Binary variable Stakus: 1=Cper..,
H ﬁ' PARA_DOS_RMI_WOL
e[ CFo_Foi1d

[ [Eg L1111 o
MK111
MK112
fal MK113
- (B3] MK114

[ (B3] MP111 -
4| | »

TiHE HLiH FEEh

8. Hi“ifiE"(OK) LARAFHIN -
PR BRI B b2 (Tag) FAE.

9. iR CLLFE" M #"(Both) 2T,
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S HRATR7 I

8.6 LY FE AT

1/0 B4 |

TE IPl:a.ntleMTl;‘SETP :JI
Bk |2 e |
_:W:_fé

O HEiE O EA & TSN

~HEF

?HE:A:/J\...| 12
$1¢E$ﬁ...| hrial
we. | [

TR mi |

10. e (OK) ARAFEH N o

8.6.11  PIE 2 - A% E /0 A

Bk
o “RMT1.pdI"ik F i 1] 2 78 B g 2% HH 4T T F
o LEA 1/0 1,

PAR7A

BEE 1O ks Ay 5 e BSOS 5 s XA R
1. &+ 1/O H5 1.
2. AR AL PR B B A

— Pl SR 4N BE AN W] L (Line Weight/Invisible) 4% H .
I ER AR 25 BRSO A I AE

— R 7R/ B (Fill pattern/transparent) 4 H .
SCAA R B I AE AR A 3B
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S HRAT 75

8.6 LI #ELLFE Il
3,
4.
5,
6.
7.
8.
9.

8.6.12 S 3 -

2k

Tk

182

PR WA & YLE” (View) >“J& 14 (Properties) .
“X % J&@ V" (Object Properties) X1 HEFT I, L@ " (Properties)
IR AL TR IRES o

FEAL S B A PE AR AL B $51/0 180(1/0 field) 2 H -
TEANE AL DR Sl R SOAHE R BR8] o

DI BI VRN 65 SALIE, AR5 Wi 28 (Static) 71 ¥ “|OField 174 AHE .
DA T 25 45 L iy AHE PP R STAS

HNHBIRSEL_REAK”, #RJ51% ENTER.
R RAF LR FRIFAE AT P R

FERE AP T PR/ 15/5447(1/O Field/Font)
S H, IFAETEAE B E H ek R A" (Bold) J& M I 3 Uk “ 2 (Yes).

L G BEO /i /4 (10 Field/Output/input)
ZH, JFERENE B % D e 4k #% 50" (Data Format)
JeE P PR B O k) (Binary) .

5% H1“xt % J& P (Object Properties) % ifHE .
W s A S

Jn T 5 B 1 SCA

“RMT 1. pdI” ik 2 i ] 45 B G 4R s HH 4T T
EAA 1/O s 2o Hok B g .

) AR OB AR ENITE PR I VO KB EAT Ao I SO DL i i ]
BRVE ) I8t CAE ] SO

1.

2.

N SCAY, — i F“brvEXT 4 (Standard Objects)/#: 25 A (Static
Text) 5 AT A

HINPLURSCA:  “Select reactor GEFEN3E) : 0 = Reactor 1 (Jx V3
1) , 1=Reactor2 (KW 2) 7,
% <Shift + Return> 61 g — £k .
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S HRATR7 I

8.6 LY FE AT

3. U AT AR PR U SCAR IR ) s 2
— AEANET L -2 O A /AN R] W (Line Weight/Invisible) 15 &
— HFEMW -7 AE B (Fill Pattern/Transparent) $ '

4. AE /O TN SCAS IR i B4 — AN - O i A F B X % /4B (Standard
Objects/Rectangle) %,

5. A% A AUk b v BSOS A 2
— IBHERPRLAN LR SR AN /3 15 257 (Line Weight/3 Pixel) X &
— HFEW - He A% (Fill Pattern/Transparent) 3

6. % MEPIRIICEX 5 :

Select reactor:.
1 =FReactor 1 -

7. JHRUbRHEIR 40 B

8. P A 4GB (Edit) >*41”(Group) >“41”(Group).
PRI 208 BT 4 S IALLUN AN R I 5 TR Eh R 4

9. RrXLEX BB AR N EE 4] o

8.6.13 S E 4 - TN EEHH

Tk
FEIAE NS 1 2 2 I T O FEEA T8 A s DU B (D SR LA -

1. A AR
“Plant1/RMT1/FC111/CFC_FC111/DOSE/SPEXT_ON"{fi A\ I/O .

2. {ERECIE PR A 1/O Skt e JE 1k -
— IAME: AT, - FEIE R T B 2 4R 4 B2/ AN v] WL (Line Weight/Invisible)
— TS BV - PRk RO B S 45 A% W7 (Fill Pattern/Transparent)
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S HRAT 75

8.6 LY FE AT

3. {E*J& " (Properties) X ifHEH 2 1/O 1845 & J& V-
— “l/O (/O Field) J& 7 -“% % £ #x"(Object Name) §ft: “SEL_SP”
— “FHE°(Font) J& M -“HlfA"(Bold) #itk: “/&"(Yes)
— “fay /% A" (Output/Input) J& 1 -“Hdli#% (" (Data Format) #5E: “—3tHil"(Binary)

4. FAVEIESOARSE: WA BOEM, 0= AEE GRIESD , 1=4MiE (CFC
K#) "(Input setpoint, 0 = internal (operator), 1 = external (CFC chart))

5. Ml AR A PR B SCA I

— IHE: AL 2SR AN AN AT WL (Line Weight/Invisible) 15

— Mg B - AE W] (Fill Pattern/Transparent) %
6. HANTERINME — R GIEPEM, “PrifExt %/ HJE”(Standard Objects/ Rectangle) %} 4t
7. SRR AR BB N AR A

— JOMEMIZE SR T LR 54N /3 15 227 (Line Weight/3 Pixel) % &

— 7. B - AE W (Fill Pattern/Transparent) i &

A Input setpaint
| 0=internat -

f {operator) . .
171 =external -

8. Wi i T “gmiE"(Edit) >“40%1 %" (Group objects) >*4H"(Group) %, HEATH 5504 .
9. KA Ja IR G IBCEAT 22 R4y

8.6.14 W5 TIE

Tk

1. ZEPATES A ..._FC111/CTRL_PID"He & br 2 [A4fi A — 57k, DLRHREARES 5%k
ElbrZ I8 R
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SR AT
8.6 G FE I

2. {ESRHRERI SR I FRe.. . /CFC_LIM/LIA”Z [aJ4l AN — ik, DARHIE R FR 2 512 0 & b
Z IR AR -

3. R R B E (I EAE YL 5. /CFC_FC111/DOSE” - .
4. WAL EXNR.

R
Ao A 0 T P IR 2 BT

o

9909999 Il 15
Q1]
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S HRAT 75

8.6 LY FE AT

1. WP (File) >“0R7F"(Save) fir 2
PR DR AT CLAS T A 5 CSOMIVAS I EUE A ) 3 R 1 7

2. KK A .

PCS7- NI/ - 5 1 #45
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S HRATR7 I

8.7 ik ...

8.7 HEPRAS...

8.7.1 i B A4 EPRA

BRI SES
SEm, BH CoeR XA DL I R, BAE OS AN C s 7 LA T Dhfe:
75 SIMATIC 5 B4 v 5 ! i 11 g Pk
L b
Gt R AR S
TE BT G A5 A3 A Fionf 5 Clni & RNl 50 B g P i
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S HRAT 75

8.7 ik ...
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fEIBAT P i fE 9
9.1  HXIFFRE

9.1.1 TR T OB AE Bk

AR T KR AF R IR IR TR
FER R, “color_gs™ T H D481 b il A i P R die o5 M T REE
FEF P bRIN, ATREAT T
o WMHEMNPRE:  WITITEEH
o WEERPIRAS: F B BERRGE
o NBRIEFREE g AR AR
A 1O Sk}, AT ik
o RPN
o IEFETTM CFC RN BE(H, skFELmaed L) Ak SAESNIR E BUE(H.
o AR g BhE B i vod (i
AT LAEAE CFC AT SFC 3. MR, 28 TIXATIkE.

9.1.2 SRR AP A

&t
TSRS B IS BRI A, X B R R R 1 PCS 7
PP SRTEAT T BB
LM 00 P 4T 5 DA R 3

o T
R EAT R LR L BB
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BT A

9.1 W1 7 7 11

190

MK

FOVFI AR 1 fir A HHLE R L) IR B AR X LEK B, (e color_gs™ W H i, i T
TR AN, RS AN RMT T L

(AR, SETIANEEL, T 255K A TR IR AN K
T B R 4 2 i

165 PR BB A 0 0 5 ST FF— AL, 7 o T LR 2 4 (0 T 4%

R

HRAE/E S WD R DI, SR 16t e P . 7E“color_gs B H b, 4 il
Vel B i 4 S B 1 T

I

AT TV P Bt R T LR (0 % I . 7e"color_gs B TR, s FUAE T AREI%
T F A B AL

SHETT BREX
T q
! |
110 0 RRRN EERNE
N N
N N
N N N
SR EE

DO000ddoy 0odod dododoo Ce

l

BE
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BT A

9.2 W FEHAC FIIERIE R 1

9.2 AT MRk 5 i

9.2.1 ARl EE I R AR X

Bk
e WInCC Il H & #4847 I
o ST HAT I
BiEd R %

1. EECH(File) >“BiE”(Activate) i 4.
K FT T HE 5 4% R )i 20 1 T

07_10_08_15_31_36

BEEERETRG
L]

50 %

2. i X N “RMT17,
o TN TE T G i 2 v B0 B 1) ol R o T

9.2.2 el g shit #2

f&j
SRR LR I DAL BT A ThRE, IUE XA 8l 4Rl 7.
sE LR SFC W& H8). AIfEd AN B A3 SFC, Joiti#enl 2] SIMATIC
(LT N
A WA B R
o [FMHHLEER ... /.RMT1/SFC_RMT1”
o LAl — AN %A
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BT A

9.2 W FERC FIIHRAT G M1

A PP A JE 3

1. i Ebse... /RMT1/SFC_RMT1”.
EEEAPIRI TP

MT1/SFC_RMT1
LI TT

2. HuhH 8l (Start) #4241
BT IT“SFC #:4F”(SFC Operation) XJiGHE .

3. Ml E"(OK).
R R SR AR S8, ] TR e A i R T R

4. B H 73" (Section).
T IF SFC ERMPEA S R BoR. X— /RN T SFC 4ifiash SFC
SESINETATN

5. X SFC B Ef—/ P8, DIAH KT SFC ER AR ME el i 8.

i 4 5 3h

1. Hh R %41 20" (Change Button Set): '
SR AN

2. Hui#i“SFC nf#i4L"(SFC Visualization). &
FF F“FT 7+ SFC”(Open SFC) *fiFHE. HTIiHH HA—4 OS fl—/> SFC
KL, Frbl A7t OS Worfem A g, i HAETEN{E B % H e H i oRi% SFC
K.
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By 44

9.2 W FEHAC FIIERIE R 1

T T3 SFC [x]
=
B |
- % CHS1 SFC AT f—... | T ez i
“8L color_gs_SP_05(1) * =l * N | * i
&= Plank 1 RMT1/SFC,.. 2007)...  Plant](RMT1/SFC_RMT1 SFC_JEAEIL rMTL -
e | [ m
v

3. EVELIME A T B RMT1/FC111/SFC_RMTP £, SRS H ik i 2 ” (OK).

FFTIT SFC KL M I /ME S

K2sre ... |

]

4. ﬁ‘ﬁj“ﬂ:l:)é\% o

K thPL SFC BRI TEA(E B 5

PRI A B s

PCS 7 - NI'145# - 55 1 64>
AI14574, 09/2007, A5E01222374-01

PEPEANME BB s 2R AL T-7E SFC i & il ikl SFC

193



By 4ia

9.2 i B FIIHRAF S 155

BdPlantl/RMT1/SFC_RMT1 : SERUN: T as 3% =T

| @ |V oE ImerEs | BehEe | [EE
Fig || T —
[
IMIT_LI... IMIT_LI...
= o
INIT_DD...
SLOwWY . -
& I
= o

B IT gl
= | [
Fa |xl BE U] EmE | s@mEn |VoesEd
Hep Xl ik ¥ = |m] EiE T 7EREAT
HEEE IR I e
|SFC_JF#AETL RMTL

x|

5. Kb e BB e i, LR A T R B
6. Hii“ A 8" (Start).
BT IT“SFC #:4F”(SFC Operation) XG4

7. ki E"(OK).
K RSP R S Rl B A1 SFC IR I TR B R h & n] i .
#£ SFC EZR P 1R A 5 M R IRk BT A

9.2.3 s kR

L
WERAAY B R IE W I2AT IS5, v T sk

PCS7- NI/ - 5 1 #45
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BT A

9.2 W FEHAC FIIERIE R 1

1. 7& SFC ERMPEaAL -, iz 1" (Stop).
#4TIT“SFC #:4F”(SFC Operation) X it .

2. TR E"(OK).
B b,

3. WifE, {E“SFC #:4E"(SFC Operation)

XFUEHE L A" (Reset), AR i i 52" (OK) o
SEER AR BT AT (L R A7 A A

9.2.4 ane] ) FE 3o i T 4 R

B RS REES
FEIS AR LT, A7 LA A FH e 8 i 1 55 i o R £ 79
o JEPERNVEE (VIR 195)
o FIIFHIMR (J1FS 196)
o JEMUWEMH (L4 196)

9.2.5 WA e e )R V.3

WiR7S
1. ¥ bR TRER e AE LB I N 32 (Select reactor) X351 1/0 1k,
SRR B A2 N SUARE R .

2. Hiili 1/0 k.
/O WAGAE s 5t LR

3. AN g AL S B
— WRAER N 1 TPERESE: 0
- WURARE RN 2 hE RS R 1

4. 3% ENTER.
TEFE T L IR I B PR A W T8 H R 7E sh X 3 o
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By 4ia
9.2 W FERC FIIHRAT G M1

5. HJH IR AL R,

9.2.6 el ¥7 FFIHIAR

YiR7S
1. A ahd R
2. kit e bRe..._FC111/CTRL_PID”,
AT TFARR (K THIAR, e rprebRvf”(Standard) ZEI0 - b T Bk .
3. I T R R TR . X T color_gs™Ti H, AHICHLIE W T :
— bR — T A LR S (T T 2 A 8 Y (R S B

— B — WP R . ] “Bar HL F1“Bar LL7HE AJ 15 ek (Standard)
WEIAR I R .
— PR — n7EH R A CFC R X AN E SRS BRI

4. KPR .

9.2.7 T Ae] B8 B i e AR

faifr
AT A AN 2 R i A
o UL, SCEREAL AN e (I R A E e E A -
o RIFHINFFE BOE

SEA: R vEER

1. 45 G4 VO IRI"H A B {57 (Input setpoint) X .
LSRRI o ORI
LR A S A AR

2. Wi /O B, JFHE FERPR, AT BRI Kk

3. #% ENTER.
PR AEIE e R DR A B (B4 F R AE e X v
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BT A
9.2 I FEHE FIHE LIS

wmeEEEE...... MAWTHE:
M CFC B2 iz 1
FEEEY(HAESILIIN 0

SB|2:. MAREH
1. Hudi e bie.../CFC_FC111/DOSE’.
BT IR TR, LA “brvfE”(Standard) ZE7 R AL TR IR Es

# dosing of raw material EEEHE R
e Flantl/RMT1/CFC_FC111/D0SE

S P = |

100.000 W =k
s R I

sz v| G ]
50
TEE o
v
0.000 LE 0.
SF BV {E1EE o

2. IJFBE (" (Setpoint) 514
FETIFSP R R AE

3. BOE“AN EB(Internal) S IEHE

¢ OBE £
A
| m= || Bl |
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By 4ia

9.2 W FERC FIIHRAT G M1

4. HE“217"(Run).
B OB 1H (Setpoint) Fi AHE .,
5. H e (" (Setpoint) FiAME .
BT ¥ 2 7 (Setpoint) X IHHE

6. {EHIAME N LT A BT

|

L +1000.000 N

w50

LL  +0.000 %

e | W] =
FEER, [#]

[Iﬂllﬁllﬂllﬂl

7. s (Run),
{ELRI AR A 25 AHE o

8. KM -
RAE B b s B R 1L

9. HHIIFEIFH AL R

9.2.8 Pl EEFaE NP

faifr

R TR T R

o {EIHEATH

o {EHKIHESIE T
H BT

SIS REEATIN, MR O [V S S s A i P AT
H BT B S U SE G e M BT o

AT AT A IR A LA A S
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By 44

9.2 W FEHAC FIIERIE R 1

HRFIR
WRIHESN R A F FTATH AR E .

1. P EE 4 407 (Change Button Set) #2411 :

<

2. i LR 4" (Message System):

i
e WoRHEYIE.

3. 4% NRP7RHiIAH B

4. PRI DX Al b (R L DL A B & R R ) 3

5. b X s 1 — 2" (Previous Graphic) $%4H :

K

PAT B A R R (9] B RMT A5 4 1 7

L TIRING SR PSN BT RN BAAN Y B (Acknowledge single messages).

¥
SEERAE ST H bR A = A .

AT S i wa A ITE T WY A (Acknowledge all visible messages)-.

[+

9.2.9 AT R AR R

DR
1. PR L X SR 1T 2o 41417 (Change Button Set) 44411

-

2. iR HIE1T R 4" (Exit Runtime) %4 :

PCS 7 - NI'145# - 55 1 64>
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By 4ia

9.2 W FERC FIIHRAT G M1

BT IR 24T R 407 (Exit Runtime) X iHHE .

REETHRSK

EEHEERHBRGETRS?

WAE, Wiz BHERG 2.

B HANE

N2

3. Hii“4% )" (Deactivate).
X B H I R

4. P WIinCC I H A& B g,

200
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PAT MRS 1 O

10.1 B IR 45 a5 A

B AnAESS
fE“color_gs™ Wil H i, i E P ML TE M R R A s o BEINAE S5 IR AR50 N JUkHA
#RMT2", HAZHHL: EAHEHIGERIA PR, HEH PCS7
W EBIIRE. kB PCS7
MR HIIRERAEG & AT Z D IR, REROIA LR AT IX D IR
FEQIEREE AR eIy, R BEE s B AP FEAISSE DN REAR SN, e
BT P KRE D RAGAE . I, BATASAEAH ) P AT VR D A, i o die e
AP LR HIY, 0 Wi BEAT B 45t — A AT =

10.2 e B T A B RMT 175843

Bk

o [\{F SIMATIC & F g8 FT 2 mi H .

o MR MA.

e RMT1 L) HAHMHSTTEN, HARBIE R,
FiE

1. &+ Windows (1“5 D ER“RMT 17 |2 4 SCA R AT B Plant1” 2 S0 .
SIMATIC
LGSR B RMT R R0, a4 0 RMTA(1)", IR HAR A7 2 Plant1”)/2 44
S, xR g (flin CFC/SFC EIZ) A RRiB I — AN ELE S o
1EAARZSCAT I, B H# 3 &4 CFC &I N A [ ¥ )2 e SOk, 76 OS
I T PR B 20 G2 58 ) CFC SR fsg X5 T2 H sh AT S0 .
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AITHINITES

10.2 Wi R #H 1) BAHTRMT1 7257

>

EE

R R T T RS S B R R T, Rk, BUANFE RO R it T = A 8,
BN ASR G5 RPRE 5%, A 250 1] T HORE L FOH B 21 B

2. IR N R SUZ PO KA SR A BN A4 K

BF IR AW ASINE - IHAHKR AR
RMT1(1) RMT2 “RMT (1) i P i i RMT2
SFC_RMT1(1) SFC_RMT2
FC111 FC112 CFC_FC111(1) CFC_FC112
ADDIT ADDIT2 CFC_SETP(1) CFC_SETP2
LI111 L1112 CFC_LI111(1) CFC_LI112
NK 111 NK115 CFC_NK111(1) CFC_NK115
NK112 NK116 CFC_NK112(1) CFC_NK116
NK113 NK117 CFC_NK113(1) CFC_NK117
NK114 NK118 CFC_NK114(1) CFC_NK118
NP111 NP112 CFC_NP111(1) CFC_NP112

BUE, LTSRN N P

E® color_gs_MP { T ] #E) -- F\Temp',color_gs"color_gs

EI% color_gz_S5P
o) E=EH
-1-[Eg] Plant]

=38 color_gs MP | | HEE [45 532 [0s #82 [ o5 BHEES I

[hCFC_ES2
Repart{E)[1]

1]

SIMATIC 4001 MNEPU 41,
CHS1%WinCC Applicat... -

202
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AITHINITS

10.3

He% LIE

10.4

Bk

Tiik

10.3 A FEHRECHINER T 1F

SRR RIS TR

FESRHIL) A4 RMT1 LG RMT2 I, Gt 17 5 i) Pl AR aod v 1

WAL ZF X EEF BN R A S RGO A4y OS.

N, O T RE R TN R, RGO, PCS7

fi R 7 AN G AT T 28 8 B SO IR T ST g D AT 3R A P 7 (1 I 1)
fE“color_gs” Tl H v, IXIFAEE, BOYIZIHAR .

TEHARBLL) I, 2k IR AE 7 T

— EUSERCT G AR R, R B A RMT2 i R i 1

SR T R R R R REA T DI RENA

A G PEAT T B 2

o LL7E SIMATIC 4 BHLa5 T 4T IT ST H .
o CHUE L) LK.
e CPU 4t T“RUN-P"#i:A.

1. EM TERLE Hh £ FE“color_gs_Pri"Iii H .

2. R4 PLC >R HgmFExT % ..."(Save and Compile Objects...).
“K13"(Charts) X SRS SH K.

3. f% N ProRes ke
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AITHINITES

10.4 it # /40 2

MEERE(E)
. & T, oy T
E-@ color_gs_MP Z Z
E_% color_gs_SF z z
=&, CHst ] ]
oy @& ET (] ]
- WintC Application [l []
n R FEL O] O
w3 05010 HEE B IR ] ]
S SUMTIC 40003 [“] []
ﬂﬁ 253 FEH ] | |
5[ cEv AT []
B
HE R [v] [v]
% EE FEX ] ]
R THEHBE 3 HELF EETE
$RIBIE).. | () | L) T fEAE=RI0) BE) 5. | HERRSET) i SEE (L)
[ TR (R
[ =iz M) v il E IR TR D)
B | xAo | # |
4
Bi B

E“Yn PR N 4 %" (Compile and Download Objects)

XPUEAER, A SR TR G PR I8 B R E X (undefined), it 55" (Update)
DI RS (Status) .

IR SRR

4. WEFE R (Charts) X %I Hdi Y (Edit) 424
BT IT G R 4 %) H k5 248" (Compile Program / Download to Target System)
XA o

5. WHELLT &0
— WE " (Scope) 4l I " (Changes only) & iEHE.
A0S T IR, CPU AR e FER A R .
— PO R K B LR (Generate module drivers) 5 EHE
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AITHINITS

10.4 21174 #1362 2

REER |
wiZER AR |

CRU : CPU 417-4
ERE SIMATIC 40001 4CPU 417-4557 325 (2]

e
C BIEFE

..........................

v 4 iEEIEENER (G) HIEEIEEE(E)..
[ =gt SCLIE[M)

L3

Caricel Help

6. Hii“fffiE"(OK).
PN X e 15 B I R T 3% S7”(Download S7) £+ .
7. EPHE N (Changes) 0, &5 i " (OK).
SIS Py
8. EFOS()" X%, H i’ (Edit).
FEAT TP BRI WR L X d5 23 it 4545 /E B3k OS(1)? ”(Which areas do you want to assign to
operator station OS(1)?)
XHEHE, A “RMTA” L] 4IFFHT RMT2" 1) 408 WonfEdI R .
SFX A B BT OS (1)
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AITHINITES
10.4 it # /40 2

= | s | 05 482 | ez I
(B3t Plant14RMT1 FMT1  CHSTWIRCC Applications0S[1]  Paw Material Tank 1 [RMT1) BEHEELEHEL
Plant14FMT2  BMT2  CHS1SWIRCC Application’O5(1)  Baw Matenal Tank 1 [FMT1] [EHEL [EHEL

9. H N — >"(Next >).
BT TN 5 IXHE X I ICHK 1) ST F /7718 £ M 4% 14 82" (Select the network connections
for the S7 programs associated with the areas) X%, P4~ OS
DX IS R e A TS TR, TIAE NetPro HhG g 1) 19 26 3% 42 W s A A A b
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AITHINITS
10.4 21174 #1362 2

HY : dW&if 05

A SEEHXER 57 BFERE SR

HRERETIE D) : STIERFIFIEEIERE(S) -
= A 050) s7ief || ForTERER | winC s | k| a
= RMT1 FIS7iefEZ) 1 M. MPI HPI

» RMT2

ol | i
EEO. |
cEEE [ F-gns | =mE | me | #=BU |

10. #i“F & >"(Next >).
FEFT T 35 S 2w 3 (1) B8 AN 2 1RV [ (Select the data you want to compile and the
scope of the compilation) X 1FAE.

11, WS LU S HE AL I -
— “#¥5"(Data) 41: “EHEFHE"(Tags and messages)
— “Y¥f5"(Data) 41: “SFC n#1k”(SFC visualization)
— “Yli"(Data) 41:  “H[f 4" (Picture tree)
— “Ju["(Scope) 41: “Changes (¥ ”

12, B8N H(Apply).
X UEHE S o
13. Hifi“/H3)"(Start).
VA ZN B N AR, AT IR ERHEAE IS AT ) R #0RE P B ... " (Downloadi

ng program changes during operation...).
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AITHINITES

10.5 4t e OS 4%

14, FdHhE”(0K).
FEFT TR B TERE W AL 2R R 3 o, WA, ... & 4k42? "(If you want to

download changes online, please make sure that.... Do you want to continue?).

15. Hii“2"(Yes),
G ERN T BARAER TS, IF H H SO SR SR 2 4T T

16. KHICA YA .

17. FE“Gu PR T 206 %" (Compile and Download Objects)
XPEAEHT, L OC 17 (Close).

10.5 A& OS A&

E:EN
C7E WInCC Tt H 4 HILEs vh T T S48 55 H

YiR7S
1. FEETE 4 s b T IFRMT 27 T
2. BRI SCAS T U “RMT2 part of the plant (1) () RMT2 #44) .
3. AT IZIL R I .
4. KB g as .

FE AR LT, DR A IR i T (1 B Ay B Pl o S DR IR T LI e 52 Al B 1 A i
(K1gw PERAE HEAT T 50T

10.6 W )E B EER

Ek
e OS U4mi¥.

o LfE WInCC 3 H A& P P T TR 1 H
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AITHINITS

Ttk

EZER

10.6 2117 )7 53 F 0

Je 82 TAE CE“RMT 2 i R i T Hh AT

. {E WIinCC i H & B 8% h ik B30 (File) >“¥4iE" (Activate) .

UL RER D4 B R R .
BV R A R RMT 2" 4441
T A H“RMT 1R “RMT 2L DI AL B, AT 43 55 SRR 266 o
AT LG A B AR .

AR X R RMT2 444
- DI 4 SFC AL (SFC Visualization).

PP 4T 4T+ SFC”(Open SFC) K& HE
TEAME S WoR A~ SFC EIR. “RMT17[) SFC KR A“RMT2"f SFC K%

. LR IRMT27SFC BRI A ahIUF 1 6 R 46

i
ARVEAE R, IS T AR - T REA o i A B R AL

- AERFERC R AT L D R

- FEL) ERRRIDI .
- EHCE R
— TR RN P

HEMREAER, TS R 7)o

PCS 7 - NI'J451 - 25 1 #4)
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10.6 21 )i 553 F e ¢
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JA BB L 1 1

11.1 SEA51 3 H “color_gs”

S35 H “color_gs”
R (NI19RH) (Getting Started) , it O 45244181 PCS 7

I H“color_gs”. nJ7EVIA ML EFTIFFE Bt H .
i T EA AR I H MHBOE T — AN RS, BTRL, i S FH A [R] R 20 44,
D) 5 G A 21 25

MEA A4 T AR T T RS sk I H -
o JTITSEHIIIH (Uifi5 212)

o BEHERBIITH AEFE (15 213)

o BHEREINIH B (5T 214)

o BN I H £l (519 215)
o ZMPEAN N HELBIIUH (V1% 216)

PCS 7 - NI'145# - 55 1 64>
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JASYRNE 2 SEp)

11.2 L5

11.2

11.2.1

£33

Tk

212

SE’

WATIT I LB E

SIMATIC & HES 4TI

iR
ST H LA ZIP SRR, /& 2481 PCS 7 ZhRg kAT SRR .

. IEEESE Ay A 30 (File) >“E Hi#KEL...”(Retrieve...).

BT I FB R AL - Y3 )RS"(Retrieve - Select Archive) X 1iHE .

. ATIF S JE“SIEMENS/ STEP7/ Examples_MP”,

. IE$E“color_gs.zip" X I H1i“4T IF"(Open)

BT 2% H kx H " (Select Destination Directory)
XPIEHE,  [F]IN“STprof” SCAF gk b, AT PCS 7 T H I EBRAAFA# 7 &

— RERSZERN SRR, R R €7 (OK).
— EONSEEIIUH AU TSk, TR SO, R A B i E " (OK) o

It Rty VA v EE T R H
YRS R EF R IO H 5, 2597 IF AR BB 3k HC(Retrieve from Archive)
TR

- e (OK).

BT TT 53— A0 B EAE -
‘O EErR I 150 H ‘color_gs’. EHL{EFT HHE M ? "(Multiproject 'color_gs' has
been retrieved from the archive. Do you want to open it now?).

PCS 7 - NI'145%8 - 55 1 #4>
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JABYRNE 2L )

11.2.2

Bk

Tiik

6. fLi"2"(Yes).

BT IT LB H

W feT A ST E R

C7E SIMATIC 45 BLa5 T T IT S H .
ERIR AL

- ARG AP B (1 R 4R TS G 2

ARIEARIITEAFE R, W%,
U AE AL A S P AT RE (WU 26)7 93

g
CEFEEH TS TR IR M A G By GEIRAE LSS o

HRUENENGEE, 2%
“UnfT7E Simatic Shell HZkE R 4GRS (VLS 27)3H 57 .

. 4174 AS:
e A A E B S viE & o N 1 A=K SO B 2 e e R D e R O G WANE DB i

X2 A AL a AT T A FH I 208
— Xt CP FIM I AT W

ARIEARIITEAFE R, W%,
“WATALZS AS” (BihiH 38)HK 73

. Hirs PC ok,

ARENERTEANEE, TE%.
‘Wi E A 44 PC ul” (JThS 42)#5 53 -

. 4175 OS:

—  BUE PILRIE I A AN Y 2% T

ARIEARIITEAFE R, W%,
“GifaZH A OS (1) PC uh” (T8 42)#4)

PCS 7 - NI'145# - 55 1 64>
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JASYRNE 2 SEp)

11.2 L5

11.2.3

R

Tk

214

6. 7t NetPro 414 M % iER I F 4.5 PC k.,

HRUN BTG R, is%.
“Unfa 7E NetPro W ib4T ¥ & (VLIS 45)3H 47 .

I R SR T AR

CU7E SIMATIC & BEZS 4T FF S I H .
C AT T F“PCS 7 Library V7.0”,

- FERIRIEAL DR R4 H

“PCS 7 Library V7.0/H R4 (Blocks+Templates)/Ht (Blocks)”
AL < BT

CIEREE AL T
. BB 5 E] “color_gs_MP/color_gs_Lib/S7 Program(1)/5¢ (Blocks)” = 44 7 .

BT I 48 AN T BEL (Insert function block) G HE .

AT (A .

KilH PCS 7 22 24 i A (1 B 0 3 ks e o ) P A e

. TEMTE AL i $E“color_gs_MP/color_gs_Lib/S7 Program(1)/Kl3 (Charts)”.
IR AR R AL VALVE” .

- EPESE LA g (Edit) >“FT 45" (Open Object).

PR 2511 CFC Y as 4T .

. TP A A A WL B (View) >“BeJ5 78" (Block types).

AT T He5 79" (Block Types) X G HE

. IEREIERSCIRJE (Chart Folder) 4l BT A HL, 2R )5 Fdi B A" (New Version).

W4T I8 B % X7 (Set format) XtEHE.

PCS 7 - NI'145%8 - 55 1 #4>
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11.2 205

10. 2 (Yes) M.
W AR FEAR A R 5 S AT RRA P (R B, IS 4T3 BT hCAS " (Import New
Version) X 1EHE .

1. it (Yes) BHbe,
“S OB RAS” (Import New Version) XHEHEFT T, I o~ BT A HH A (B2,

12. 2" (Yes).
X UEHE ST o

13. Hii“CH"(Close).
14. KM CFC ZwlH4s .
15. ZEMHERLIE ik $E“color_gs_MP/color_gs_Lib/S7 Program(1)/5k (Blocks)”.

16. P A 4“1 T (Options) >“E %" (Charts) >“H Hi ¥ #"(Update block types).
BT IFT Priei A" (Update Block Types) [ 5.

— FEEFEHH TR A S7 25 (Select the S7 programs to be checked)

LSRR, ik color_gs"IUH MPTAT 3CIF. BRINEOL T, SBasprf S7
FEFF IR P AT SOt B ) SR

— p4k4"(Continue).

— BRUHOL T, SWOE P IR IE BRI T B P L (Select the block type to be
updated) " AT B AL

—  Hl“5E B (Finish).
W ¥1 v B # 2X7(Set format) S HE

— R (Yes) W H#
PRI HSEE I FR e RS, BT IT.

17. £ HE&EF HE“ K " (Close).

18. SAHEGE AS.

11.24 WM& SEEEIIR B IR B s

Eok
o 7E SIMATIC & HE 88 T IF LT H .
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11.2 L5

o (EAPFHLEFIESE OS(1).

HikE
1. EPCR a2 iR (Edit) >“%} 5 J8 14" (Object Properties).
BT FF“sTomwinx” X HE

2. Hlier(Yes) AIAEIEAT TRk &5 a B R (AT RO 4T IR I H
KT I WInCC i H & B 45

3. (ERNE O rp, EPEOS(1)/1HEHL"(OS(1)/Computer) 4 H
4. X VELIE R R T SRR

5. fE“TH S HLAFK"(Computer name) fir A tskrt, AT I H (T SEHLI A4 FK o
FAEG A ARG AR A P AR B A AR

6. Hidi*ffig”(OK).

7. A2 (OK) #ih S i 50014 #K”(Change computer name) ji ..
AERF AR 1R L SR SRS

8. KM WIinCC il HE #Eg:, ARJF FHRATITE .
SRS FRBLAE T2 N

9. EHE4 H*OS i H 4ui 43" (OS Project Editor).

10. MPRFESCH A IEFE ST IF(Open) fir <o
OS I H Z 4547 IT

1. R BOABCEIF R 52" (0K).
OS T H 2t = 41T H .

12. XM WIinCC Iii H & Bl s ,

11.2.5 W iEM T 240 B

R
o UV SIMATIC 4 HE 85 4T FF S0 H o
e CPU 4 T*STOP"#:{,
o LALLM,
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T

11.2 205

B AN H s

. AER AR ] Ak £ “color_gs_Prj”Ti H .

PR LA A PLC >“PRTEH4wiEXTA..."(Save and Compile Objects...).

BT ITRAF I 4w B 4 42" (Save and Compile Objects) X iHHE

BB REAE:

color_gs_Prj/[PC 31 4 FR]/41 7 (Configuration):  “%ii%”(Compile)

— color_gs_Prj/[PC ¥ 1# A YWIinCC N HFEF (WinCC Application)/OS(1):
“Z% 15" (Compile)

— color_gs_Prj/SIMATIC 400(1)/f#f}: (Hardware): “%ii¥"(Compile)
A1~ %" (Download)

— color_gs_Prj/SIMATIC 400(1)/[CPU )% F#R]/EZ (Charts):  “%i%"(Compile)
AT 35" (Download)

. MEF“EIER7(Charts) %% 3t i “gm i (Edit) 1441

BT ITYm R R %3 H b5 £ 40" (Compile Program / Download to Target System)
XS TEAE o

- WS LU A AL T

— “JuH"(Scope) 41: “Entire program (HEANFERF) ”

~ HEiE: “Generate module drivers (4 piBitIKEHFRIT)

. R E”(OK).
CIEFEOS() XS, g (Edit) .

. AECREER RS X ) il 25 A Dl OS(1)? ”(Which areas do you want to assign to

the operator station OS(1)?) XHEHEF, K“RMT1UFI“RMT2" 1) 424 OS (1).

 FECN IR LG IR OCIR [ ST FEIFIE$F W 4414 32" (Select the network connections for the

S7 programs associated with the areas) X i HE ik $% S7 %42,

10, 7E“TE$EEYm 35 1 B A 2w PR VE I (Select the data you want to compile and the

scope of the compilation) XJiEHEHT, 2 DL & EAE:

— “$¥5"(Data) 41: “AEHEFHE"(Tags and messages)

PCS 7 - NI'145# - 55 1 64>
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11.2 L5

— “Y¥f5"(Data) 41: “SFC nJ#1k”(SFC visualization)

— “¥4fi"(Data) 41:  “H [ #4”(Picture tree)

— “YEH"(Scope) 4l: “#A4~ OS fififi#s 27" (Entire OS with memory reset)
1. N (Apply) -

12. Hi* 3" (Start).
KT AW R T B AE
AT EHE IS AT W)~ 80RO, R AW R e i e, 28 N AT
ORI AR ” (Downloading program changes during operation can, in
the case of malfunctions or program errors, cause serious damage to personnel and
equipment! Make sure...).

13. e (0K).
AT T SR HE G SRARAE 2 B B, TR ... 25 4KEE? 7(If you want to
download changes online, please make sure that ... Do you want to continue?).

14. Hili2"(Yes).
H &GS AR SCAR G AR A AT IT S DLR RGBT B0 15 Bl M 58 B

15. KRHISCAG s

16. JA5h AS It CPU,

fEF OS
1. P1#5] SIMATIC 45 F 8 [ 4R A
2. #79F OS.

RN EMTENG R, aI5%.
“GifA] J4 5 PCS 7 OS (WS 161)" 5553 .

3. Wahid R
CEZE)S)

ARIEABIEAE R, W%
LR B ER AT Sk (TR 189)7H 4y .
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A

AS, 34

47, 34
AS-0S /i iic, 53
AS-OS N, 53

C

CFC K3, 57, 67, 68, 69, 71, 76, 77, 86, 130, 133, 187

CFC_FC111 ff1% X, 68

CFC_LI111 % X, 69

CFC_NK11x % X, 69

CFC_NP111 #5 X, 69

CFC_SETP 15 X, 68

4%, 130

%, 86

B, 67

X5 g, 69

1) )24, 67

IF, 76

A, 71

WAL, 133

AR, 77

4iik, 130

Hfir4, 69, 187

TjiH, 67
CFC #w#52%, 57, 74, 75, 135

ALK, 74

MRk, 74

MR 2%, 135

M, 135

A%, 135

Hx, 75

4hK, 74
CFC_FC111, 68, 81, 82, 87

%, 87

fHAR, 81

47, 82
CFC_LI111, 69, 83, 84, 89

3%, 89

fH AL, 83

7, 84
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CFC_NK111x, 94
14, 94
CFC_NK11x, 69
CFC_NP111, 69, 85
47, 85
CFC_SETP, 68, 77,78
WA, 77
HA&, 78
color_gs i H 41220, 22

E

ES, 15
PIRER, 15

I/0, 77
R, 77
IP B3, 39

M

MAC Hitik, 23, 39
MODE, 82

N
NetPro, 42

O

0S, 39
47, 39

OS X1k, 145

OS 414, 140, 193
B, 193
Pk, 140
I 1 JB 12, 140
Yn i, 140

OS Jii H gt 2%, 199
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FJl

P

PC i}, 38
w4, 38
PCS 7,15
TR B IR, 15
PCS 7 Library V70, 61, 63
PCS 7 OS, 139, 150
4175, 139
4E#t), 150
PG i, 23

S

S7 %%, 42,145
SFC n#ifk, 145
SFC [¥%, 103, 106, 107, 117, 130, 133, 187

4%, 130

wiEtk, 117

I, 107

WAL, 133

%), 106

M7, 117

%%, 130

4, 107, 187
SFC % #%, 104, 134

IhfiE, 104

#, 104

MR E 2%, 134

MR, 134

M4, 104
SIMATIC Shell, 24
SIMATIC % #igs, 16, 18, 140

OS 414, 140

OS %ii%, 140

JA5), 18

ik, 16

FH = 5, 16

4it, 16

\%
View_Tag, 165

w

WinCC Il H 4 #L %%, 150
glitd), 150

220

-+

T#, 45, 129, 130, 189, 199
CFC %, 130
SFC K3, 130
S H, 199
X%, 130
Bk, 189
T EAC &, 45

5

Lyl i %, 99
MiEx, 99

*

TR, 25, 58, 59, 61, 63
55, 58
RAFHR, 61
RAEXT 4, 58
PRAF L FEFRZESTY, 63
B, 59
I REPRZEETY, 58, 59

H

1%, 86, 87, 89, 162
CFC K%, 86
CFC_FC111 (5, 87
CFC_LIM11 ik, 89
JEoRHE S5 R, 162

£

{145 %13%, 21
T 47, 21
{1455 X, 20
EIEALEREA, 20

{4
ek, 126
iB4T R, 126

fiE

i, 33
LA, 33
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FJl

TR

{447, 58, 61, 63
THARFE R XS, 58
B, 61
A FRARZEIETY, 63

W

&

i, 49, 94, 141, 165, 193, 196
OS 417, 193

ZH, 94

P kr, 165

ST H, 196

| [ 44 %, 141

BN, 49

i

{1k, 182
iR, 182

K

KM, 32
TiH, 32

ol

4k, 25, 26, 67, 109
CFC K%, 67
B e, 25
TiH, 26
74 1 R 48, 109

1
igate, 117

il

Mg, 99, 143
5 bk (%) B 3%, 99
I, 143

i)

Lifie, 49, 104
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SFC Zw’fi#t, 104

L4

ALK, 74
¥.73, 49

%

=

ZH, 94, 120, 124
B, 94
#, 120
oA, 124

W

»

I3
[Nk FE, 167

]

] ", 25

A

Ja70, 18, 179, 194
SFC HeEbx, 179
SIMATIC % 5i%s, 18
YA, 179
R, 194

iy

44, 49, 158
T )24, 49
)41tk 49
A, 158

&

K m4E 2, 151, 152, 153
#4151, 153
KR IEPEHR, 152
T HF:, 152
J#, 151
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FJl

H

Hiuhl, 99
MR Hi%, 99

B

M, 59, 61, 77, 86
/O, 77
FHdEE, 59
Hi%, 86
fRA7, 61

Pl by, 97, 141, 143, 165
B, 165
JE A, 97
WAk, 141
"k, 143

HelEbx:, 165

Hui R, 94

PeH, 74

e
FEARFNIH, 9

2

i, 159, 187
1) 4ifF, 187
AL, 159

EZ

ZIiH, 25

an

U eI A Bk, 197
A g ez I (435 H 2, 199

7

FEAfi s 2 AL, 145

5E

& X, 90, 97
Hpr 5 128, 97

222

REFER SAL I %, 90

w

A5 35 H |, 195, 196, 199
T, 199
B4, 196
17T, 196
%%, 199

b

Xt
%1%, 15, 130, 151, 154
N, 130
B4, 151
CUA A\ S N K, 154
A, 154
%1%k, 130
A, 151, 154
iH, 15
WG IEPER, 152

=

JE A, 52, 187
N, 52
Hms, 187

J&

J&bE, 105
#, 105
R 5 AF, 105

T

T HF%, 152
KB dnft#s, 152
T) 7,49
T.J J24%%, 47, 49, 52, 67, 71, 143
CFC K3, 67
B AR, 49
Bt bR, 143
4, 49
J=9%, 47
JER A, 52
i N CFC K%, 71
I [T 2%, 47
WE, 47
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FJl

BT, 47
T 411F, 49, 187
fir44, 49
i, 187

T) 47, 21
T) %, 16, 49
IR, 49
¥T, 49
T) 7,49
¥y, 49
W, 49

2

CFE A 1/0 38, 169
¥, 169

O A A 8K, 154, 167
N, 167

FE

[, 60, 65, 74, 151
KB gnti#%, 151
¥, 60
27K, 65

K, 65

A

N R, 15
ES i, 15

f17t, 18, 32, 60, 76, 107, 151, 152, 196
CFC K%, 76
SFC K%, 107
SIMATIC ## 45, 18
ScHIiH, 196
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T HF:, 152
J#, 60
I LI, 151
TiH, 32

%

YieHl e, 177

&

B, 23
AT E, 23

i

ik, 16, 19
SIMATIC 4%, 16
HiH, 19

i

A, 71,77, 81, 83, 93, 155, 158, 167, 171
CFC_FC111 g5k, 81
CFC_LI111 thfy ¥k, 83
CFC_SETP ik, 77
PH (1) CFC K%, 71
O3 N B A\ e, 167
A, 158
Nk, 167
TREPRZEIRAY, 71, 93
T T () T E, 155
T EAE, 171

i N AR I 1H], 52
JE AR, 52

%I:é

1k, 182
T FE, 182

FRAE Bi3h, 139, 145, 148
JA5h, 148
e R T, 139
Y ik, 145
W 2154z, 145
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FJl

5

WAz, 74
MR A TARR, 74

i)

JE, 165
HelElbr, 165

3

ALK, 154, 158, 159, 170
fir 4, 158
521, 159
A, 158
¥, 158
i, 170
Kbk, 158
HEX G R, 158

B

Bt H, 25
B, 25

I

27, 65, 74
CFC %idtiss, 74
JE, 65

B

4, 183, 189
N, 189
TRBEBE(H, 183

A
1T, 9

¥

K%k, 49
ETL) ZgH, 49

224

7
bRy, 157
(EFR W P bRy T ¥Rog, 157
AT E, 154, 162
J5UkHEE, 162
FriR, 57
CFC K, 57

w

R4t 16
SIMATIC 245, 16

1%

¥, 158, 169
Edfi N 11O 1%, 169
AR, 158

i
MR, 74

i
AR, 71

1E

IEER 3, 148
PRAE D1k, 148
HRERE, 179

W

#, 104, 105, 111, 120
24,120
JE 1, 105
Hiws, 111

|

Mk, 129

MR, 133, 134, 135
CFC 4%, 133
CFC %, 135
SFC 4%, 133
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SFC gufHas, 134
JBTE, 134
Wi, 134
BT, 134

(]
WIYaE L, 150

A
W, 185

fifiik, 185
A%, 185
WE RS, 185
W AT, 177,185

s, 170
SOAER, 170

gL

MATIH, 25

A

B, 143
Hefbr, 143

H

S, 177
RS, 177
i, 9
FH, 9

H

i, 143
s, 143

I [T 2 ), 47

I 1f JE 1, 141
B A T PR A R, 1441
Y, 141

R, 145
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H3%, 75
HAr%&%¢, 130

]

fifitr, 13, 34
AS 417, 34
H3%, 34
R, 13
e B, 23
TEEAC S, 34, 45
AS, 34
T4, 45

i

ffiik, 185
M, 185

¥

¥, 106
SFC K%, 106

b
s, 34
A7, 34

fi

fii TR, 15
PCS 7,15

B

IE I

IEAM AR TR, 20

H

1, 15
PCS 7 IiH, 15
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FJl

AFALPE, 16, 139
ERAE B, 139
M2, 21, 34, 39, 75, 77, 78, 82, 84, 85, 94, 117, 123,
139
AS, 34
CFC Bk, 77
CFC 4wl a1 H %, 75
CFC_FC111 H 13k, 82
CFC_LI111 hf#yHe, 84
CFC_NK111x, 94
CFC_NP111 ¥, 85
CFC_SETP, 78
0S, 39
PCS 7 OS, 139
SFC K&, 117
fifift, 34
vli, 34
M4, 123
WHTL, 21
ML, 76
CFC EZ£ANEA, 76
HEEHR, 23
W, 23
PP, 23

¥

45, 186
R, 186

45, 16, 74, 150
CFC %5y, 74
SIMATIC % BH%%, 16
WinCC Jii H % £ 45, 150

%
Z X, 151

Y

ik, 129, 130, 145, 199
CFC/SFC K%, 130
S H , 199
X4, 130
BRAE Bk, 145

Yk, 141
I TF77 e 1, 141

226

2

R, 23
AT E, 23
W £ T G 4, 23

=

sk, 13,14
figiff, 13
WA, 14

)

LA, 16, 33
T) fLK, 16
ALK, 16
HFEZ AL, 16

w®

W, 49

W, 23,42, 47, 158
1t NetPro 1, 42
T 2%, 47
211, 23
A, 158
fififf, 23
HAEEHG, 23
M2k, 23

#it, 104
SFC Zwi#s, 104

52
AR AL, 16
SIMATIC #5154, 16

i
W, 183
[fiAR, 183

23

40, 104, 105, 114, 123, 124
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